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一般的なトラブルシューティング

この章では、Cisco ONS 15454 の運用時に発生する も一般的な問題のトラブルシューティングの

手順について説明します。ONS 15454 の特定のアラームのトラブルシューティングについては、第

2 章「アラームのトラブルシューティング」 を参照してください。調べたい内容が見つからない場

合は、弊社の Cisco Technical Assistance Center（TAC）に問い合わせてください。

End-of-Life（EoL; サポート終了日）と End-of-Sale（EOS; 販売終了）の注意事項に関するアップデー

トについては、次の URL を参照してください。

http://cisco.com/en/US/products/hw/optical/ps2006/prod_eol_notices_list.html

この章では、ネットワークの問題に関する次の内容について説明します。

• 1.1　ループバックによる回線パスのトラブルシューティング（p.1-3） — ループバックおよびヘ

アピン回線について説明します。これらを使用してネットワークの回線パスをテストしたり、

障害を論理的に切り分けられます。

（注） Dense Wavelength Division Multiplexing（DWDM; 高密度波長分割多重）のネットワーク 終試験に

ついては、『Cisco ONS 15454 DWDM Procedure Guide』を参照してください。

• 1.2　ループバックによる電気回線パスのトラブルシューティング（p.1-11） — DS-1、DS-3、ま

たは EC-1 電気回線上の障害を特定するために、「1.1　ループバックによる回線パスのトラブル

シューティング」 に記述されているループバック試験の使用法を説明します。

• 1.3　FEAC ループバックによる DS3XM-6 または DS3XM-12 カードの電気回路パスのトラブル

シューティング（p.1-54） — DS3XM-6 および DS3XM-12 カードの Far-End Alarm and Control
（FEAC; 遠端アラームおよび制御）機能について説明します。

• 1.4　ループバックによる光回線パスのトラブルシューティング（p.1-56） — OC-N 光回線上の

障害を特定するために、「1.1　ループバックによる回線パスのトラブルシューティング」 に記

述されているループバック試験の使用法を説明します。

• 1.5　ループバックによるイーサネット回線パスのトラブルシューティング（p.1-81） — G シ
リーズまたは CE シリーズのイーサネット回線上の障害を特定するために、「1.1　ループバッ

クによる回線パスのトラブルシューティング」 に記述されているループバック試験の使用法を

説明します。

• 1.6　ループバックによる FC_MR 回線パスのトラブルシューティング（p.1-102） — ファイバ

チャネル（FC_MR）回線上の障害を特定するために、「1.1　ループバックによる回線パスのト

ラブルシューティング」 に記述されているループバック試験の使用法を説明します。

http://cisco.com/en/US/products/hw/optical/ps2006/prod_eol_notices_list.html
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残りの項では、次のトピックに基づいて分類した症状、問題、および解決方法について説明します。

• 1.7　CTC 診断の使用（p.1-118） — カードの LED テストの実行方法、シスコ テクニカル サポー

トのために診断ファイルをダウンロードする方法、および双方向の診断 VT 回線を作成する方

法を説明します。

• 1.8　データベースとデフォルト設定の復元（p.1-126） — ソフトウェア データを復元する手順

とノードをデフォルトの設定に復元する手順について説明します。

• 1.9　PC 接続のトラブルシューティング（p.1-126） — ONS 15454 への PC とネットワーク接続

に関するトラブルシューティングの手順について説明します。

• 1.10　CTC の動作のトラブルシューティング（p.1-133） — Cisco Transport Controller（CTC）へ

のログインまたは操作上の問題に関するトラブルシューティングの手順について説明します。

• 1.11　回線とタイミング（p.1-148） — 回線の作成とエラー レポートの作成に関するトラブル

シューティングの手順とタイミング基準のエラーとアラームについて説明します。

• 1.12　ファイバとケーブル接続（p.1-153） — ファイバとケーブル接続のエラーに関するトラブ

ルシューティングの手順について説明します。

• 1.13　電源の問題（p.1-164） — 電源の問題に関するトラブルシューティングの手順について説

明します。
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1.1　ループバックによる回線パスのトラブルシューティング
ループバックおよびヘアピン回線は、実トラフィックを伝送する前に、新しく作成した SONET 回

線をテストしたり、ネットワーク障害の発生箇所を論理的に突き止めるために使用します。すべて

の ONS 15454 電気回路カード、OC-N カード、G シリーズ イーサネットカード、および FC_MR-4

カードで、ループバックとヘアピン試験回線を使用できます。ループバックができない他のカード

としては、Optical Booster（OPT-BST; 光ブースタ）、Optical Preamplifier（OPT-PRE; 光プリアンプ）、

Optical Service Channel and Combiner/Splitter Module（OSC-CSM; 光サービス チャネルおよびコンバ

イナ / スプリッタ モジュール）、Band Optical Add/Drop Multiplexing（AD-xB-xx.x; 帯域光分岐挿入）

と Channel Optical Add/Drop Multiplexing（AD-xC-xx.x; チャネル 光分岐挿入）カードのような E シ

リーズ イーサネット、ML シリーズ イーサネットおよび DWDM カードがあります。トランスポン

ダ（TXP）またはマックスポンダ（MXP）のループバックの詳細については、『Cisco ONS 15454 DWDM

Troubleshooting Guide』を参照してください。

ポートにループバックを作成するには、ポートは Out-of-Service and Management, Maintenance

（OOS-MA,MT）サービス状態でなければなりません。ループバックを作成したあと、サービス状態

は Out-of-Service and Management, Loopback and Maintenance（OOS-MA,LPBK & MT）になります。

注意 ファシリティ ループバックまたはターミナル ループバックは、サービスに影響を及ぼす可能性が

あります。トラフィックを保護するには、ターゲット ループバック ポートにロックアウトまたは

強制切り替えを適用します。これらの手順の基本的な説明は、第 2 章「アラームのトラブルシュー

ティング」 に記載されています。この操作の詳細については、『Cisco ONS 15454 Procedure Guide』
の「Maintain the Node」の章を参照してください。

（注） 回線の切り替え時間を確認したり、トラフィックの中断が発生しているかどうかを判断するため

に、物理ループバックを使用しないでください。この方法でテストすると、60 m/ 秒以上にわたっ

てトラフィックが中断されます。切り替え時間をテストするには、回線の物理的な両端にテスト

セットを配置します。

注意 すべての OC-N カードでは、ファシリティ ループバックは個々の回線ではなくカード全体に適用

されます。実トラフィックを伝送する OC-N カードでループバックを使用する場合は注意してくだ

さい。
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1.1.1　ファシリティ ループバック

ここでは、ファシリティ ループバック操作の全体的な情報と、ONS 15454 カードのループバック動

作に関する特定の情報について説明します。

1.1.1.1　一般的な動作

ファシリティ ループバックでは、カードの Line Interface Unit（LIU; 回線インターフェイス ユニッ

ト）、Electrical Interface Assembly（EIA; 電気回路インターフェイス アセンブリ）、および関連する

ケーブル接続をテストします。ポートにファシリティ ループバックを適用したあと、テスト セッ

トを使用してループバック上でトラフィックを実行します。ファシリティ ループバックが成功すれ

ば、ネットワークの問題の考えられる原因として LIU、EIA、またはケーブル設備を切り分けるこ

とができます。図 1-1 に、DS-N 電気回路カードでのファシリティ ループバックを示します。

図 1-1 近端の DS-N カードでのファシリティ ループバック パス

OC-N カード LIU を試験するには、光テスト セットを OC-N ポートに接続して、ファシリティ ルー

プバックを実行します。または、回線パスに沿ったさらに遠くのカードでループバックまたはヘア

ピンを使用します。図 1-2 に、OC-N カードでのファシリティ ループバックを示します。

図 1-2 近端の OC-N カードでのファシリティ ループバック パス

CTC では、ファシリティ ループバックを持つ OC-N にはアイコンが表示されます（図 1-3 を参照）。

このリリースでは、ループバック アイコンは他のカードでは表示されません。

図 1-3 OC-N ファシリティ ループバック インジケータ
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注意 OC-N カードでファシリティ ループバックを実行する前に、カードが取り付けられているノードへ

の Data Communications Channel（DCC; データ通信チャネル）パスが、カードに少なくとも 2 本あ

ることを確認します。2 本めの DCC は、ループバック適用後にノードにログインするための非ルー

プ パスになります。これにより、ファシリティ ループバックを削除できます。ループバック OC-N
カードのある ONS 15454 に直接接続する場合は、2 本めの DCC を確保する必要はありません。

注意 ループバックされるファシリティがノードと回線同期していないことを確認します。その場合、タ

イミング ループが作成されます。

（注） CTC では、ファシリティ ループバックはファシリティ（回線）ループバックとして表示されます。

「回線」は、ループバック信号が発信元のファシリティから離れ、スパンへ向かうことを明らかに

するためのものです。

1.1.1.2　ONS 15454 カードの動作

ONS 15454 のポートのループバックでは、ループバック信号を終端またはブリッジングします。

ONS 15454 では、すべてのファシリティ ループバック（光、電気回線、イーサネット、および

FC_MR-4）は、終端されます（表 1-1 を参照）。

ポートがファシリティ ループバック信号を終端する場合には、信号は発信元のポートにループバッ

クされるだけで、ダウンストリームには伝送されません。ポートがループバック信号をブリッジン

グする場合には、信号は発信元ポートにループバックされるとともに、ダウンストリームにも伝送

されます。

（注） 表 1-1 では、信号がブリッジングされた場合は、Alarm Indication Signal（AIS; アラーム表示信号）

は挿入されません。信号が終端された場合は、イーサネット カードを除くすべてのカードのダウ

ンストリームで適切な AIS が挿入されます。

表 1-1 ONS 15454 カードのファシリティ ループバック動作

カード / ポート ファシリティ ループバック信号

DS-1 終端

DS-3 終端

DS3XM-6 または DS3XM-12 終端

すべての OC-N カード 終端

EC-1 終端

G シリーズ イーサネット 終端1

1. G シリーズのファシリティ ループバックは終端され、AIS はダウンストリームに送信され
ません。ただし、シスコ リンク完全性信号は引き続きダウンストリームに送信されます。
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ループバック自体は、Conditions ウィンドウに一覧表示されます。たとえば、このウィンドウには、

テスト ポートの LPBKFACILITY 状態が表示されます（Alarms ウィンドウは、ループバック中の

ファシリティでアラームが抑制されていることを示す AS-MT を表示します）。

ループバックでは、次の動作が確認できます。

• 電気回路または光ポートが Out-of-Service and Management, Disabled（OOS-MA,DSBLD）サービ

ス状態の場合、AIS 信号のアップストリームとダウンストリームが挿入されます。

• ループバック テストの前に、電気回路または光ポートが OOS-MA,MT サービス状態にある場

合、AIS 信号が挿入される原因となるサービスに影響する障害がないかぎり、ポートはアップ

ストリームおよびダウンストリームで AIS 信号を解除します。テストのためにポートを代替状

態にする方法については、『Cisco ONS 15454 Procedure Guide』の「Change Card Settings」の章

を参照してください。 

FC_MR-4 カードのファシリティ ループバックは、他の ONS 15454 カードとは異なる動作をします。

クライアント側のファシリティ ループバックでは、クライアント ポートのサービス状態は

OOS-MA,LPBK & MT ですが、残りのクライアント ポートとトランク ポートは任意の他のサービス

状態にできます。トランク側のファシリティ ループバックのカードでは、トランク ポートのサー

ビス状態は OOS-MA,LPBK & MT ですが、残りのクライアント ポートとトランク ポートは他の任

意のサービス状態にできます。

注意 2 ファイバまたは 4 ファイバ Bidirectional Line Switched Ring（BLSR; 双方向回線交換リング）スパ

ンをファシリティ ループバック状態にする前に、保護のロックアウトを実行する必要があります。

すなわち、2 ファイバ BLSR のリングの一方（イースト側など）でファシリティ ループバックを操

作するには、その前に、同じ側（イースト側）のスパン ロックアウトが必要です。4 ファイバ BLSR
のリングの一方（イースト側など）でファシリティ ループバックを操作するには、その前に同じ

側の保護（イースト保護側）のスパン ロックアウトが必要です。ループバックを作成する前にロッ

クアウトを実行しなかった場合、ループバックの解除後にリングが異常状態になることがありま

す。

1.1.2　ターミナル ループバック

ここでは、ターミナル ループバック操作の全体的な情報と、ONS 15454 カードのループバック動作

に関する特定の情報について説明します。

1.1.2.1　一般的な動作

ターミナル ループバックでは、クロスコネクト カードを通り、ループバックが設定されたカード

からループバックする回線パスをテストします。図 1-4 に、OC-N カードのターミナル ループバッ

クを示します。テスト セットのトラフィックは 電気回路ポートに入り、クロスコネクト カードを

経由して光カードに入ります。光カードのターミナル ループバックによって、信号は LIU に到達

する前に向きを変え、クロスコネクト カードを経て光カードに返送されます。このテストはクロス

コネクト カードと端末の回線パスが有効かどうかを検証しますが、光カードの LIU をテストする

ものではありません。
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図 1-4 OC-N カードでのターミナル ループバック パス

CTC では、ターミナル ループバックを使用する OC-N カードにはアイコンが表示されます（図 1-5

を参照）。このリリースでは、ループバック アイコンは他のカードでは表示されません。

図 1-5 ターミナル ループバック インジケータ

図 1-6 では、DS-N 電気回路カード上のターミナル ループバックを示します。テスト セットのトラ

フィックは、光カードに入り、クロスコネクト カードを経由して電気回路カードに入ります。電気

回路カードのターミナル ループバックによって、信号は LIU に到達する前に向きを変え、クロス

コネクト カードを経て光カードに返送されます。このテストはクロスコネクト カードと端末の回

線パスが有効かどうかを検証しますが、電気回路カードの LIU をテストするものではありません。

（注） CTC では、ターミナル ループバックはターミナル（内部）ループバックとして表示されます。「内

部」は、スパンへ向かう方向ではなく、ループバック信号が発信元のファシリティ内の方向に伝送

されることを明らかにするためのものです。

図 1-6 DS-N カードでのターミナル ループバック パス
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1.1.2.2　ONS 15454 カードの動作

ONS 15454 のターミナル ポートのループバックでは、信号を終端またはブリッジングします。

ONS 15454 では、光、電気回線、イーサネット、および FC_MR-4 のすべてのターミナル ループバッ

クが終端されます（表 1-2 を参照）。ターミナル ループバックの実行時には、ループバック信号を

ブリッジングする ONS 15454 カードもあれば、信号を終端するものもあります。

ポートがターミナル ループバック信号を終端する場合には、信号は発信元のポートにループバック

されるだけで、ダウンストリームには伝送されません。ポートがループバック信号をブリッジング

する場合には、信号は発信元ポートにループバックされるとともに、ダウンストリームにも伝送さ

れます。

表 1-2 に、ONS 15454 カードのターミナル ループバック ブリッジングと終端動作を示します。

（注） 表 1-2 では、信号がブリッジングされた場合は、AIS 信号は挿入されません。信号が終端された場

合は、イーサネット カードを除くすべてのカードのダウンストリームで適切な AIS が挿入されま

す。

図 1-7 と 図 1-8 に、DS-N および OC-N のブリッジングされたターミナル ループバックの例を示し

ます。

図 1-7 信号がブリッジングされた DS-N カードのターミナル ループバック

表 1-2 ONS 15454 カードのターミナル ループバック動作

カード / ポート ターミナル ループバック信号

DS-1 終端

DS-3 ブリッジング

DS3XM-6 または DS3XM-12 ブリッジング

すべての OC-N カード ブリッジング

EC-1 ブリッジング

G シリーズ イーサネット 終端1

1. G シリーズ イーサネットのターミナル ループバックは終端され、イーサネット伝送は無効
になります。イーサネット用の AIS は挿入されませんが、遠端イーサネット ポートで 
TPTFAIL アラームが発生します。



第 1 章      一般的なトラブルシューティング

1.1　ループバックによる回線パスのトラブルシューティング

1-9
Cisco ONS 15454 トラブルシューティング ガイド

78-17734-01-J

図 1-8 信号がブリッジングされた OC-N カードのターミナル ループバック

ターミナル ループバックされた G シリーズのイーサネット カードは、他の ONS 15454 カードとは

異なる PM 動作を行います（PM カウンタの詳細については、『Cisco ONS 15454 Reference Manual』

の「Performance Monitoring」の章を参照してください）。G シリーズ イーサネット カードでターミ

ナル ループバックを設定した場合、CTC カード レベルのビュー Performance > Statistics ページにあ

る Tx Packet カウンタと Rx Packet のカウンタの増加が止まらないことがあります。ループバック

ポートで伝送レーザーを一時的に無効にし、受信パケットをドロップする場合でも、カウンタは増

加することがあります。

Tx Packet の統計は、送信（Tx）レーザーによって伝送されるパケットではなく、G シリーズ カー

ド内部の Tx 信号に基づいているため、増加し続けます。通常のイン サービス ポート動作では、Tx

信号が記録され、Tx レーザーがパケットを伝送しますが、ターミナル ループバックでは、この信

号が G シリーズ カード内でループバックされ、Tx レーザーはパケットを伝送しません。

G シリーズ カードにターミナル ループバックを設定すると、Rx パケット カウンタも増加します。

接続デバイスの Rx パケットはドロップされ記録されませんが、内部的にループバックされたパ

ケットは、G シリーズ カードの通常の受信パスに従うため、Rx Packet カウンタに記録されます。

ループバック自体は、Conditions ウィンドウに一覧表示されます。たとえば、Conditions ウィンドウ

には、テスト ポートの LPBKTERMINAL 状態、または LPBKFACILITY 状態が表示されます（Alarms

ウィンドウには、ループバック テスト中のポートですべてのアラームが抑制されていることを示す

AS-MT が表示されます）。

ループバックでは、次の動作が確認できます。

• 電気回路または光ポートが OOS-MA,DSBLD サービス状態の場合、AIS 信号のアップストリー

ムとダウンストリームが挿入されます。

• ループバック テストの前に、電気回路または光ポートが OOS-MA,MT サービス状態にある場

合、AIS 信号が挿入される原因となりサービスに影響する障害がないかぎり、ポートはアップ

ストリームおよびダウンストリームで AIS 信号を解除します。テストのためにポートを代替状

態にする方法については、『Cisco ONS 15454 Procedure Guide』の「Change Card Settings」の章

を参照してください。

注意 2 ファイバまたは 4 ファイバ BLSR スパンをターミナル ループバック状態にする前に、保護のロッ

クアウトを実行する必要があります。すなわち、2 ファイバ BLSR のリングの一方（イースト側な

ど）でファシリティ ループバックを操作するには、その前に、同じ側（イースト側）のスパン ロッ

クアウトが必要です。4 ファイバ BLSR のリングの一方（イースト側など）でターミナル ループ

バックを操作するには、その前に同じ側の保護（イースト保護側）のスパン ロックアウトが必要

です。ループバックを作成する前にロックアウトを実行しなかった場合、ループバックの解除後に

リングが異常状態になることがあります。
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1.1.3　ヘアピン回線

ヘアピン回線では、トラフィックは OC-N カードに送信されずに、電気回路ポートで送受信されま

す。ヘアピンは、特定の同期転送信号（STS）または仮想トリビュタリ（VT）回線だけをループ

バックして、OC-N ポート全体がループバックされるわけではないので、OC-N ポートのトラフィッ

クすべてがドロップされるのを防ぎます。ヘアピンを使用すると、実トラフィックを伝送している

ノードで特定の STS または VT 回線をテストできます。図 1-9 に、DS-N カードのヘアピン回線パ

スを示します。

図 1-9 DS-N カードでのヘアピン回線パス

1.1.4　クロスコネクト ループバック

クロスコネクト（XC）ループバックでは、光ポート上の他のトラフィックに影響を与えずに、ク

ロスコネクト カードを通ってテスト対象のポートにループバックする OC-N 回線パスをテストし

ます。クロスコネクト ループバックは、ターミナル ループバックまたはファシリティ ループバッ

クより、トラフィックに及ぼす影響が小さくなります。ターミナル ループバックおよびファシリ

ティ ループバックのテストと回線の検証を行うには、多くの場合、回線全体をダウンさせる必要が

あります。しかし、クロスコネクト ループバックを使用すると、STS-1 以上の粒度で、サポートさ

れているペイロードで埋め込みチャネルのループバックを作成できます。たとえば、光ファシリ

ティで、他の STS 回線に割り込まずに単一の STS-6c などをループバックできます。

このテストは、CTC インターフェイスを介してローカルやリモートで実施でき、現場要員が必要あ

りません。これは OC-N カード上でのみ可能であり、STS（または、それ以上の）回線でポートと

クロスコネクト カードを介して、トラフィック パスをテストします。信号パスは、ファシリティ

ループバックに似ています。

XC ループバックは既存のパスを分解し、新しいクロスコネクト（ヘアピン）を作成しますが、元

のパスのソースは回線側の AIS-P を挿入するように設定されます。図 1-10 に、ループバックの信号

パスと AIS 挿入を示します。

図 1-10 SONET クロスコネクト ループバック機能を使用するネットワーク要素
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クロスコネクト ループバックを作成する場合、次の規則を参照してください。

• 予備ポートが 1+1 保護グループで使用され、現用モードである場合を除き、動作中のすべての

現用光ポートまたは予備光ポートでクロスコネクト ループバックを作成できます。

• ポートにターミナルまたはファシリティ ループバックが存在する場合は、クロスコネクト ルー

プバックを使用できません。

1.2　ループバックによる電気回線パスのトラブルシューティング
多くの場合、ファシリティ ループバック、ターミナル ループバック、およびヘアピン回線を使用

して、ネットワーク全体の回線パスをテストしたり、障害を論理的に切り分けたりします。回線パ

スに沿った各ポイントでループバック テストを実施することにより、考えられる障害ポイントを体

系的に切り分けます。

ここで扱う例では、2 ノード BLSR 上の電気回線をテストします。一連のファシリティ ループバッ

ク、ターミナル ループバック、ヘアピン、および（適切な場合は）クロスコネクト ループバック

を電気回線を伝送する光パス上で使用して、回線パスをトレースし、考えられる障害ポイントをテ

ストして除去します。8 つのネットワーク テスト手順の論理的な進行が、次のサンプル シナリオに

適用されます。

（注） これらの手順は、DS-1、DS-3、および EC-1 カードに適用されます。回線のテスト手順は、回線の

種類とネットワーク トポロジによって異なります。

ウェストからイースト方向（左から右）

1. 発信元ノードの電気回路ポート（DS-N または EC-N）でのファシリティ ループバック

2. 発信元ノードの電気回路ポートでのヘアピン

3. 宛先ノードの OC-N STS（電気回線を伝送）での XC ループバック

4. 宛先ノードの電気回路ポートでのターミナル ループバック

イーストからウェスト方向（右から左）

1. 宛先ノードの電気回路ポートでのファシリティ ループバック

2. 宛先ノードの電気回路ポートでのヘアピン

3. 発信元ノードの OC-N STS（電気回線を伝送）での XC ループバック

4. 発信元ノードの電気回路ポートでのターミナル ループバック

（注） ファシリティ、ヘアピン、ターミナル ループバック テストには、現場要員が必要です。
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1.2.1　発信元の電気回路ポートでのファシリティ ループバックの実行（ウェストから
イースト）

ファシリティ ループバック テストは、ネットワーク回線内のノードの発信元電気回路ポート（こ

の例では、発信元ノードの DS-N ポート）で実行します。このポートでのファシリティ ループバッ

クが正常に完了すれば、ケーブル接続、電気回路カード、および EIA が障害ポイントである可能性

を切り分けられます。図 1-11 に、発信元 DS-N ポートのファシリティ ループバックの一例を示し

ます。

図 1-11 回線発信元 DS-N ポートでのファシリティ ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。トラフィック

を保護するには、ターゲット ループバック ポートにロックアウトまたは強制切り替えを適用しま

す。これらの操作の詳細については、『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の

章を参照してください。

（注） ファシリティ ループバックには、現場要員が必要です。

（注） ONS 15454 DS-3 端末ループバックでは、ループバックから離れる方向には AIS を送信しません。

AIS の代わりに、ループバックに一連の信号が伝送されます。DS3/EC1-48 カードは、必要な場合

には、端末ループバックで AIS を送信するようにプロビジョニングできます。

カードのタイプに応じて、「発信元 DS-1、DS-3、DS3N-12、DS3i-N-12、または EC1 ポートでのファ

シリティ ループバックの作成」（p.1-13） または 「発信元 DS3E または DS3XM ポートでのファシリ

ティ ループバックの作成」（p.1-14） の作業を行ってから、説明に従ってループバックをテストし、

解除してください。
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発信元 DS-1、DS-3、DS3N-12、DS3i-N-12、または EC1 ポートでのファシリティ ループバックの作成

ステップ 1 テストするポートに電気テスト セットを接続します。

適切なケーブル接続で、電気テスト セットの Tx および Rx 端末を、テストするポート用の EIA コ

ネクタまたは DSx パネルに接続します。Tx および Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用方法については、製造元に確認し

てください）。

ステップ 3 ノード ビューで、カードをダブルクリックして、カード ビューを表示します。

ステップ 4 Maintenance > Loopback タブをクリックします。

ステップ 5 テストするポートに対して、Admin State カラムから OOS,MT を選択します。このカードがマルチ

ポート カードの場合、テストするポートに対応する行を選択します。

ステップ 6 テストするポートに対して、Loopback Type カラムから Facility を選択します。このカードがマルチ

ポート カードの場合、テストするポートに対応する行を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

（注） ループバックのセットアップ時には、通常、「LPBKFACILITY（DS1、DS3）」（p.2-179） が
表示されます。ループバックを削除すると、この状態はクリアされます。

ステップ 9 「DS-3、DS3N-12、DS3i-N-12、または EC1 ポートのファシリティ ループバック回線のテストと解

除」（p.1-13） の作業を行います。

DS-3、DS3N-12、DS3i-N-12、または EC1 ポートのファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。カードを

ダブルクリックして、カード ビューを表示します。

ステップ 4 カードのタイプに応じて、Maintenance > Loopback  タブをクリックします。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。
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ステップ 6 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 「電気回路ケーブル接続のテスト」（p.1-15） の作業を行います。

発信元 DS3E または DS3XM ポートでのファシリティ ループバックの作成

この手順は、DS3E、DS3XM-6、および DS3XM-12 カードに適用されます。DS3XM カードの FEAC

ループバック機能は使用しません。FEAC の詳細については、「1.3　FEAC ループバックによる

DS3XM-6 または DS3XM-12 カードの電気回路パスのトラブルシューティング」（p.1-54） を参照し

てください。

ステップ 1 テストするポートに電気テスト セットを接続します。

適切なケーブル接続で、電気テスト セットの Tx および Rx 端末を、テストするポート用の EIA コ

ネクタまたは DSx パネルに接続します。Tx および Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用方法については、製造元に確認し

てください）。

ステップ 3 ノード ビューで、カードをダブルクリックして、カード ビューを表示します。

ステップ 4 これらのカードのいずれかの Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 5 DS3 タブでは、テストするポートに対して、Admin State カラムから OOS,MT を選択します。この

カードがマルチポート カードの場合、テストするポートに対応する行を選択します。DS1 タブで

は、DS-1 がイン サービスになっていないかぎり、状態選択は必要ありません。Derived State が

OOS,DSBLD の場合、DS-1 に対してループバック / 送信コードを選択することはできません。

ステップ 6 テストするポートに対して、Loopback Type カラムから Facility を選択します。このカードがマルチ

ポート カードの場合、テストするポートに対応する行を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

（注） ループバックのセットアップ時には、通常、「LPBKFACILITY（DS1、DS3）」（p.2-179） が
表示されます。ループバックを削除すると、この状態はクリアされます。
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ステップ 9 「DS3E または DS3XM ポート ファシリティ ループバック回線のテストと解除」（p.1-15） の作業を行

います。

DS3E または DS3XM ポート ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。カードを

ダブルクリックして、カード ビューを表示します。

ステップ 4 これらのカードのいずれかの Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 「電気回路ケーブル接続のテスト」（p.1-15） の作業を行います。

電気回路ケーブル接続のテスト

ステップ 1 問題があると考えられるケーブル接続（テスト セットと DSx パネルまたは EIA ポートの間のケー

ブル）を、良好なケーブルと交換します。詳細については、『Cisco ONS 15454 Procedure Guide』の

「Install Cards and Fiber-Optic Cable」の章を参照してください。

良好なケーブルを使用できない場合は、テスト セットを使用して問題があると考えられるケーブル

をテストします。問題があると考えられるケーブルを DSx パネルまたは EIA から取り外し、テス

ト セットの Tx および Rx 端末に接続します。トラフィックを伝送し、ケーブルが良好であるか、不

良であるかを判断します。

ステップ 2 良好なケーブルを取り付けて、ループバック回線にテスト用トラフィックを再送信します。測定の

結果、回線に異常がない場合は、ケーブルの欠陥が問題であったと考えられます。
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ステップ 3 不良なケーブルを交換します。

ステップ 4 電気回路カードのカード ビューで、タイプに応じて、Maintenance > Loopback  タブ、Maintenance

> DS1 タブ、または Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 「電気回路カードのテスト」（p.1-16） の作業を行います。

電気回路カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。Return

Materials Authorization（RMA）プロセスを通じて、不良カードをシスコに返送してください。詳し

くは、弊社テクニカル サポートにお問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 電気回路カードのカード ビューで、タイプに応じて、Maintenance > Loopback  タブ、Maintenance

> DS1 タブ、または Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 6 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 7 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 8 Apply をクリックします。
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ステップ 9 確認用ダイアログボックスで Yes をクリックします。

ステップ 10「EIA のテスト」（p.1-17） の作業を行います。

EIA のテスト

ステップ 1 次のように EIA を取り外して再度取り付け、正しく挿し込まれていることを確認します。

a. 下部のバックプレーン カバーを外します。カバーを ONS 15454 に固定している 5 本のネジを

緩めて、シェルフ アセンブリから引き抜きます。

b. EIA パネルを固定している周囲の 9 本のネジを緩めます。

c. EIA パネルを下から持ち上げて、シェルフ アセンブリから取り外します。

d. 該当する EIA の取り付け手順に従ってください。手順については、『Cisco ONS 15454 Procedure
Guide』の「Install the Shelf and Backplane Cable」の手順を参照してください。

ステップ 2 良好なケーブル接続、良好なカード、および再度取り付けた EIA を使用して、ループバック回線に

テスト用トラフィックを再送信します。測定の結果、回線に異常がない場合は、EIA が正しく挿し

込まれていなかったことが問題であったと考えられます。ステップ 16 へ進んでください。問題が

解消せず、EIA が正しく固定されている場合は、ステップ 3 へ進みます。

ステップ 3 電気回路カードのカード ビューで、タイプに応じて、Maintenance > Loopback  タブ、Maintenance

> DS1 タブ、または Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 4 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 5 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 6 Apply をクリックします。

ステップ 7 確認用ダイアログボックスで Yes をクリックします。ステップ 16 に進みます。

ステップ 8 測定の結果、回線に異常がある場合は、EIA の欠陥が問題であると考えられます。RMA プロセス

を通じて、不良 EIA をシスコに返送してください。詳しくは、弊社テクニカル サポートにお問い

合わせください。

ステップ 9 「電気回路インターフェイス アセンブリの交換」（p.2-302） の作業を行って、不良 EIA を交換します。

ステップ 10 良好なケーブル接続、良好なカード、および交換した EIA を使用して、ループバック回線にテスト

用トラフィックを再送信します。測定の結果、回線に異常がある場合は、ファシリティ ループバッ

クのすべての手順を繰り返します。
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ステップ 11 測定の結果、回線に異常がない場合は、EIA の欠陥が問題であったと考えられます。Maintenance

> Loopback タブ、Maintenance > DS1 タブ、または Maintenance > DS3 タブをクリックして、ファ

シリティ ループバックを解除します。

ステップ 12 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 13 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 14 Apply をクリックします。

ステップ 15 確認用ダイアログボックスで Yes をクリックします。

ステップ 16「1.2.2　発信元ノードの電気回路ポートでのヘアピン テストの実行（ウェストからイースト）」

（p.1-18） の作業を行います。

1.2.2　発信元ノードの電気回路ポートでのヘアピン テストの実行（ウェストからイー
スト）

ヘアピン テストはネットワーク回線のクロスコネクト カードで実行します。ヘアピン回線は、発

信元および宛先の両方で同じポートを使用します。ポート経由でヘアピンが正常に完了すれば、ク

ロスコネクト カードが回線不良の原因である可能性が切り分けられます。図 1-12 に、発信元ノー

ドのポートでのヘアピン ループバックの一例を示します。

図 1-12 発信元ノードのポートでのヘアピン

（注） ONS 15454 は、クロスコネクト カードのシンプレックス オペレーションをサポートしていません。

各ノードに、同じタイプのクロスコネクト カードを 2 枚取り付ける必要があります。

（注） ヘアピン ループバックには、現場要員が必要です。

「発信元ノードの電気回路ポートでのヘアピン回線の作成」（p.1-19） の作業を行います。
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発信元ノードの電気回路ポートでのヘアピン回線の作成

ステップ 1 テストするポートに電気テスト セットを接続します。

a. 「1.2.1　発信元の電気回路ポートでのファシリティ ループバックの実行（ウェストからイース

ト）」（p.1-12） の作業を完了したばかりであれば、発信元ノードの電気回路ポートに電気テスト

セットを接続したままにします。

b. 電気テスト セットを DS-N ポートに接続せずにこの手順を開始する場合は、適切なケーブル接

続で、電気テスト セットの Tx および Rx 端子を、テストするポートの EIA コネクタに接続し

ます。Tx および Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、次のようにテスト ポートにヘアピン回線をセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「Hairpin1」のような分かりやすい名前を

指定します。

e. サイズ（STS-1 など）を選択します。

f. Bidirectional チェックボックスをオフにします。State、SD Threshold、および SF Threshold の値

はデフォルトのままにします。

g. Next をクリックします。

h. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。Use Secondary Source のチェックはオフのまま

にします。

i. Next をクリックします。

j. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。Use Secondary Destination の
チェックをオフのままにします。

k. Next をクリックします。

l. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 新しく作成した回線が Circuits タブに表示され、Dir カラムに単方向回線として示されていることを

確認します。

ステップ 5 「電気回路ポート ヘアピン回線のテストと削除」（p.1-20） の作業を行います。
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電気回路ポート ヘアピン回線のテストと削除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ヘアピン回線でのテストは終了です。次のようにヘアピン回

線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のヘアピン回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧からヘアピン回線が削除されていることを確認します。

ステップ 4 「スタンバイ クロスコネクト カードのテスト」（p.1-20） の作業を行います。

スタンバイ クロスコネクト カードのテスト

（注） この手順を実行するノードでは、クロスコネクト カードを 2 枚（アクティブとスタンバイ）を使

用している必要があります。

ステップ 1 アクティブ カードにするために、スタンバイ クロスコネクト カードでリセットを実行します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. スタンバイ クロスコネクト カードの上にカーソルを置きます。

c. 右クリックして、RESET CARD を選択します。

d. 確認用ダイアログボックスで Yes をクリックします。

ステップ 2 ループバック回線を再テストする前に、クロスコネクト カードで外部切り替えコマンド（サイド切

り替え）を開始します。

注意 クロスコネクトのサイド切り替えは、XC-VXC-10G カードを使用したサイド切り替えを除き、サー

ビスに影響します。ノードのカードにある実トラフィックは、 大 50 ミリ秒までの中断に耐えら

れます。XC-VXC-10G のサイド切り替えではエラーは発生しません。 
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a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross Connect > Cards タブを選択します。

c. Cross-Connect Cards 領域で Switch をクリックします。

d. Confirm Switch ダイアログボックスで Yes をクリックします。

（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。

ステップ 3 ループバック回線にテスト用トラフィックを再送信します。

これで、テスト用トラフィックは代替のクロスコネクト カード経由で伝送されるようになります。

ステップ 4 測定の結果、回線に異常がある場合は、クロスコネクト カードが問題の原因ではないと考えられま

す。次のようにヘアピン回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のヘアピン回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧からヘアピン回線が削除されていることを確認します。

ステップ 5 元のクロスコネクト カードに問題があることを確認するには、「元のクロスコネクト カードの再テ

スト」（p.1-21） の作業を行います。

元のクロスコネクト カードの再テスト

ステップ 1 クロスコネクト カードで外部切り替えコマンド（サイド切り替え）を開始します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross-Connect > Cards タブを選択します。

c. Cross Connect Cards メニューから、Switch を選択します。

d. Confirm Switch ダイアログボックスで Yes をクリックします。

（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。
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ステップ 2 ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がある場合は、カードの欠陥が問題であると考えられます。RMA プロセ

スを通じて、不良カードをシスコに返送してください。弊社テクニカル サポートにお問い合わせの

上、ステップ 4 へ進みます。テストの結果、回線に異常が見つからない場合は、ステップ 5 に進み

ます。

ステップ 4 不良カードに対して、「イン サービス クロスコネクト カードの物理的な交換」（p.2-293） の作業を

行います。

ステップ 5 測定の結果、回線に異常がない場合は、クロスコネクト カードに一時的な問題があり、サイド切り

替えによってその問題が解消された可能性があります。次のようにヘアピン回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のヘアピン回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧からヘアピン回線が削除されていることを確認します。

ステップ 6 「1.2.3　電気信号を伝送している宛先ノードの OC-N STS での XC ループバックの実行（ウェストか

らイースト）」（p.1-22） の作業を行います。

1.2.3　電気信号を伝送している宛先ノードの OC-N STS での XC ループバックの実行
（ウェストからイースト）

XC ループバックでは、カード上の他のスパンから OC-N スパンを切り分けて、回線の OC-N スパ

ンに問題があるかどうかをテストします。ループバックは、ネットワーク回線のクロスコネクト

カードで行います。図 1-13 に、宛先 OC-N ポートの XC ループバックの一例を示します。トラフィッ

クのパターンはターミナル ループバックと似ていますが、トラフィックは、ポート全体に影響を与

えるのではなく、STS でのみ伝送されます。

（注） OC-N カードでの XC ループバックは、他の回線のトラフィックに影響を及ぼしません。

（注） XC ループバックには、現場要員は不要です。

（注） 回線の発信元現用ポートか、1+1 保護グループの予備ポートで、XC ループバックを実施できます。
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図 1-13 宛先 OC-N ポートの XC ループバック

宛先ノードの OCN STS での XC ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.2.2　発信元ノードの電気回路ポートでのヘアピン テストの実行（ウェストからイースト）」

（p.1-18） の作業が完了したばかりであれば、宛先ノードのポートに光テスト セットを接続した

ままにします。

b. 現在の手順を開始するときに、光テスト セットが宛先ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx および Rx 端末をテストするポートに接続します。Tx
および Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、テストする回線を次のようにアウト オブ サービス状態にします。

a. ノード ビューで、Circuits タブをクリックします。

b. 回線をクリックし、Edit をクリックします。

c. Edit Circuit ダイアログボックスで、State タブをクリックします。

d. Target Circuit Admin State ドロップダウン リストから OOS,MT を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 CTC を使用して、テストする回線に XC ループバックをセットアップします。

a. ノード ビューで、OC-N カードをダブルクリックしてカード ビューを表示します。

b. Maintenance > Loopback > SONET STS タブをクリックします。

c. テストするポートに対して、XC Loopback カラムにあるチェックボックスをオンにします。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 5 「XC ループバック回線のテストと解除」（p.1-24） の作業を行います。
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XC ループバック回線のテストと解除

（注） この手順は、OC-N カードだけで実行します。

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、クロスコネクトでのテストは終了です。XC ループバックを

解除します。

a. カード ビューで、Maintenance > Loopback > SONET STS タブをクリックします。

b. テスト対象の回線に対して、XC Loopback カラムにあるチェックボックスをオフにします。

c. Apply をクリックします。

d. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「スタンバイ クロスコネクト カードのテスト」（p.1-24） の作業を行います。

スタンバイ クロスコネクト カードのテスト

ステップ 1 スタンバイ クロスコネクト カードでリセットを実行します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. スタンバイ クロスコネクト カードの上にカーソルを置きます。

c. 右クリックして、RESET CARD を選択します。

d. 確認用ダイアログボックスで Yes をクリックします。

ステップ 2 ループバック回線を再テストする前に、クロスコネクト カードで外部切り替えコマンド（サイド切

り替え）を開始します。

注意 クロスコネクトのサイド切り替えは、XC-VXC-10G カードを使用したサイド切り替えを除き、サー

ビスに影響します。ノードのカードにある実トラフィックは、 大 50 ミリ秒までの中断に耐えら

れます。XC-VXC-10G のサイド切り替えではエラーは発生しません。 

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。



第 1 章      一般的なトラブルシューティング

1.2　ループバックによる電気回線パスのトラブルシューティング

1-25
Cisco ONS 15454 トラブルシューティング ガイド

78-17734-01-J

b. ノード ビューで、Maintenance > Cross Connect > Card タブを選択します。

c. Cross-Connect Cards 領域で Switch をクリックします。

d. Confirm Switch ダイアログボックスで Yes をクリックします。

（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。

ステップ 3 ループバック回線にテスト用トラフィックを再送信します。

これで、テスト用トラフィックは代替のクロスコネクト カード経由で伝送されるようになります。

ステップ 4 測定の結果、回線に異常がある場合は、クロスコネクト カードが問題の原因ではないと考えられま

す。XC ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象の XC ループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧から XC ループバック回線が削除されていることを確認します。測定の結

果、回線に異常がない場合は、クロスコネクト カードに問題がある可能性があります。

ステップ 5 元のクロスコネクト カードに問題があることを確認するには、「元のクロスコネクト カードの再テ

スト」（p.1-25） の作業を行います。

元のクロスコネクト カードの再テスト

（注） この手順は、OC-N カードとクロスコネクト カードだけで実行します。

ステップ 1 クロスコネクト カードで外部切り替えコマンド（サイド切り替え）を開始します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross Connect > Card  タブを選択します。

c. Cross-Connect Cards 領域で Switch をクリックします。

d. Confirm Switch ダイアログボックスで Yes をクリックします。
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（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。

ステップ 2 ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がある場合は、カードの欠陥が問題であると考えられます。RMA プロセ

スを通じて、不良カードをシスコに返送してください。弊社テクニカル サポートにお問い合わせの

上、ステップ 4 へ進みます。回線に不良が見られず、カードも欠陥があることを示していない場合

は、テストを終了します。

ステップ 4 不良クロスコネクト カードに対して、「イン サービス クロスコネクト カードの物理的な交換」

（p.2-293） の作業を行い、ステップ 5 を実行します。

ステップ 5 測定の結果、回線に異常がない場合は、クロスコネクト カードに一時的な問題があり、サイド切り

替えによってその問題が解消された可能性があります。XC ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象の XC ループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 6 テストで別の問題があれば、「1.2.4　宛先電気回路ポートでのターミナル ループバックの実行（ウェ

ストからイースト）」（p.1-26） へ進んでください。

1.2.4　宛先電気回路ポートでのターミナル ループバックの実行（ウェストからイース
ト）

ターミナル ループバック テストは、宛先ノードの電気回路ポートなど、回線内の宛先ノードの電

気回路ポートで実行します。まず、発信元ノードの電気回路ポートで始まり、宛先ノードの電気回

路ポートでループバックする双方向回線を作成します。次に、ターミナル ループバック テストに

進みます。宛先ノードの電気回路ポートへのターミナル ループバックが正常に完了すれば、回線が

宛先の電気回路ポートまで問題ないことが実証されます。図 1-14 に、宛先 DS-N ポートでのターミ

ナル ループバックの一例を示します。

図 1-14 宛先 DS-N ポートへのターミナル ループバック
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注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。トラフィック

を保護するには、ターゲット ループバック ポートにロックアウトまたは強制切り替えを適用しま

す。これらの操作の詳細については、『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の

章を参照してください。

（注） ターミナル ループバックには、現場要員が必要です。

（注） ONS 15454 DS-3 端末ループバックでは、ループバックから離れる方向には AIS を送信しません。

AIS の代わりに、ループバックに一連の信号が伝送されます。DS3/EC1-48 カードは、必要な場合

には、端末ループバックで AIS を送信するようにプロビジョニングできます。

カードのタイプに応じて、「宛先 DS-3、DS3N-12、DS3i-N-12、または EC1 ポートでのターミナル

ループバックの作成」（p.1-27） または 「宛先 DS-3E または DS3XM ポートでのターミナル ループ

バックの作成」（p.1-29） を実行します。続いて、説明に従いループバックをテストし、解除します。

宛先 DS-3、DS3N-12、DS3i-N-12、または EC1 ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに電気テスト セットを接続します。

a. 「1.2.3　電気信号を伝送している宛先ノードの OC-N STS での XC ループバックの実行（ウェス

トからイースト）」（p.1-22） の作業を完了したばかりであれば、発信元ノードのポートに電気テ

スト セットを接続したままにします。

b. この手順を開始するときに、電気テスト セットが電気回路ポートに接続されていない場合は、

適切なケーブル接続で、電気テスト セットの Tx および Rx 端子を、テストするポートの DSx
パネルまたは EIA コネクタに接続します。Tx と Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC のノード ビューで Circuits タブをクリックし、Create をクリックします。

ステップ 4 Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

ステップ 5 Next をクリックします。

ステップ 6 次の Circuit Creation ダイアログボックスで、回線に「DS1toDS2」のような分かりやすい名前を指定

します。

ステップ 7 Bidirectional  チェックボックスは、オンの状態のままにします。

ステップ 8 Next をクリックします。
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ステップ 9 Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、

Port、および STS（または VT） を選択します。

ステップ 10 Next をクリックします。

ステップ 11 Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ Node、

カード Slot、Port、および STS（または VT）を選択します。

ステップ 12 Next をクリックします。

ステップ 13 Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のままにし

ます。Finish をクリックします。

ステップ 14 Dir カラムに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL（DS1、DS3）」（p.2-184） が
表示されます。ループバックを削除すると、この状態はクリアされます。

（注） ONS 15454 DS-3 端末ループバックでは、ループバックから離れる方向には AIS を送信しません。

AIS の代わりに、ループバックに一連の信号が伝送されます。DS3/EC1-48 カードは、必要な場合

には、端末ループバックで AIS を送信するようにプロビジョニングできます。

ステップ 15 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、宛先ノードの DS-N カードなど、ループバックが必要なカードをダブルク

リックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 16「DS-3、DS3N-12、DS3i-N-12、または EC1 宛先ポートのターミナル ループバック回線のテストと

作成」（p.1-29） の作業を行います。
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DS-3、DS3N-12、DS3i-N-12、または EC1 宛先ポートのターミナル ループバック回線のテストと作成

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ターミナル ループ

バックが設定されている宛先ノードの電気回路カードをダブルクリックします。

ステップ 4 Maintenance > Loopback タブをクリックします。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）

を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 ターミナル ループバックを解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 10「宛先の電気回路カードのテスト」（p.1-32） の作業を行います。

宛先 DS-3E または DS3XM ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに電気テスト セットを接続します。

a. 「1.2.3　電気信号を伝送している宛先ノードの OC-N STS での XC ループバックの実行（ウェス

トからイースト）」（p.1-22） の作業を完了したばかりであれば、発信元ノードの電気回路ポート

に電気テスト セットを接続したままにします。

b. この手順を開始するときに、電気テスト セットが電気回路ポートに接続されていない場合は、

適切なケーブル接続で、電気テスト セットの Tx および Rx 端子を、テストするポートの DSx
パネルまたは EIA コネクタに接続します。Tx と Rx は、同じポートに接続します。

c. 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を

参照してください）。

ステップ 2 CTC のノード ビューで Circuits タブをクリックし、Create をクリックします。
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ステップ 3 Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

ステップ 4 Next をクリックします。

ステップ 5 次の Circuit Creation ダイアログボックスで、回線に「DS1toDS3」のような分かりやすい名前を指定

します。

ステップ 6 Bidirectional  チェックボックスは、オンの状態のままにします。

ステップ 7 Next をクリックします。

ステップ 8 Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、

Port、および STS（または VT） を選択します。

ステップ 9 Next をクリックします。

ステップ 10 Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ Node、

カード Slot、Port、および STS（または VT）を選択します。

ステップ 11 Next をクリックします。

ステップ 12 Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のままにし

ます。Finish をクリックします。

ステップ 13 Dir カラムに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL（DS1、DS3）」（p.2-184） が
表示されます。ループバックを削除すると、この状態はクリアされます。

（注） ONS 15454 DS-3 端末ループバックでは、ループバックから離れる方向には AIS を送信しま

せん。AIS の代わりに、ループバックに一連の信号が伝送されます。DS3/EC1-48 カードは、

必要な場合には、端末ループバックで AIS を送信するようにプロビジョニングできます。

ステップ 14 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、宛先ノードの DS-N カードなど、ループバックが必要なカードをダブルク

リックします。

c. Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。
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d. DS3 タブでは、テストするポートに対して、Admin State カラムから OOS,MT を選択します。

このカードがマルチポート カードの場合、テストするポートに対応する行を選択します。DS1
タブでは、DS-1 がイン サービスになっていないかぎり、状態選択は必要ありません。Derived
State が OOS,DSBLD の場合、DS-1 に対してループバック / 送信コードを選択することはできま

せん。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 15「DS-3E または DS3XM 宛先ポート ターミナル ループバック回線のテストと解除」（p.1-31） の作業

を行います。

DS-3E または DS3XM 宛先ポート ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ターミナル ループ

バックが設定されている宛先ノードの電気回路カードをダブルクリックします。

ステップ 4 Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）

を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 ターミナル ループバックを解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。
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ステップ 10「宛先の電気回路カードのテスト」（p.1-32） の作業を行います。

宛先の電気回路カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良な電気回路カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行いま

す。

ステップ 5 ポートのターミナル ループバック状態を解除します。

a. ターミナル ループバックが設定されている宛先ノードの電気回路カードをダブルクリックし

ます。

b. カードのタイプに応じて、Maintenance > Loopback  タブ、Maintenance > DS1 タブ、または

Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ターミナル ループバック回線を削除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.2.5　宛先ノードの電気回路ポートでのファシリティ ループバックの実行（イーストからウェス

ト）」（p.1-33） の作業を行います。
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1.2.5　宛先ノードの電気回路ポートでのファシリティ ループバックの実行（イースト
からウェスト）

ファシリティ ループバック テストは、ネットワーク回線内の宛先ノードの電気回路ポートで実行

します。このポートでのファシリティ ループバックが正常に完了すれば、ケーブル接続、電気回路

カード、および EIA が障害ポイントである可能性を切り分けられます。図 1-15 に、宛先 DS-N ポー

トのファシリティ ループバックの一例を示します。

図 1-15 回線宛先 DS-N ポートでのファシリティ ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。トラフィック

を保護するには、ターゲット ループバック ポートにロックアウトまたは強制切り替えを適用しま

す。基本的な方法については、「2.9.2　保護切り替え、ロック開始、クリア」（p.2-278） を参照して

ください。これらの操作の詳細については、『Cisco ONS 15454 Procedure Guide』の「Maintain the
Node」の章を参照してください。

（注） ファシリティ ループバックには、現場要員が必要です。

（注） ONS 15454 DS-3 端末ループバックでは、ループバックから離れる方向には AIS を送信しません。

AIS の代わりに、ループバックに一連の信号が伝送されます。DS3/EC1-48 カードは、必要な場合

には、端末ループバックで AIS を送信するようにプロビジョニングできます。

カードのタイプに応じて、「宛先 DS-1、DS-3、DS3N-12、DS3i-N-12、または EC-1 ポートでのファ

シリティ ループバックの作成」（p.1-34） または 「発信元 DS3E または DS3XM ポートでのファシリ

ティ ループバックの作成」（p.1-35） を実行します。続いて、説明に従いループバックをテストし、

解除します。



第 1 章      一般的なトラブルシューティング

1.2　ループバックによる電気回線パスのトラブルシューティング

1-34
Cisco ONS 15454 トラブルシューティング ガイド

78-17734-01-J

宛先 DS-1、DS-3、DS3N-12、DS3i-N-12、または EC-1 ポートでのファシリティ ループバックの作成

ステップ 1 テストするポートに電気テスト セットを接続します。

a. 「1.2.4　宛先電気回路ポートでのターミナル ループバックの実行（ウェストからイースト）」

（p.1-26） の作業を完了したばかりであれば、宛先ノードのポートに電気テスト セットを接続し

たままにします。

b. 適切なケーブル接続で、電気テスト セットの Tx および Rx 端末を、テストするポート用の EIA
コネクタまたは DSx パネルに接続します。Tx および Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC ノード ビューで、カードをダブルクリックして、カード ビューを表示します。

ステップ 4 Maintenance > Loopback タブをクリックします。

ステップ 5 テストするポートに対して、Admin State カラムから OOS,MT を選択します。このカードがマルチ

ポート カードの場合、テストするポートに対応する行を選択します。

ステップ 6 テストするポートに対して、Loopback Type カラムから Facility を選択します。このカードがマルチ

ポート カードの場合、テストするポートに対応する行を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

（注） ループバックのセットアップ時には、通常、「LPBKFACILITY（DS1、DS3）」（p.2-179） が
表示されます。ループバックを削除すると、この状態はクリアされます。

ステップ 9 「DS-3、DS3N-12、DS3i-N-12、または EC-1 ポートのファシリティ ループバック回線のテストと作

成」（p.1-34） の作業を行います。

DS-3、DS3N-12、DS3i-N-12、または EC-1 ポートのファシリティ ループバック回線のテストと作成

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。カードを

ダブルクリックして、カード ビューを表示します。

ステップ 4 Maintenance > Loopback タブをクリックします。



第 1 章      一般的なトラブルシューティング

1.2　ループバックによる電気回線パスのトラブルシューティング

1-35
Cisco ONS 15454 トラブルシューティング ガイド

78-17734-01-J

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 「電気回路ケーブル接続のテスト」（p.1-36） の作業を行います。

発信元 DS3E または DS3XM ポートでのファシリティ ループバックの作成

この手順は、DS3E、DS3XM-6、および DS3XM-12 カードに適用されます。DS3XM カードの FEAC

ループバック機能は使用しません。FEAC の詳細については、「1.3　FEAC ループバックによる

DS3XM-6 または DS3XM-12 カードの電気回路パスのトラブルシューティング」（p.1-54） を参照し

てください。

ステップ 1 テストするポートに電気テスト セットを接続します。

適切なケーブル接続で、電気テスト セットの Tx および Rx 端末を、テストするポート用の EIA コ

ネクタまたは DSx パネルに接続します。Tx および Rx 端末は、同じポートに接続します。必要に応

じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照してくだ

さい）。

ステップ 2 CTC ノード ビューで、カードをダブルクリックして、カード ビューを表示します。

ステップ 3 これらのカードのいずれかの Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 4 DS3 タブでは、テストするポートに対して、Admin State カラムから OOS,MT を選択します。この

カードがマルチポート カードの場合、テストするポートに対応する行を選択します。DS1 タブで

は、DS-1 がイン サービスになっていないかぎり、状態選択は必要ありません。Derived State が

OOS,DSBLD の場合、DS-1 に対してループバック / 送信コードを選択することはできません。

ステップ 5 テストするポートに対して、Loopback Type カラムから Facility を選択します。このカードがマルチ

ポート カードの場合、テストするポートに対応する行を選択します。

ステップ 6 Apply をクリックします。

ステップ 7 確認用ダイアログボックスで Yes をクリックします。

（注） ループバックのセットアップ時には、通常、「LPBKFACILITY（DS1、DS3）」（p.2-179） が
表示されます。ループバックを削除すると、この状態はクリアされます。
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ステップ 8 「DS3E または DS3XM ポート ファシリティ ループバック回線のテストと解除」（p.1-36） の作業を行

います。

DS3E または DS3XM ポート ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。カードを

ダブルクリックして、カード ビューを表示します。

ステップ 4 これらのカードのいずれかの Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 「電気回路ケーブル接続のテスト」（p.1-36） の作業を行います。

電気回路ケーブル接続のテスト

ステップ 1 問題があると考えられるケーブル接続（テスト セットと DSx パネルまたは EIA ポート間のケーブ

ル）を、良好なケーブルと交換します。詳細については、『Cisco ONS 15454 Procedure Guide』の

「Install Cards and Fiber-Optic Cable」の章を参照してください。

良好なケーブルを使用できない場合は、テスト セットを使用して問題があると考えられるケーブル

をテストします（テスト セットの使用については、製造元の説明を参照してください）。問題があ

ると考えられるケーブルを DSx パネルまたは EIA から取り外し、テスト セットの Tx および Rx 端

末に接続します。トラフィックを伝送し、ケーブルが良好であるか、不良であるかを判断します。

ステップ 2 良好なケーブルを取り付けて、ループバック回線にテスト用トラフィックを再送信します。測定の

結果、回線に異常がない場合は、ケーブルの欠陥が問題であったと考えられます。
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ステップ 3 不良なケーブルを交換します。

ステップ 4 電気回路カードのカード ビューで、タイプに応じて、Maintenance > Loopback  タブ、Maintenance

> DS1 タブ、または Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 「電気回路カードのテスト」（p.1-37） の作業を行います。

電気回路カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 電気回路カードのカード ビューで、タイプに応じて、Maintenance > Loopback  タブ、Maintenance

> DS1 タブ、または Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 6 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 7 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 8 Apply をクリックします。
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ステップ 9 確認用ダイアログボックスで Yes をクリックします。

ステップ 10「EIA のテスト」（p.1-38） の作業を行います。

EIA のテスト

ステップ 1 次のように EIA を取り外して再度取り付け、正しく挿し込まれていることを確認します。

a. 下部のバックプレーン カバーを外します。カバーを ONS 15454 に固定している 5 本のネジを

緩めて、シェルフ アセンブリから引き抜きます。

b. EIA パネルを固定している周囲の 9 本のネジを緩めます。

c. EIA パネルを下から持ち上げて、シェルフ アセンブリから取り外します。

d. 該当する EIA の取り付け手順に従ってください。手順については、『Cisco ONS 15454 Procedure
Guide』の「Install the Shelf and Backplane Cable」の章を参照してください。

ステップ 2 良好なケーブル接続、良好なカード、および再度取り付けた EIA を使用して、ループバック回線に

テスト用トラフィックを再送信します。測定の結果、回線に異常がない場合は、EIA が正しく挿し

込まれていなかったことが問題であったと考えられます。ステップ 16 へ進んでください。問題が

解消せず、EIA が正しく固定されている場合は、ステップ 3 へ進みます。

ステップ 3 電気回路カードのカード ビューで、タイプに応じて、Maintenance > Loopback  タブ、Maintenance

> DS1 タブ、または Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 4 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 5 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 6 Apply をクリックします。

ステップ 7 確認用ダイアログボックスで Yes をクリックします。

ステップ 8 測定の結果、回線に異常がある場合は、EIA の欠陥が問題であると考えられます。RMA プロセス

を通じて、不良 EIA をシスコに返送してください。詳しくは、弊社テクニカル サポートにお問い

合わせください。

ステップ 9 不良 EIA を交換します。「電気回路インターフェイス アセンブリの交換」（p.2-302） の作業を行いま

す。

ステップ 10 良好なケーブル接続、良好なカード、および交換した EIA を使用して、ループバック回線にテスト

用トラフィックを再送信します。測定の結果、回線に異常がある場合は、ファシリティ ループバッ

クのすべての手順を繰り返します。
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ステップ 11 測定の結果、回線に異常がない場合は、EIA の欠陥が問題であったと考えられます。Maintenance

> Loopback タブ、Maintenance > DS1 タブ、または Maintenance > DS3 タブをクリックして、ファ

シリティ ループバックを解除します。

ステップ 12 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 13 テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、

IS,AINS）を選択します。

ステップ 14 Apply をクリックします。

ステップ 15 確認用ダイアログボックスで Yes をクリックします。

ステップ 16「1.2.6　宛先ノードの電気回路ポートでのヘアピン テストの実行（イーストからウェスト）」（p.1-39）

の作業を行います。

1.2.6　宛先ノードの電気回路ポートでのヘアピン テストの実行（イーストからウェス
ト）

ヘアピン テストは、ネットワーク回線内のクロスコネクト カードで実行し、発信元と宛先で同じ

ポートを使用します。カード経由でヘアピンが正常に完了すれば、クロスコネクト カードが回線不

良の原因である可能性が切り分けられます。図 1-16 に、宛先ノードのポートでのヘアピン ループ

バックの一例を示しています。

図 1-16 宛先ノードの DS-N ポートでのヘアピン

（注） ONS 15454 は、クロスコネクト カードのシンプレックス オペレーションをサポートしていません。

各ノードに、同じタイプのクロスコネクト カードを 2 枚取り付ける必要があります。

（注） ヘアピン ループバックには、現場要員が必要です。

「宛先ノードのポートでのヘアピン回線の作成」（p.1-40） の作業を行います。
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宛先ノードのポートでのヘアピン回線の作成

ステップ 1 テストするポートに電気テスト セットを接続します。

a. 「1.2.5　宛先ノードの電気回路ポートでのファシリティ ループバックの実行（イーストから

ウェスト）」（p.1-33） の作業を完了したばかりであれば、宛先ノードの電気回路ポートに電気テ

スト セットを接続したままにします。

b. この手順を開始するときに、電気テスト セットが電気回路ポートに接続されていない場合は、

適切なケーブル接続で、電気テスト セットの Tx および Rx 端子を、テストするポートの DSx
パネルまたは EIA コネクタに接続します。Tx および Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、次のようにテスト ポートにヘアピン回線をセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「Hairpin1」のような分かりやすい名前を

指定します。

e. サイズ（STS-1 など）を選択します。

f. Bidirectional チェックボックスをオフにします。State、SD Threshold、および SF Threshold の値

はデフォルトのままにします。

g. Next をクリックします。

h. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。Use Secondary Source のチェックはオフのまま

にします。

i. Next をクリックします。

j. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。Use Secondary Destination の
チェックをオフのままにします。

k. Next をクリックします。

l. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 新しく作成した回線が Circuits タブに表示され、Dir カラムに単方向回線として示されていることを

確認します。

ステップ 5 「電気ヘアピン回線のテストと削除」（p.1-41） の作業を行います。
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電気ヘアピン回線のテストと削除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ヘアピン回線でのテストは終了です。次のようにヘアピン回

線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のヘアピン回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧からヘアピン回線が削除されていることを確認します。

ステップ 4 「スタンバイ クロスコネクト カードのテスト」（p.1-41） の作業を行います。

スタンバイ クロスコネクト カードのテスト

（注） この手順を実行するノードでは、クロスコネクト カードを 2 枚（アクティブとスタンバイ）を使

用している必要があります。

ステップ 1 アクティブ カードにするために、スタンバイ クロスコネクト カードでリセットを実行します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. スタンバイ クロスコネクト カードの上にカーソルを置きます。

c. 右クリックして、RESET CARD を選択します。

d. 確認用ダイアログボックスで Yes をクリックします。

ステップ 2 ループバック回線を再テストする前に、クロスコネクト カードで外部切り替えコマンド（サイド切

り替え）を開始します。

注意 クロスコネクトのサイド切り替えは、XC-VXC-10G カードを使用したサイド切り替えを除き、サー

ビスに影響します。ノードのカードにある実トラフィックは、 大 50 ミリ秒までの中断に耐えら

れます。XC-VXC-10G のサイド切り替えはエラーレスです。 
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a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross Connect > Cards タブを選択します。

c. Cross-Connect Cards 領域で Switch をクリックします。

d. Confirm Switch ダイアログボックスで Yes をクリックします。

（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。

ステップ 3 ループバック回線にテスト用トラフィックを再送信します。

これで、テスト用トラフィックは代替のクロスコネクト カード経由で伝送されるようになります。

ステップ 4 測定の結果、回線に異常がある場合は、クロスコネクト カードが問題の原因ではないと想定されま

す。次のようにヘアピン回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のヘアピン回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧からヘアピン回線が削除されていることを確認します。

ステップ 5 元のクロスコネクト カードに問題があることを確認するには、「元のクロスコネクト カードの再テ

スト」（p.1-42） の作業を行います。

元のクロスコネクト カードの再テスト

ステップ 1 クロスコネクト カードで外部切り替えコマンド（サイド切り替え）を開始します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross-Connect > Cards タブを選択します。

c. Cross Connect Cards メニューから、Switch を選択します。

d. Confirm Switch ダイアログボックスで Yes をクリックします。

（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。
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ステップ 2 ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がある場合は、カードの欠陥が問題であると考えられます。RMA プロセ

スを通じて、不良カードをシスコに返送してください。弊社テクニカル サポートにお問い合わせの

上、ステップ 4 へ進みます。テストの結果、回線に異常が見つからない場合は、ステップ 5 に進み

ます。

ステップ 4 不良なクロスコネクト カードについて、「イン サービス クロスコネクト カードの物理的な交換」

（p.2-293） の作業を行います。

ステップ 5 測定の結果、回線に異常がない場合は、クロスコネクト カードに一時的な問題があり、サイド切り

替えによってその問題が解消された可能性があります。次のようにヘアピン回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のヘアピン回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧からヘアピン回線が削除されていることを確認します。

ステップ 6 「1.2.7　電気回線を伝送している発信元ノード OC-N STS での XC ループバックの実行（イーストか

らウェスト）」（p.1-43） の作業を行います。

1.2.7　電気回線を伝送している発信元ノード OC-N STS での XC ループバックの実行
（イーストからウェスト）

XC ループバックでは、カード上の他のスパンから OC-N スパンを切り分けて、回線の OC-N スパ

ンに問題があるかどうかをテストします。また、クロスコネクト カードが問題のある回線の障害原

因になっているかどうかを切り分けます。ループバックは、ネットワーク回線のクロスコネクト

カードで行います。図 1-17 に、発信元 OC-N ポートの XC ループバックの一例を示します。

（注） OC-N カードでの XC ループバックは、他の回線のトラフィックに影響を及ぼしません。

（注） XC ループバックには、現場要員は不要です。

（注） 回線の発信元現用ポートか、1+1 保護グループの予備ポートで、XC ループバックを実施できます。
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図 1-17 発信元 OC-N ポートでの XC ループバック

「電気回線を伝送する発信元 OC-N ポートでの XC ループバックの作成」（p.1-44） の作業を行います。

電気回線を伝送する発信元 OC-N ポートでの XC ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.2.6　宛先ノードの電気回路ポートでのヘアピン テストの実行（イーストからウェスト）」

（p.1-39） の作業が完了したばかりであれば、発信元ノードのポートに光テスト セットを接続し

たままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx お
よび Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、テストする回線を次のようにアウト オブ サービス状態にします。

a. ノード ビューで、Circuits タブをクリックします。

b. 回線をクリックし、Edit をクリックします。

c. Edit Circuit ダイアログボックスで、State タブをクリックします。

d. Target Circuit Admin State ドロップダウン リストから OOS,MT を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 CTC を使用して、テストする回線に XC ループバックをセットアップします。

a. ノード ビューで、OC-N カードをダブルクリックしてカード ビューを表示します。

b. Maintenance > Loopback > SONET STS タブをクリックします。

c. テストするポートの XC Loopback カラムのチェックボックスをクリックします。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。
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ステップ 5 「XC ループバック回線のテストと解除」（p.1-45） の作業を行います。

XC ループバック回線のテストと解除

（注） この手順は、OC-N カードだけで実行します。

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、クロスコネクトでのテストは終了です。XC ループバックを

解除します。

a. カード ビューで、Maintenance > Loopback > SONET STS タブをクリックします。

b. テスト対象の回線に対して、XC Loopback カラムにあるチェックボックスをオフにします。

c. Apply をクリックします。

d. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「スタンバイ クロスコネクト カードのテスト」（p.1-45） の作業を行います。

スタンバイ クロスコネクト カードのテスト

ステップ 1 スタンバイ クロスコネクト カードでリセットを実行します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. スタンバイ クロスコネクト カードの上にカーソルを置きます。

c. 右クリックして、RESET CARD を選択します。

d. 確認用ダイアログボックスで Yes をクリックします。

ステップ 2 ループバック回線を再テストする前に、クロスコネクト カードで外部切り替えコマンド（サイド切

り替え）を開始します。

注意 クロスコネクトのサイド切り替えは、XC-VXC-10G カードを使用したサイド切り替えを除き、サー

ビスに影響します。ノードのカードにある実トラフィックは、 大 50 ミリ秒までの中断に耐えら

れます。XC-VXC-10G のサイド切り替えではエラーは発生しません。 
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a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross Connect > Cards タブを選択します。

c. Cross-Connect Cards 領域で Switch をクリックします。

d. Confirm Switch ダイアログボックスで Yes をクリックします。

（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。

ステップ 3 ループバック回線にテスト用トラフィックを再送信します。

これで、テスト用トラフィックは代替のクロスコネクト カード経由で伝送されるようになります。

ステップ 4 測定の結果、回線に異常がある場合は、クロスコネクト カードが問題の原因ではないと考えられま

す。XC ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象の XC ループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧から XC ループバック回線が削除されていることを確認します。測定の結

果、回線に異常がない場合は、クロスコネクト カードに問題がある可能性があります。

ステップ 5 元のクロスコネクト カードに問題があることを確認するには、「元のクロスコネクト カードの再テ

スト」（p.1-46） の作業を行います。

元のクロスコネクト カードの再テスト

（注） この手順は、OC-N カードとクロスコネクト カードだけで実行します。

ステップ 1 クロスコネクト カードで外部切り替えコマンド（サイド切り替え）を開始します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross-Connect > Cards タブを選択します。

c. Cross-Connect Cards 領域で Switch をクリックします。

d. Confirm Switch ダイアログボックスで Yes をクリックします。
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（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。

ステップ 2 ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がある場合は、カードの欠陥が問題であると考えられます。RMA プロセ

スを通じて、不良カードをシスコに返送してください。弊社テクニカル サポートにお問い合わせの

上、ステップ 4 へ進みます。回線に不良が見られず、カードも欠陥があることを示していない場合

は、テストを終了します。

ステップ 4 不良なクロスコネクト カードについて、「イン サービス クロスコネクト カードの物理的な交換」

（p.2-293） の作業を行います。ステップ 5 を実行します。

ステップ 5 測定の結果、回線に異常がない場合は、クロスコネクト カードに一時的な問題があり、サイド切り

替えによってその問題が解消された可能性があります。XC ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象の XC ループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. 問題が解決しなければ、「1.2.8　発信元ノードの電気回路ポートでのターミナル ループバック

の実行（イーストからウェスト）」（p.1-47） へ進みます。

1.2.8　発信元ノードの電気回路ポートでのターミナル ループバックの実行（イースト
からウェスト）

ターミナル ループバック テストは、発信元ノードの電気回路ポートなど、回線内の発信元ノード

の電気回路ポートで実行されます。まず、宛先ノードの電気回路ポートで開始し、発信元ノードの

電気回路ポートでループバックする双方向回線を作成します。次に、ターミナル ループバック テ

ストに進みます。発信元ノードの電気回路ポートへのターミナル ループバックが正常に完了すれ

ば、回線が発信元の電気回路ポートまで問題ないことが実証されます。図 1-18 に、発信元 DS-N

ポートでのターミナル ループバックの一例を示します。

図 1-18 発信元 DS-N ポートでのターミナル ループバック
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注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。トラフィック

を保護するには、ターゲット ループバック ポートにロックアウトまたは強制切り替えを適用しま

す。基本的な手順については、「2.9.2　保護切り替え、ロック開始、クリア」（p.2-278） を参照して

ください。これらの操作の詳細については、『Cisco ONS 15454 Procedure Guide』の「Maintain the
Node」の章を参照してください。

（注） ターミナル ループバックには、現場要員が必要です。

（注） ONS 15454 DS-3 端末ループバックでは、ループバックから離れる方向には AIS を送信しません。

AIS の代わりに、ループバックに一連の信号が伝送されます。DS3/EC1-48 カードは、必要な場合

には、端末ループバックで AIS を送信するようにプロビジョニングできます。

カードのタイプに応じて、「発信元 DS-1、DS-3、DS3N-12、DS3i-N-12、または EC1 ポートでのター

ミナル ループアックの作成」（p.1-48） または 「発信元 DS3E または DS3XM ポートでのターミナル

ループバックの作成」（p.1-50） を実行します。続いて、説明に従いループバックをテストし、解除

します。

発信元 DS-1、DS-3、DS3N-12、DS3i-N-12、または EC1 ポートでのターミナル ループアックの作成

ステップ 1 テストするポートに電気テスト セットを接続します。

a. 「1.2.7　電気回線を伝送している発信元ノード OC-N STS での XC ループバックの実行（イース

トからウェスト）」（p.1-43） の作業を完了したばかりであれば、発信元ノードの DS-N ポートに

電気テスト セットを接続したままにします。

b. 電気テスト セットを DS-N ポートに接続せずにこの手順を開始する場合は、適切なケーブル接

続で、電気テスト セットの Tx および Rx 端子を、テストするポートの EIA コネクタに接続し

ます。Tx と Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC のノード ビューで Circuits タブをクリックし、Create をクリックします。

ステップ 4 Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

ステップ 5 Next をクリックします。

ステップ 6 次の Circuit Creation ダイアログボックスで、回線に「DS1toDS4」のような分かりやすい名前を指定

します。

ステップ 7 Bidirectional  チェックボックスは、オンの状態のままにします。

ステップ 8 Next をクリックします。
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ステップ 9 Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、

Port、および STS（または VT） を選択します。

ステップ 10 Next をクリックします。

ステップ 11 Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ Node、

カード Slot、Port、および STS（または VT）を選択します。

c. Next をクリックします。

d. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 12 Dir カラムに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL（DS1、DS3）」（p.2-184） が
表示されます。ループバックを削除すると、この状態はクリアされます。

（注） ONS 15454 DS-3 端末ループバックでは、ループバックから離れる方向には AIS を送信しません。

AIS の代わりに、ループバックに一連の信号が伝送されます。DS3/EC1-48 カードは、必要な場合

には、端末ループバックで AIS を送信するようにプロビジョニングできます。

ステップ 13 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、宛先ノードの DS-N カードなど、ループバックが必要なカードをダブルク

リックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 14「DS-3、DS3N-12、DS3i-N-12、または EC1 ポートのターミナル ループバックのテストと解除」

（p.1-50） の作業を行います。
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DS-3、DS3N-12、DS3i-N-12、または EC1 ポートのターミナル ループバックのテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ターミナル ループ

バックが設定されている宛先ノードの電気回路カードをダブルクリックします。

ステップ 4 Maintenance > Loopback タブをクリックします。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）

を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 ターミナル ループバックを解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 10「発信元の電気回路カードのテスト」（p.1-53） の作業を行います。

発信元 DS3E または DS3XM ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに電気テスト セットを接続します。

a. 「1.2.7　電気回線を伝送している発信元ノード OC-N STS での XC ループバックの実行（イース

トからウェスト）」（p.1-43） の作業を完了したばかりであれば、発信元ノードの DS-N ポートに

電気テスト セットを接続したままにします。

b. 電気テスト セットを DS-N ポートに接続せずにこの手順を開始する場合は、適切なケーブル接

続で、電気テスト セットの Tx および Rx 端子を、テストするポートの EIA コネクタに接続し

ます。Tx と Rx は、同じポートに接続します。

c. 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を

参照してください）。

ステップ 2 CTC のノード ビューで Circuits タブをクリックし、Create をクリックします。
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ステップ 3 Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

ステップ 4 Next をクリックします。

ステップ 5 次の Circuit Creation ダイアログボックスで、回線に「DS1toDS5」のような分かりやすい名前を指定

します。

ステップ 6 Bidirectional  チェックボックスは、オンの状態のままにします。

ステップ 7 Next をクリックします。

ステップ 8 Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、

Port、および STS（または VT） を選択します。

ステップ 9 Next をクリックします。

ステップ 10 Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ Node、

カード Slot、Port、および STS（または VT）を選択します。

d. Next をクリックします。

e. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 11 Dir カラムに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL（DS1、DS3）」（p.2-184） が
表示されます。ループバックを削除すると、この状態はクリアされます。

（注） ONS 15454 DS-3 端末ループバックでは、ループバックから離れる方向には AIS を送信しません。

AIS の代わりに、ループバックに一連の信号が伝送されます。DS3/EC1-48 カードは、必要な場合

には、端末ループバックで AIS を送信するようにプロビジョニングできます。

ステップ 12 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、宛先ノードの DS-N カードなど、ループバックが必要なカードをダブルク

リックします。

c. Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。
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ステップ 13 DS3 タブでは、テストするポートに対して、Admin State カラムから OOS,MT を選択します。この

カードがマルチポート カードの場合、テストするポートに対応する行を選択します。DS1 タブで

は、DS-1 がイン サービスになっていないかぎり、状態選択は必要ありません。Derived State が

OOS,DSBLD の場合、DS-1 に対してループバック / 送信コードを選択することはできません。

d. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 14「DS3E または DS3XM ポート ターミナル ループバック回線のテストと解除」（p.1-52） の作業を行い

ます。

DS3E または DS3XM ポート ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ターミナル ループ

バックが設定されている宛先ノードの電気回路カードをダブルクリックします。

ステップ 4 カードのタイプに応じて、Maintenance > Loopback  タブ、Maintenance > DS1 タブ、または

Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

ステップ 5 テストするポートに対して、Loopback Type カラムから None を選択します。

ステップ 6 テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）

を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 ターミナル ループバックを解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。
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ステップ 10「発信元の電気回路カードのテスト」（p.1-53） の作業を行います。

発信元の電気回路カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良な電気回路カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行いま

す。

ステップ 5 ポートのターミナル ループバック状態を解除します。

a. ターミナル ループバックが設定されている宛先ノードの電気回路カードをダブルクリックし

ます。

b. カードのタイプに応じて、Maintenance > Loopback  タブ、Maintenance > DS1 タブ、または

Maintenance > DS3 タブをクリックします。

（注） DS-3 Admin State は DS-1 Derived State の基本となります。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ターミナル ループバック回線を削除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

この回線のすべてのテストが完了しました。
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1.3　FEAC ループバックによる DS3XM-6 または DS3XM-12 カードの
電気回路パスのトラブルシューティング

DS3XM-6 カードと DS3XM-12 カードは、基本的な DS-3 カードでは使用できない FEAC 機能をサ

ポートしています。カード ビューで、DS3XM-6 または DS3XM-12 の Maintenance > DS1  タブをク

リックすると、さらに 2 つの機能カラムが表示されます。図 1-19 に、DS3 サブタブと追加の Send

Code および Inhibit FE Lbk 機能カラムを示します。

図 1-19 DS3XM-6 カードの FEAC 機能へのアクセス

FEAC の「far end」（遠端）とは、回線の遠端ではなく、DS3XM カードに接続されている装置を指

します。図 1-20 では、DS3XM-6（近端）ポートが回線ループ コードを送信するように設定されて

いた場合、コードは DS3XM-6（遠端）ポートではなく、接続されたテスト セットに送信されます。

図 1-20 FEAC 回線図
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1.3.1　FEAC 送信コード

DS3XM-6 または DS3XM-12 カードの Maintenance タブの Send Code カラムは、CBIT フレーミング

で設定された OOS-MA,MT ポートにだけ適用されます。このカラムで、ユーザは No Code（デフォ

ルト）または回線ループ コードを選択できます。回線ループ コードを選択すると、接続されたファ

シリティに送信される CBIT オーバーヘッドに回線ループ アクティベート FEAC が挿入されます。

このコードは、ファシリティから ONS 15454 へのループバックを開始します。No Code を選択する

と、回線ループ ディアクティベート FEAC コードが、接続された装置に送信され、ループバックが

除去されます。DS-3 回線に多重化された 28 の DS-1 回線に FEAC を挿入することもできます。

1.3.2　DS-3E および DS3i-N-12 のループバック禁止

DS-3E および DS-3i-N-12 カードは、DS-3 レベルの FEAC コードに応答します（送信はしません）。

これらのカードの Maintenance ウィンドウにある Inhibit Lbk チェック ボックスを使用して、これら

のカードのポートでの FEAC 応答を禁止できます。

1.3.3　DS3XM-6 および DS3XM-12 の FEAC ループバックの禁止

DS3XM-6 および DS3XM-12 ポートと多重化された DS-1 回線は、FEAC 回線ループ コードを受信す

ると、ループバックを開始します。DS-3 ポートの Inhibit FE Lbk チェック ボックスがチェックされ

ていた場合、このポートは受信した FEAC 回線ループ コードを無視して、ループバックしません

（コードを返しません）。FEAC ループバック応答を禁止するように設定できるのは、DS-3 ポートだ

けです。個々の DS-1 ポート（DS3XM DS1 タブでアクセス）で応答を禁止することはできません。

DS-3 ポートの遠端ループバック応答を禁止した場合でも、この DS-3 ポートとそれに含まれる DS-1

回線は、ターミナルまたはファシリティ ループバックに応答します。

1.3.4　FEAC アラーム

ONS 15454 ポートが FEAC ループバックのアクティブ化コードを受信すると、

「LPBKDS1FEAC-CMD」（p.2-177） または 「LPBKDS3FEAC」（p.2-177） を生成します。この状態は、

ポートが FEAC ループバックを非アクティブ化するコマンドを受信するとクリアされます。ノード

が FEAC ループバック コマンドを遠端に送信した場合、送信側ノードは近端ポートに対して

「LPBKDS1FEAC-CMD」（p.2-177） または 「LPBKDS3FEAC-CMD」（p.2-178） を生成します。
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1.4　ループバックによる光回線パスのトラブルシューティング
多くの場合、ファシリティ ループバック、ターミナル ループバック、およびクロスコネクト ルー

プバック回線を使用して、ネットワーク全体の回線パスをテストしたり、障害を論理的に切り分け

たりします。回線パスに沿った各ポイントでループバック テストを実施することにより、考えられ

る障害ポイントを体系的に切り分けます。

この章で説明する手順は、OC-N カードに適用されます。G シリーズのイーサネット カードについ

ては、「1.5　ループバックによるイーサネット回線パスのトラブルシューティング」（p.1-81） を参

照してください。ここで扱う例では、3 ノード BLSR 上の OC-N 回線をテストします。ファシリ

ティ、クロスコネクトとターミナル ループバックを組み合わせて、例に示しているシナリオでは、

回線パスをトレースし、考えられる障害箇所を検証して除去します。この工程は、7 つのネットワー

ク試験手順で構成されます。

（注） 回線のテスト手順は、回線の種類とネットワーク トポロジによって異なります。

1. 発信元ノードの OC-N ポートでのファシリティ ループバック

2. 発信元ノードの OC-N ポートでのターミナル ループバック

3. 発信元 OC-N ポートでのクロスコネクト ループバック

4. 中間ノードの OC-N ポートでのファシリティ ループバック

5. 中間ノードの OC-N ポートでのターミナル ループバック

6. 宛先ノードの OC-N ポートでのファシリティ ループバック

7. 宛先ノードの OC-N ポートでのターミナル ループバック

（注） ファシリティ、ヘアピン、ターミナル ループバック テストには、現場要員が必要です。

1.4.1　発信元ノードの光ポートでのファシリティ ループバックの実行

ファシリティ ループバック テストは、ネットワーク回線内のノードの発信元ポートで実行されま

す。次のテスト例では、発信元ノード内の発信元 OC-N ポートが対象です。このポートでのファシ

リティ ループバックが正常に完了すれば、OC-N ポートが障害ポイントである可能性を切り分けら

れます。図 1-21 に、回線の発信元 OC-N ポートでのファシリティ ループバックの一例を示します。

図 1-21 回線発信元 OC-N ポートでのファシリティ ループバック
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注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ファシリティ ループバックには、現場要員が必要です。

「発信元の光ポートでのファシリティ ループバックの作成」（p.1-57） の作業を行います。

発信元の光ポートでのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

適切なケーブルを使用して、光テスト セットの Tx と Rx 端末をテスト対象のポートに接続します。

Tx および Rx 端末は、同じポートに接続します。必要に応じてテスト セットを調節します（テスト

セットの使用については、製造元の説明を参照してください）。

ステップ 2 CTC ノード ビューで、カードをダブルクリックして、カード ビューを表示します。

ステップ 3 Maintenance > Loopback > Port タブをクリックします。

ステップ 4 テストするポートに対して、Admin State カラムから OOS,MT を選択します。このカードがマルチ

ポート カードの場合、目的のポートに対応する行を選択します。

ステップ 5 テストするポートに対して、Loopback Type カラムから Facility を選択します。このカードがマルチ

ポート カードの場合、目的のポートに対応する行を選択します。

ステップ 6 Apply をクリックします。

ステップ 7 確認用ダイアログボックスで Yes をクリックします。

（注） ループバック セットアップ時には、通常、「LPBKFACILITY（OCN）」（p.2-182） または

「LPBKFACILITY（G1000）」（p.2-181） が表示されます。ループバックを削除すると、この

状態はクリアされます。

ステップ 8 「ファシリティ ループバック回線のテストと解除」（p.1-58） の作業を行います。
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ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ファシリ

ティ ループバックを解除します。

a. Maintenance > Loopback > Port タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「OC-N カードのテスト」（p.1-58） の作業を行います。

OC-N カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ファシリティ ループバックを解除します。

a. Maintenance > Loopback > Port タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「1.4.2　発信元ノードの光ポートでのターミナル ループバックの実行」（p.1-59） の作業を行います。
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1.4.2　発信元ノードの光ポートでのターミナル ループバックの実行

ターミナル ループバック テストは発信元ノードの光ポートで実行されます。次のテスト例では、発

信元ノード内の発信元 OC-N ポートが対象です。まず、ノードの宛先光ポートで始まり、ノードの

発信元光ポートでループバックする双方向回線を作成します。次に、ターミナル ループバック テ

ストに進みます。ノードの発信元ポートへのターミナル ループバックが正常に完了すれば、回線が

発信元ポートまで問題ないことが実証されます。図 1-22 に、発信元 OC-N ポートでのターミナル

ループバックの一例を示します。

図 1-22 発信元ノードの OC-N ポートでのターミナル ループバック

ターミナル ループバック状態の OC-N カードには、図 1-23 に示すように、CTC でアイコンが表示

されます。

図 1-23 ターミナル ループバック インジケータ

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ターミナル ループバックには、現場要員が必要です。

「発信元ノードの光ポートでのターミナル ループバックの作成」（p.1-59） の作業を行います。

発信元ノードの光ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。
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a. 「1.4.1　発信元ノードの光ポートでのファシリティ ループバックの実行」（p.1-56） の作業が完了

したばかりであれば、発信元ノードの OC-N ポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

c. 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を

参照してください）。

ステップ 2 CTC を使用して、次のようにテスト ポートにターミナル ループバックをセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「OCN1toOCN2」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 3 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL（OCN）」（p.2-187） が表示

されます。ループバックを削除すると、この状態はクリアされます。

ステップ 4 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. ノード ビューで、発信元ノードの宛先 OC-N カードなど、ループバックが必要なカードをダブ

ルクリックします。

b. Maintenance > Loopback > Port タブをクリックします。

c. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

d. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 5 「ターミナル ループバック回線のテストと解除」（p.1-61） の作業を行います。
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ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートのターミナ

ル ループバック状態を解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback > Port タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 5 「光カードのテスト」（p.1-61） の作業を行います。

光カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。
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ステップ 5 ネットワーク パスの次のセグメントの試験に進む前に、発信元カード ポートのターミナル ループ

バックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback > Port タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ネットワーク回線パスの次のセグメントの試験に進む前に、ターミナル ループバック回線を解除し

ます。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.4.3　発信元の光ポートでの XC ループバックの実行」（p.1-62） の作業を行います。

1.4.3　発信元の光ポートでの XC ループバックの実行

（注） この手順は、OC-N カードだけで実行し、クロスコネクト回線の接続をテストします。

（注） 回線の発信元現用ポートか、1+1 保護グループの予備ポートで、XC ループバックを実施できます。

（注） XC ループバックには、現場要員は不要です。

XC ループバック テストは、ネットワーク回線のクロスコネクト カードで実行します。クロスコネ

クト カードを介して OC-N カードからの XC ループバックが正常に完了すると、不良な回線の障害

原因として、そのクロスコネクト カードを取り除けます。図 1-24 に、発信元 OC-N ポートの XC

ループバック パスの一例を示します。
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図 1-24 発信元 OC-N ポートでの XC ループバック

「発信元ノードの光ポートでの XC ループバックの作成」（p.1-63） の作業を行います。

発信元ノードの光ポートでの XC ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.4.2　発信元ノードの光ポートでのターミナル ループバックの実行」（p.1-59） の作業が完了

したばかりであれば、発信元ノードのポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx お
よび Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、テストする回線を次のようにアウト オブ サービス状態にします。

a. ノード ビューで、Circuits タブをクリックします。

b. 回線をクリックし、Edit をクリックします。

c. Edit Circuit ダイアログボックスで、State タブをクリックします。

d. Target Circuit Admin State ドロップダウン リストから OOS,MT を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 CTC を使用して、テストする回線に XC ループバックをセットアップします。

a. ノード ビューで、OC-N カードをダブルクリックしてカード ビューを表示します。

b. Maintenance > Loopback > SONET STS タブをクリックします。

c. テストするポートに対して、XC Loopback カラムにあるチェックボックスをオンにします。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。
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ステップ 5 「XC ループバック回線のテストと解除」（p.1-64） の作業を行います。

XC ループバック回線のテストと解除

（注） この手順は、OC-N カードだけで実行します。

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、クロスコネクトでのテストは終了です。XC ループバックを

解除します。

a. カード ビューで、Maintenance > Loopback > SONET STS タブをクリックします。

b. テスト対象の回線に対して、XC Loopback カラムにあるチェックボックスをオフにします。

c. Apply をクリックします。

d. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「スタンバイ クロスコネクト カードのテスト」（p.1-64） の作業を行います。

スタンバイ クロスコネクト カードのテスト

（注） この手順は、クロスコネクト カードだけで実行します。

ステップ 1 スタンバイ クロスコネクト カードでリセットを実行します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. スタンバイ クロスコネクト カードの上にカーソルを置きます。

c. 右クリックして、RESET CARD を選択します。

d. 確認用ダイアログボックスで Yes をクリックします。

ステップ 2 ループバック回線を再テストする前に、クロスコネクト カードで外部切り替えコマンド（サイド切

り替え）を開始します。
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注意 クロスコネクトのサイド切り替えは、XC-VXC-10G カードを使用したサイド切り替えを除き、サー

ビスに影響します。ノードのカードにある実トラフィックは、 大 50 ミリ秒までの中断に耐えら

れます。XC-VXC-10G のサイド切り替えはエラーレスです。 

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross Connect > Cards タブを選択します。

c. Cross-Connect Cards 領域で Switch をクリックします。

d. Confirm Switch ダイアログボックスで Yes をクリックします。

（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。

ステップ 3 ループバック回線にテスト用トラフィックを再送信します。

これで、テスト用トラフィックは代替のクロスコネクト カード経由で伝送されるようになります。

ステップ 4 測定の結果、回線に異常がある場合は、クロスコネクト カードが問題の原因ではないと想定されま

す。XC ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象の XC ループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

e. Circuits タブの一覧から XC ループバック回線が削除されていることを確認します。測定の結

果、回線に異常がない場合は、クロスコネクト カードに問題がある可能性があります。

ステップ 5 元のクロスコネクト カードに問題があることを確認するには、「元のクロスコネクト カードの再テ

スト」（p.1-66） の作業を行います。
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元のクロスコネクト カードの再テスト

（注） この手順は、OC-N カードとクロスコネクト カードだけで実行します。

ステップ 1 クロスコネクト カードで外部切り替えコマンド（サイド切り替え）を開始します。

a. スタンバイ クロスコネクト カードを判別します。物理ノードと CTC のノード ビュー ウィンド

ウの両方で、スタンバイ クロスコネクトの ACT/SBY LED はオレンジであり、アクティブ カー

ドの ACT/SBY LED はグリーンです。

b. ノード ビューで、Maintenance > Cross-Connect > Cards タブを選択します。

c. Cross-Connect Cards 領域で Switch をクリックします。

d. Confirm Switch ダイアログボックスで Yes をクリックします。

（注） アクティブ クロスコネクトがスタンバイ モードになると、元のスタンバイ カードがア

クティブになり、そのカードの ACT/SBY LED がグリーンに変わります。元のアクティ

ブ カードはスタンバイになり、そのカードの ACT/SBY LED はオレンジに変わります。

ステップ 2 ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がある場合は、カードの欠陥が問題であると考えられます。RMA プロセ

スを通じて、不良カードをシスコに返送してください。弊社テクニカル サポートにお問い合わせの

上、ステップ 4 へ進みます。回線に不良が見られず、カードも欠陥があることを示していない場合

は、テストを終了します。

ステップ 4 不良カードに対して、「イン サービス クロスコネクト カードの物理的な交換」（p.2-293） の作業を

行います。

ステップ 5 測定の結果、回線に異常がない場合は、クロスコネクト カードに一時的な問題があり、サイド切り

替えによってその問題が解消された可能性があります。XC ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象の XC ループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 6 「1.4.4　中間ノードでの光ポートのファシリティ ループバックの実行」（p.1-67） の作業を行います。
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1.4.4　中間ノードでの光ポートのファシリティ ループバックの実行

中間ポートでファシリティ ループバック試験を実行することにより、そのノードが回線障害の原因

かどうかを切り分けることができます。図 1-25 に示した状況では、中間 OC-N ポートでテストが実

行されます。

図 1-25 中間ノードの OC-N ポートでのファシリティ ループバック パス

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ファシリティ ループバックには、現場要員が必要です。

「中間ノードでの光ポートのファシリティ ループバックの作成」（p.1-67） の作業を行います。

中間ノードでの光ポートのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.4.3　発信元の光ポートでの XC ループバックの実行」（p.1-62） の作業が完了したばかりであ

れば、発信元ノードのポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。
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ステップ 3 CTC を使用して、次のようにテスト ポートにファシリティ ループバックをセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「OCN1toOCN3」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKFACILITY（OCN）」（p.2-182） が表示さ

れます。ループバックを削除すると、この状態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でファシリティ ループバックを作成します。

a. 中間ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要な中間ノードのカードをダブルクリックします。

c. Maintenance > Loopback > Port タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Facility を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「ファシリティ ループバック回線のテストと解除」（p.1-69） の作業を行います。
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ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ポートか

らファシリティ ループバックを解除します。

a. Maintenance > Loopback > Port タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ファシリティ ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 5 「光カードのテスト」（p.1-69） の作業を行います。

光カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートからファシリティ ループバックを解除します。

a. Maintenance > Loopback > Port タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。
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c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ファシリティ ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.4.5　中間ノードの光ポートでのターミナル ループバックの実行」（p.1-70） の作業を行います。

1.4.5　中間ノードの光ポートでのターミナル ループバックの実行

次のトラブルシューティング テストでは、中間ノードのポートに対してターミナル ループバック

を実行することにより、宛先ポートが回線障害の原因となっているかどうかを切り分けます。図

1-26 に示す例の状況では、ターミナル ループバックを、回線内の中間光ポートに対して実行しま

す。まず、発信元ノードの光ポートで始まり、中間ノードのポートでループバックする双方向回線

を作成します。次に、ターミナル ループバック テストに進みます。ノードでのターミナル ループ

バックが正常に完了すれば、このノードを回線障害の原因から除外します。

図 1-26 中間ノードの OC-N ポートでのターミナル ループバック パス

ファシリティ ループバック状態の OC-N カードには、図 1-27 に示すようにアイコンが表示されま

す。

図 1-27 ファシリティ ループバック インジケータ
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注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ターミナル ループバックには、現場要員が必要です。

「中間ノードの光ポートでのターミナル ループバックの作成」（p.1-71） の作業を行います。

中間ノードの光ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.4.4　中間ノードでの光ポートのファシリティ ループバックの実行」（p.1-67） の作業が完了

したばかりであれば、発信元ノードのポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、次のようにテスト ポートにターミナル ループバックをセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「OCN1toOCN4」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。



第 1 章      一般的なトラブルシューティング

1.4　ループバックによる光回線パスのトラブルシューティング

1-72
Cisco ONS 15454 トラブルシューティング ガイド

78-17734-01-J

ステップ 4 新しく作成した回線が Circuits タブに表示され、Dir カラムで双方向回線として表示されていること

を確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL（OCN）」（p.2-187） が表示

されます。ループバックを削除すると、この状態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 中間ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback > Port タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「光ターミナル ループバック回線のテストと解除」（p.1-72） の作業を行います。

光ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートからターミ

ナル ループバックを解除します。

a. カード ビューを表示するために、ターミナル ループバックが設定されている中間ノードのカー

ドをダブルクリックします。

b. Maintenance > Loopback > Port タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。
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ステップ 4 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 5 「光カードのテスト」（p.1-73） の作業を行います。

光カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートのターミナル ループバックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback > Port タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.4.6　宛先ノードの光ポートでのファシリティ ループバックの実行」（p.1-74） の作業を行います。
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1.4.6　宛先ノードの光ポートでのファシリティ ループバックの実行

宛先ポートでファシリティ ループバック試験を実行することにより、ローカル ポートが回線障害

の原因かどうか判別します。図 1-28 に、宛先ノードの OC-N ポートで実行するファシリティ ルー

プバックの例を示します。

図 1-28 宛先ノードの OC-N ポートでのファシリティ ループバック パス

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ファシリティ ループバックには、現場要員が必要です。

「宛先ノードの光ポートでのファシリティ ループバックの作成」（p.1-74） の作業を行います。

宛先ノードの光ポートでのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.4.5　中間ノードの光ポートでのターミナル ループバックの実行」（p.1-70） の作業が完了し

たばかりであれば、発信元ノードのポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。
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ステップ 3 CTC を使用して、次のようにテスト ポートにヘアピン回線をセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「OCN1toOCN5」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKFACILITY（OCN）」（p.2-182） が表示さ

れます。ループバックを削除すると、この状態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でファシリティ ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback > Port タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Facility を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「光ファシリティ ループバック回線のテストと解除」（p.1-76） の作業を行います。
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光ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ポートか

らファシリティ ループバックを解除します。

a. Maintenance > Loopback > Port タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ファシリティ ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 5 「光カードのテスト」（p.1-76） の作業を行います。

光カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートでファシリティ ループバックを解除します。

a. Maintenance > Loopback > Port タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。
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c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ファシリティ ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.4.7　宛先ノードの光ポートでのターミナル ループバックの実行」（p.1-77） の作業を行います。

1.4.7　宛先ノードの光ポートでのターミナル ループバックの実行

宛先ノードのポートでのターミナル ループバックは、回線トラブルシューティング プロセスの中

でローカルなハードウェア エラーを除去する 後の手順です。テストが成功すれば、回線が宛先

ポートまで正常であることが分かります。図 1-29 に示した例は、中間ノードの宛先 OC-N ポートで

のターミナル ループバックです。

図 1-29 宛先ノードの OC-N ポートでのターミナル ループバック パス

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ターミナル ループバックには、現場要員が必要です。

「宛先ノードの光ポートでのターミナル ループバックの作成」（p.1-78） の作業を行います。
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宛先ノードの光ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.4.6　宛先ノードの光ポートでのファシリティ ループバックの実行」（p.1-74） の作業が完了

したばかりであれば、発信元ポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、次のようにテスト ポートにターミナル ループバックをセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「OCN1toOCN6」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL（OCN）」（p.2-187） が表示

されます。ループバックを削除すると、この状態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。
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b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback > Port タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「光ターミナル ループバック回線のテストと解除」（p.1-79） の作業を行います。

光ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートからターミ

ナル ループバックを解除します。

a. ターミナル ループバックが設定されている中間ノードのカードをダブルクリックします。

b. Maintenance > Loopback > Port タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

回線パス全体が、一連の総合ループバック テストに合格しました。この回線は、実トラ
フィックの伝送に適しています。

ステップ 5 測定の結果、回線に異常がある場合は、カード不良が問題であると考えられます。

ステップ 6 「光カードのテスト」（p.1-80） の作業を行います。
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光カードのテスト

ステップ 1 問題があると考えられるカードに対して「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートのターミナル ループバックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback > Port タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

回線パス全体が、一連の総合ループバック テストに合格しました。この回線は、実トラフィックの

伝送に適しています。
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1.5　ループバックによるイーサネット回線パスのトラブルシューティ
ング

多くの場合、ファシリティ ループバック、ターミナル ループバック、およびクロスコネクト ルー

プバック回線を使用して、ネットワーク全体の回線パスをテストしたり、障害を論理的に切り分け

たりします。回線パスに沿った各ポイントでループバック テストを実施することにより、考えられ

る障害ポイントを体系的に切り分けます。

これらの手順は、G シリーズ および CE シリーズ イーサネット カードには使用できますが、E シ

リーズまたは ML シリーズ イーサネット カードには使用できません。ここで扱う例では、3 ノード

BLSR 上の G シリーズ カード回線をテストします。例に示しているシナリオでは、ファシリティ

ループバックとターミナル ループバックを組み合わせて、回線パスをトレースし、考えられる障害

箇所を検証して切り分けます。この工程は、6 つのネットワーク試験手順で構成されます。

（注） 回線のテスト手順は、回線の種類とネットワーク トポロジによって異なります。

1. 発信元ノードのイーサネット ポートでのファシリティ ループバック

2. 発信元ノードのイーサネット ポートでのターミナル ループバック

3. 中間ノードのイーサネット ポートでのファシリティ ループバック

4. 中間ノードのイーサネット ポートでのターミナル ループバック

5. 宛先ノードのイーサネット ポートでのファシリティ ループバック

6. 宛先ノードのイーサネット ポートでのターミナル ループバック

（注） ファシリティ、ヘアピン、ターミナル ループバック テストには、現場要員が必要です。

1.5.1　発信元ノードのイーサネット ポートでのファシリティ ループバックの実行

ファシリティ ループバック テストは、ネットワーク回線内のノードの発信元ポートで実行されま

す。次のテスト例では、発信元ノード内の発信元 G シリーズ ポートが対象です。このポートでの

ファシリティ ループバックが正常に完了すれば、G シリーズ ポートが障害ポイントである可能性

が切り分けられます。図 1-21 に、回線の発信元のイーサネット ポートでのファシリティ ループバッ

クの一例を示します。

（注） ファシリティ ループバックは、Release 4.1 以前の G シリーズ カードでは使用できません。

（注） ファシリティ ループバックには、現場要員が必要です。
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図 1-30 回線の発信元イーサネット ポートでのファシリティ ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

「発信元ノードのイーサネット ポートでのファシリティ ループバックの作成」（p.1-82） の作業を行

います。

発信元ノードのイーサネット ポートでのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

適切なケーブルを使用して、光テスト セットの Tx と Rx 端末をテスト対象のポートに接続します。

Tx および Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC ノード ビューで、カードをダブルクリックして、カード ビューを表示します。

ステップ 4 Maintenance > Loopback タブをクリックします。

ステップ 5 テストするポートに対して、Admin State カラムから OOS,MT を選択します。このカードがマルチ

ポート カードの場合、目的のポートに対応する行を選択します。

ステップ 6 テストするポートに対して、Loopback Type カラムから Facility を選択します。このカードがマルチ

ポート カードの場合、目的のポートに対応する行を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

（注） ループバックのセットアップ時には、通常、「LPBKFACILITY（G1000）」（p.2-181） が表示

されます。ループバックを削除すると、この状態はクリアされます。
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ステップ 9 「ファシリティ ループバック回線のテストと解除」（p.1-83） の作業を行います。

ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ファシリ

ティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「イーサネット カードのテスト」（p.1-83） の作業を行います。

イーサネット カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。
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ステップ 6 「1.5.2　発信元ノードのイーサネット ポートでのターミナル ループバックの実行」（p.1-84） の作業

を行います。

1.5.2　発信元ノードのイーサネット ポートでのターミナル ループバックの実行

ターミナル ループバック テストは発信元ノードのイーサネット ポートで実行されます。次のテス

ト例では、発信元ノードの発信元 G シリーズ ポートが対象です。まず、ノードの宛先 G シリーズ

ポートで始まり、ノードの発信元 G シリーズ ポートでループバックする双方向回線を作成します。

次に、ターミナル ループバック テストに進みます。ノードの発信元ポートへのターミナル ループ

バックが正常に完了すれば、回線が発信元ポートまで問題ないことが実証されます。図 1-31 に、G

シリーズポートのターミナル ループバックの一例を示します。

（注） ターミナル ループバックは、Release 4.0 以前の G シリーズ カードでは使用できません。

（注） ターミナル ループバックには、現場要員が必要です。

図 1-31 G シリーズ ポートでのターミナル ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

「発信元ノードのイーサネット ポートでのターミナル ループバックの作成」（p.1-85） の作業を行い

ます。
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発信元ノードのイーサネット ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.5.1　発信元ノードのイーサネット ポートでのファシリティ ループバックの実行」（p.1-81）
の作業が完了したばかりであれば、発信元ノードのイーサネット ポートに光テスト セットを

接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、次のようにテスト ポートにターミナル ループバックをセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「G1K1toG1K2」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL （G1000）」（p.2-186） が表

示されます。ループバックを削除すると、この状態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. ノード ビューで、発信元ノードの G シリーズ カードなど、ループバックが必要なカードをダ

ブルクリックします。
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b. Maintenance > Loopback タブをクリックします。

c. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

d. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「イーサネット ターミナル ループバック回線のテストと解除」（p.1-86） の作業を行います。

イーサネット ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートのターミナ

ル ループバック状態を解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 5 「イーサネット カードのテスト」（p.1-87） の作業を行います。
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イーサネット カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ネットワーク パスの次のセグメントの試験に進む前に、発信元カード ポートのターミナル ループ

バックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ネットワーク回線パスの次のセグメントの試験に進む前に、ターミナル ループバック回線を解除し

ます。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.5.3　中間ノードでのイーサネット ポートのファシリティ ループバックの作成」（p.1-88） の作業

を行います。
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1.5.3　中間ノードでのイーサネット ポートのファシリティ ループバックの作成

中間ポートでファシリティ ループバック試験を実行することにより、そのノードが回線障害の原因

かどうかを切り分けることができます。これを 図 1-32 に示します。

図 1-32 中間ノードのイーサネット ポートでのファシリティ ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ファシリティ ループバックには、現場要員が必要です。

「中間ノードでのイーサネット ポートのファシリティ ループバックの作成」（p.1-88） の作業を行い

ます。

中間ノードでのイーサネット ポートのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.5.2　発信元ノードのイーサネット ポートでのターミナル ループバックの実行」（p.1-84） の
作業が完了したばかりであれば、発信元ノードのポートに光テスト セットを接続したままにし

ます。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。
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ステップ 3 CTC を使用して、次のようにテスト ポートにファシリティ ループバックをセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「G1K1toG1K3」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバック セットアップ時には、通常、「LPBKFACILITY（G1000）」（p.2-181）、または

「LPBKFACILITY（OCN）」（p.2-182） が表示されます。ループバックを削除すると、この状

態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でファシリティ ループバックを作成します。

a. 中間ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要な中間ノードのカードをダブルクリックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Facility を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「イーサネット ファシリティ ループバック回線のテストと解除」（p.1-90） の作業を行います。
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イーサネット ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ポートか

らファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ファシリティ ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 5 「イーサネット カードのテスト」（p.1-90） の作業を行います。

イーサネット カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートからファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。
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c. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ファシリティ ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.5.4　中間ノードのイーサネット ポートでのターミナル ループバックの作成」（p.1-91） の作業を

行います。

1.5.4　中間ノードのイーサネット ポートでのターミナル ループバックの作成

次のトラブルシューティング テストでは、中間ノードのポートに対してターミナル ループバック

を実行することにより、宛先ポートが回線障害の原因となっているかどうかを切り分けます。図

1-33 に示す例の状況では、ターミナル ループバックを、回線内の中間イーサネット ポートに対し

て実行します。まず、発信元ノードのイーサネット ポートで開始し、中間ノードのポートでループ

バックする双方向回線を作成します。次に、ターミナル ループバック テストに進みます。ノード

でのターミナル ループバックが正常に完了すれば、このノードを回線障害の原因から除外します。

図 1-33 中間ノードのイーサネット ポートでのターミナル ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ターミナル ループバックには、現場要員が必要です。

「中間ノードのイーサネット ポートでのターミナル ループバックの作成」（p.1-92） の作業を行いま

す。
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中間ノードのイーサネット ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. イーサネット回線に対して 「1.5.3　中間ノードでのイーサネット ポートのファシリティ ルー

プバックの作成」（p.1-88） の作業が完了したばかりであれば、中間ノードのポートに光テスト

セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、次のようにテスト ポートにターミナル ループバックをセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「G1K1toG1K4」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じノード、カード ス
ロット、ポート、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

ノード、カード スロット、ポート、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 新しく作成した回線が Circuits タブに表示され、Dir カラムで双方向回線として表示されていること

を確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL （G1000）」（p.2-186） が表

示されます。ループバックを削除すると、この状態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 中間ノードのノード ビューに移動します。



第 1 章      一般的なトラブルシューティング

1.5　ループバックによるイーサネット回線パスのトラブルシューティング

1-93
Cisco ONS 15454 トラブルシューティング ガイド

78-17734-01-J

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「イーサネット ターミナル ループバック回線のテストと解除」（p.1-93） の作業を行います。

イーサネット ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートからターミ

ナル ループバックを解除します。

a. カード ビューを表示するために、ターミナル ループバックが設定されている中間ノードのカー

ドをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 5 「イーサネット カードのテスト」（p.1-94） の作業を行います。
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イーサネット カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートのターミナル ループバックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.5.5　宛先ノードのイーサネット ポートでのファシリティ ループバックの実行」（p.1-95） の作業

を行います。
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1.5.5　宛先ノードのイーサネット ポートでのファシリティ ループバックの実行

宛先ポートでファシリティ ループバック試験を実行することにより、ローカル ポートが回線障害

の原因かどうか判別します。図 1-34 に、イーサネット ポートで実行するファシリティ ループバッ

クの例を示します。

図 1-34 宛先ノードの イーサネット ポートでのファシリティ ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ファシリティ ループバックには、現場要員が必要です。

「宛先ノードのイーサネット ポートでのファシリティ ループバックの作成」（p.1-95） の作業を行い

ます。

宛先ノードのイーサネット ポートでのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.5.4　中間ノードのイーサネット ポートでのターミナル ループバックの作成」（p.1-91） の作

業が完了したばかりであれば、発信元ノードのポートに光テスト セットを接続したままにしま

す。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。
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ステップ 3 CTC を使用して、次のようにテスト ポートにヘアピン回線をセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「G1K1toG1K5」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKFACILITY（G1000）」（p.2-181） が表示

されます。ループバックを削除すると、この状態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でファシリティ ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Facility を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「イーサネット ファシリティ ループバック回線のテストと解除」（p.1-97） の作業を行います。
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イーサネット ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ポートか

らファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ファシリティ ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 5 「イーサネット カードのテスト」（p.1-97） の作業を行います。

イーサネット カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートでファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。
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c. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ファシリティ ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

ステップ 7 「1.5.6　宛先ノードのイーサネット ポートでのターミナル ループバックの実行」（p.1-98） の作業を

行います。

1.5.6　宛先ノードのイーサネット ポートでのターミナル ループバックの実行

宛先ノードのポートでのターミナル ループバックは、回線トラブルシューティング プロセスの中

でローカルなハードウェア エラーを除去する 後の手順です。テストが成功すれば、回線が宛先

ポートまで正常であることが分かります。図 1-29 に、中間ノードの宛先イーサネット ポートでの

ターミナル ループバックの例を示します。

図 1-35 宛先ノードの イーサネット ポートでのターミナル ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ターミナル ループバックには、現場要員が必要です。

「宛先ノードのイーサネット ポートでのターミナル ループバックの作成」（p.1-99） の作業を行いま

す。
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宛先ノードのイーサネット ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.5.5　宛先ノードのイーサネット ポートでのファシリティ ループバックの実行」（p.1-95） の
作業が完了したばかりであれば、発信元ポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC を使用して、次のようにテスト ポートにターミナル ループバックをセットアップします。

a. ノード ビューで、Circuits タブをクリックし、Create をクリックします。

b. Circuit Creation ダイアログボックスで、タイプ（STS など）と番号（1 など）を選択します。

c. Next をクリックします。

d. 次の Circuit Creation ダイアログボックスで、回線に「G1K1toG1K6」のような分かりやすい名

前を指定します。

e. Bidirectional  チェックボックスは、オンの状態のままにします。

f. Next をクリックします。

g. Circuit Creation 発信元ダイアログボックスで、テスト セットの接続先と同じ Node、カード Slot、
Port、および STS（または VT）を選択します。

h. Next をクリックします。

i. Circuit Creation 宛先ダイアログボックスで、発信元ダイアログボックスで選択したのと同じ

Node、カード Slot、Port、および STS（または VT）を選択します。

j. Next をクリックします。

k. Circuit Creation Circuit Routing Preferences ダイアログボックスでは、すべてデフォルト値のまま

にします。Finish をクリックします。

ステップ 4 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL （G1000）」（p.2-186） が表

示されます。ループバックを削除すると、この状態はクリアされます。

ステップ 5 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。
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b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「イーサネット ターミナル ループバック回線のテストと解除」（p.1-100） の作業を行います。

イーサネット ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートからターミ

ナル ループバックを解除します。

a. ターミナル ループバックが設定されている中間ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

回線パス全体が、一連の総合ループバック テストに合格しました。この回線は、実トラフィックの

伝送に適しています。

ステップ 5 測定の結果、回線に異常がある場合は、カード不良が問題であると考えられます。

ステップ 6 「イーサネット カードのテスト」（p.1-101） の作業を行います。
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イーサネット カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートのターミナル ループバックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT）を選

択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 ターミナル ループバック回線を解除します。

a. Circuits タブをクリックします。

b. テスト対象のループバック回線を選択します。

c. Delete をクリックします。

d. Delete Circuits ダイアログボックスで Yes をクリックします。他のチェックボックスはチェック

しないでください。

回線パス全体が、一連の総合ループバック テストに合格しました。この回線は、実トラフィックの

伝送に適しています。
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1.6　ループバックによる FC_MR 回線パスのトラブルシューティング
多くの場合、ファシリティ ループバック、ターミナル ループバック、およびクロスコネクト ルー

プバック回線を使用して、ネットワーク全体の回線パスをテストしたり、障害を論理的に切り分け

たりします。回線パスに沿った各ポイントでループバック テストを実施することにより、考えられ

る障害ポイントを体系的に切り分けます。FC_MR ループバック テストは、ループバック テストが

回線の作成を必要としないので、電気、光、およびイーサネットのテストとは異なります。FC_MR

クライアント ポートは、固定的にトランク ポートにマッピングされ、ループバックをテストする

ためにクロスコネクト カード（回線内で）を信号が経由する必要はありません。

この手順を、ファイバ チャネル データ ストレージ（FC_MR）カードで実行できます。ここで扱う

例では、3 ノード BLSR 上で FC_MR 回線をテストします。例に示しているシナリオでは、ファシ

リティ ループバックとターミナル ループバックを組み合わせて、回線パスをトレースし、考えら

れる障害箇所を検証して切り分けます。この工程は、7 つのネットワーク試験手順で構成されます。

（注） FC_MR カードのクライアント ポートは、プロビジョニングされていなければ、Maintenance >
Loopback タブには表示されません。カード ビューの Provisioning > Pluggable Port Modules タブで、

ポートをプロビジョニングします。クライアント ポートのプロビジョニングについては、

『Cisco ONS 15454 Procedure Guide』を参照してください。

（注） 回線のテスト手順は、回線の種類とネットワーク トポロジによって異なります。

1. 発信元ノードの FC_MR ポートでのファシリティ ループバック

2. 発信元ノードの FC_MR ポートでのターミナル ループバック

3. 宛先ノードの FC_MR ポートでのファシリティ ループバック

4. 宛先ノードの FC_MR ポートでのターミナル ループバック

（注） ファシリティ、ヘアピン、ターミナル ループバック テストには、現場要員が必要です。

1.6.1　発信元ノードの FC_MR ポートでのファシリティ ループバックの実行

ファシリティ ループバック テストは、ネットワーク回線内のノードの発信元ポートで実行されま

す。この例のテスト状況では、発信元ノード内の発信元マックスポンダまたはトランスポンダ ポー

トが対象です。このポートでのファシリティ ループバックが正常に完了すれば、FC_MR ポートが

障害ポイントである可能性が切り分けられます。図 1-36 に、回線の発信元の FC_MR ポートでの

ファシリティ ループバックの一例を示します。
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図 1-36 回線の発信元 FC_MR ポートでのファシリティ ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ファシリティ ループバックには、現場要員が必要です。

「発信元ノードの FC_MR ポートでのファシリティ ループバックの作成」（p.1-103） の作業を行いま

す。

発信元ノードの FC_MR ポートでのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

適切なケーブルを使用して、光テスト セットの Tx と Rx 端末をテスト対象のポートに接続します。

Tx および Rx 端末は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 CTC ノード ビューで、カードをダブルクリックして、カード ビューを表示します。

ステップ 4 Maintenance > Loopback タブをクリックします。

ステップ 5 テストするポートに対して、Admin State カラムから OOS,MT を選択します。このカードがマルチ

ポート カードの場合、目的のポートに対応する行を選択します。

ステップ 6 テストするポートに対して、Loopback Type カラムから Facility を選択します。このカードがマルチ

ポート カードの場合、目的のポートに対応する行を選択します。

ステップ 7 Apply をクリックします。
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ステップ 8 確認用ダイアログボックスで Yes をクリックします。

（注） ループバック セットアップ時には、通常、「LPBKFACILITY（OCN）」（p.2-182） または

「LPBKFACILITY（G1000）」（p.2-181） が表示されます。ループバックを削除すると、この

状態はクリアされます。

ステップ 9 「FC_MR ファシリティ ループバック回線のテストと解除」（p.1-104） の作業を行います。

FC_MR ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ファシリ

ティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「FC_MR カードのテスト」（p.1-104） の作業を行います。

FC_MR カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。
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ステップ 5 ファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「1.6.2　発信元ノードの FC_MR ポートでのターミナル ループバックの実行」（p.1-105） の作業を行

います。

1.6.2　発信元ノードの FC_MR ポートでのターミナル ループバックの実行

ターミナル ループバック テストは発信元ノードの FC_MR マックスポンドダまたはトランスポン

ダ ポートで実行されます。次のテスト例では、発信元ノードの発信元 FC_MR ポートが対象です。

ノードの発信元ポートへのターミナル ループバックが正常に完了すれば、回線が発信元ポートまで

問題ないことが実証されます。図 1-37 に、発信元 FC_MR ポートでのターミナル ループバックの一

例を示します。

図 1-37 発信元ノードの FC_MR ポートでのターミナル ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ターミナル ループバックには、現場要員が必要です。

「発信元ノードの FC_MR ポートでのターミナル ループバックの作成」（p.1-106） の作業を行います。
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発信元ノードの FC_MR ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.6.1　発信元ノードの FC_MR ポートでのファシリティ ループバックの実行」（p.1-102） の作

業が完了したばかりであれば、発信元ノードの FC_MR ポートに光テスト セットを接続したま

まにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 ノード ビューで、発信元ノードの宛先 OC-N カードなど、ループバックが必要なカードをダブルク

リックします。

ステップ 4 Maintenance > Loopback タブをクリックします。

ステップ 5 Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目的の

ポートに対応する行を選択します。

ステップ 6 Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 「FC_MR ポートのターミナル ループバック回線のテストと解除」（p.1-106） の作業を行います。

FC_MR ポートのターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。
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ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートのターミナ

ル ループバック状態を解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「FC_MR カードのテスト」（p.1-107） の作業を行います。

FC_MR カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ネットワーク パスの次のセグメントの試験に進む前に、発信元カード ポートのターミナル ループ

バックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「1.6.3　中間ノードでの FC_MR ポートのファシリティ ループバックの作成」（p.1-108） の作業を行

います。
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1.6.3　中間ノードでの FC_MR ポートのファシリティ ループバックの作成

中間ポートでファシリティ ループバック試験を実行することにより、そのノードが回線障害の原因

かどうかを判断できます。図 1-38 に、中間 FC_MR ポートで実行するテストの例を示します。

図 1-38 中間ノードの FC_MR ポートでのファシリティ ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ファシリティ ループバックには、現場要員が必要です。

「中間ノードでの FC_MR ポートのファシリティ ループバックの作成」（p.1-108） の作業を行います。

中間ノードでの FC_MR ポートのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.6.2　発信元ノードの FC_MR ポートでのターミナル ループバックの実行」（p.1-105） の作業

が完了したばかりであれば、発信元ノードのポートに光テスト セットを接続したままにしま

す。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 ノード ビューで、ループバックが必要な中間ノードのカードをダブルクリックします。

ステップ 4 Maintenance > Loopback タブをクリックします。
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ステップ 5 Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目的の

ポートに対応する行を選択します。

ステップ 6 Loopback Type カラムから、Facility を選択します。このカードがマルチポート カードの場合、目的

のポートに対応する行を選択します。

ステップ 7 Apply をクリックします。

ステップ 8 確認用ダイアログボックスで Yes をクリックします。

ステップ 9 「FC_MR ポートのファシリティ ループバック回線のテストと解除」（p.1-109） の作業を行います。

FC_MR ポートのファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ポートか

らファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「FC_MR カードのテスト」（p.1-109） の作業を行います。

FC_MR カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。
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ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートからファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「1.6.4　中間ノードの FC_MR ポートでのターミナル ループバックの作成」（p.1-110） の作業を行い

ます。

1.6.4　中間ノードの FC_MR ポートでのターミナル ループバックの作成

次のトラブルシューティング テストでは、中間ノードのポートに対してターミナル ループバック

を実行することにより、宛先ポートが回線障害の原因となっているかどうかを切り分けます。図

1-39 に示す例の状況では、ターミナル ループバックを、回線内の中間 FC_MR ポートに対して実行

します。ノードでのターミナル ループバックが正常に完了すれば、このノードを回線障害の原因か

ら除外します。

図 1-39 中間ノードの FC_MR ポートでのターミナル ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ターミナル ループバックには、現場要員が必要です。

「中間ノードの FC_MR ポートでのターミナル ループバックの作成」（p.1-111） の作業を行います。
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中間ノードの FC_MR ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.6.3　中間ノードでの FC_MR ポートのファシリティ ループバックの作成」（p.1-108） の作業

が完了したばかりであれば、発信元ノードのポートに光テスト セットを接続したままにしま

す。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 中間ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「FC_MR ターミナル ループバック回線のテストと解除」（p.1-111） の作業を行います。

FC_MR ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。
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ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートからターミ

ナル ループバックを解除します。

a. カード ビューを表示するために、ターミナル ループバックが設定されている中間ノードのカー

ドをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「FC_MR カードのテスト」（p.1-112） の作業を行います。

FC_MR カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートのターミナル ループバックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「1.6.5　宛先ノードの FC_MR ポートでのファシリティ ループバックの実行」（p.1-113） の作業を行

います。
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1.6.5　宛先ノードの FC_MR ポートでのファシリティ ループバックの実行

宛先ポートでファシリティ ループバック試験を実行することにより、ローカル ポートが回線障害

の原因かどうか判別します。図 1-40 に、FC_MR  ポートで実行するファシリティ ループバックの例

を示します。

図 1-40 宛先ノードの FC_MR ポートでのファシリティ ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。

（注） ファシリティ ループバックには、現場要員が必要です。

「宛先ノードの FC_MR ポートでのファシリティ ループバックの作成」（p.1-113） の作業を行います。

宛先ノードの FC_MR ポートでのファシリティ ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.6.4　中間ノードの FC_MR ポートでのターミナル ループバックの作成」（p.1-110） の作業が

完了したばかりであれば、発信元ノードのポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。
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ステップ 3 テスト対象の宛先ポート上でファシリティ ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Facility を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「FC_MR ファシリティ ループバック回線のテストと解除」（p.1-114） の作業を行います。

FC_MR ファシリティ ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したトラフィックを調べます。テスト セットで検出されたエラーまたは他の

信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ファシリティ ループバックでのテストは終了です。ポートか

らファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 「FC_MR カードのテスト」（p.1-115） の作業を行います。
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FC_MR カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートでファシリティ ループバックを解除します。

a. Maintenance > Loopback タブをクリックします。

b. テストするポートに対して、Loopback Type カラムから None を選択します。

c. テストするポートに対して、Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、
IS,AINS）を選択します。

d. Apply をクリックします。

e. 確認用ダイアログボックスで Yes をクリックします。

ステップ 6 「1.6.6　宛先ノードの FC_MR ポートでのターミナル ループバックの実行」（p.1-115） の作業を行い

ます。

1.6.6　宛先ノードの FC_MR ポートでのターミナル ループバックの実行

宛先ノードのポートでのターミナル ループバックは、回線トラブルシューティング プロセスの中

でローカルなハードウェア エラーを除去する 後の手順です。テストが成功すれば、回線が宛先

ポートまで正常であることが分かります。図 1-41 に、中間ノードの宛先 FC_MR ポートでのターミ

ナル ループバックの例を示します。

図 1-41 宛先ノードの FC_MR ポートでのターミナル ループバック

注意 イン サービスの回線でループバックを実行すると、サービスに影響を及ぼします。
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（注） ターミナル ループバックには、現場要員が必要です。

「宛先ノードの FC_MR ポートでのターミナル ループバックの作成」（p.1-116） の作業を行います。

宛先ノードの FC_MR ポートでのターミナル ループバックの作成

ステップ 1 テストするポートに光テスト セットを接続します。

（注） テスト セット装置の接続、セットアップ、および使用方法については、製造元に確認して

ください。

a. 「1.6.5　宛先ノードの FC_MR ポートでのファシリティ ループバックの実行」（p.1-113） の作業

が完了したばかりであれば、発信元ポートに光テスト セットを接続したままにします。

b. 現在の手順を開始するときに、光テスト セットが送信ポートに接続されていない場合は、適切

なケーブル接続で、光テスト セットの Tx と Rx 端末をテストするポートに接続します。Tx と
Rx は、同じポートに接続します。

ステップ 2 必要に応じてテスト セットを調節します（テスト セットの使用については、製造元の説明を参照

してください）。

ステップ 3 Circuits タブに、新しく作成した回線が双方向回線として表示されていることを確認します。

（注） ループバックのセットアップ時には、通常、「LPBKTERMINAL（OCN）」（p.2-187） が表示

されます。ループバックを削除すると、この状態はクリアされます。

ステップ 4 テスト対象の宛先ポート上でターミナル ループバックを作成します。

a. 宛先ノードのノード ビューに移動します。

• メニュー バーから View > Go To Other Node を選択します。

• Select Node ダイアログボックスのドロップダウン リストからノードを選択し、OK をク

リックします。

b. ノード ビューで、ループバックが必要なカードをダブルクリックします。

c. Maintenance > Loopback タブをクリックします。

d. Admin State カラムから OOS,MT を選択します。このカードがマルチポート カードの場合、目

的のポートに対応する行を選択します。

e. Loopback Type カラムから、Terminal を選択します。このカードがマルチポート カードの場合、

目的のポートに対応する行を選択します。

f. Apply をクリックします。

g. 確認用ダイアログボックスで Yes をクリックします。

ステップ 5 「FC_MR ターミナル ループバック回線のテストと解除」（p.1-117） の作業を行います。
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FC_MR ターミナル ループバック回線のテストと解除

ステップ 1 テスト セットからトラフィックをまだ送信していない場合は、ループバック回線にテスト用トラ

フィックを送信します。

ステップ 2 テスト セットで受信したテスト用トラフィックを調べます。テスト セットで検出されたエラーま

たは他の信号情報を調べます。

ステップ 3 測定の結果、回線に異常がなければ、ループバック回線でのテストは終了です。ポートからターミ

ナル ループバックを解除します。

a. ターミナル ループバックが設定されている中間ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。

ステップ 4 測定の結果、回線に異常がある場合は、カード不良が問題であると考えられます。

ステップ 5 「FC_MR カードのテスト」（p.1-117） の作業を行います。

FC_MR カードのテスト

ステップ 1 問題があると考えられるカードに対して 「トラフィック カードの物理的な交換」（p.2-293） の作業

を行い、良好なカードと交換します。

ステップ 2 良好なカードを取り付けて、ループバック回線にテスト用トラフィックを再送信します。

ステップ 3 測定の結果、回線に異常がない場合は、カードの欠陥が問題であったと考えられます。RMA プロ

セスを通じて、不良カードをシスコに返送してください。詳しくは、弊社テクニカル サポートにお

問い合わせください。

ステップ 4 不良カードに対して、「トラフィック カードの物理的な交換」（p.2-293） の作業を行います。

ステップ 5 ポートのターミナル ループバックを解除します。

a. ターミナル ループバックが設定されている発信元ノードのカードをダブルクリックします。

b. Maintenance > Loopback タブをクリックします。

c. テストするポートに対して、Loopback Type カラムから None を選択します。

d. テストするポートの Admin State カラムから、適切な状態（IS、OOS,DSBLD、OOS,MT、IS,AINS）
を選択します。

e. Apply をクリックします。

f. 確認用ダイアログボックスで Yes をクリックします。
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回線パス全体が、一連の総合ループバック テストに合格しました。この回線は、実トラフィックの

伝送に適しています。

1.7　CTC 診断の使用
CTC では、次のような診断機能を使用できます。

• 適切なカード ASICS 機能の確認

• スタンバイ カードの動作確認

• 適切なカード LED 動作の確認

• 診断回線の作成

• アラームで検出した問題のお客様への通知

• ダウンロード可能な機械語の診断情報ファイルのプロビジョニング（弊社サポート担当が使

用）

ASIC の検証やスタンバイ カード動作などの機能が、バックグラウンドで監視されています。Alarms

and Conditions ウィンドウに、システムの変化や問題の通知が表示されます。カード LED 機能の確

認、双方向診断回線の作成、シスコの技術サポート担当者が使用する診断ファイルのダウンロード

など、その他の診断機能は、ノード ビューの Maintenance > Diagnostic タブから使用できます。ユー

ザが操作できる診断機能を、次の項に示します。

1.7.1　カード LED 点灯テスト

LED 点灯テストでは、カードレベルの LED が動作可能かを調べます。この診断テストは、ONS 15454

の初期ターンアップまたは定期メンテナンス作業の一環として実施するか、あるいは LED の動作

に疑いがあるときに随時実施します。メンテナンス ユーザ、またはより高い権限を持つユーザは、

LED 動作を確認するために、次のような作業を行うことができます。

一般的なカード LED の動作確認

ステップ 1 ノード ビューで、 Maintenance > Diagnostic  タブをクリックします（図 1-42 を参照）。
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図 1-42 CTC ノード ビューの診断ウィンドウ

ステップ 2 Lamp Test をクリックします。

ステップ 3 すべてのポート LED が同時に数秒間点灯することを確認します。

• 3 色 LED：5 秒間ずつ 3 回

• 2 色 LED：5 秒間 1 回と 10 秒間 1 回

• AIC または AIC-I：15 秒間 1 回

ステップ 4 Lamp Test Run ダイアログボックスで OK をクリックします。

前述の例外を除き、OC-N または DS-N の LED が点灯しない場合、LED に障害があります。RMA

プロセスを通じて、不良カードをシスコに返送してください。弊社の TAC にお問い合わせくださ

い。

G シリーズ イーサネット カードまたは FC_MR カードのポート レベル LED の動作確認

（注） G シリーズ カードおよび FC_MR カードの場合、点灯テスト時にカードレベルの LED は点灯しま

すが、ポートレベルの LED は点灯しません。

ステップ 1 「一般的なカード LED の動作確認」（p.1-118） の作業を行い、カードレベルの LED が動作すること

を確認します。
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ステップ 2 次のガイドラインを参照し、G シリーズ イーサネット ポートの LED が正しく動作しているかどう

かを物理的にテストします。ポートが記載の状態のときに LED が記載の点灯状態であれば、LED

は正しく機能しているとみなすことができます。

• 透明なポート LED：受信リンクの損失（リンクの切断や GBIC［ギガビット インターフェイス

コンバータ］が外れている場合など）が発生した場合にのみ点灯します。ポートには LOS ア
ラームが発生している可能性があります。

• オレンジのポート LED：ポートは無効であるがリンクが接続状態の場合、またはポートは有効

でリンクは接続状態である転送障害がある場合にのみ点灯します。ポートには TPTFAIL アラー

ムが発生している可能性があります。

• グリーンのポート LED：ポートが有効で、かつポートにエラーがないか、ポートにトラフィッ

クが流れている場合に点灯します。ポートが有効でエラーがなく、点滅速度に応じたトラ

フィックが流れている場合にも点灯します。トラフィックに影響のあるポート アラームは発生

していません。

ステップ 3 ポートの状態を判断できない場合は、弊社のサポート担当者に問い合わせてください。

E シリーズと ML シリーズ イーサネット カードのポート レベル LED の動作確認

（注） E シリーズおよび ML シリーズ カードでは、点灯テスト時にカードレベルの LED は点灯しますが、

ポートレベルの LED は点灯しません。

（注） ML シリーズのカードの詳細については、『Ethernet Card Software Feature and Configuration Guide for
the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327』を参照してください。

ステップ 1 「一般的なカード LED の動作確認」（p.1-118） の作業を行い、カードレベルの LED が動作すること

を確認します。

ステップ 2 次のガイドラインを参照し、E シリーズまたは ML シリーズ イーサネット カードの各ポートの LED

が正しく動作しているかどうかを物理的にテストします。ポートが記載の状態のときに LED が記

載の点灯状態であれば、LED は正しく機能しているとみなすことができます。

• 透明なポート LED：受信リンクの損失（リンクの切断や GBIC が外れている場合など）が発生

した場合、またはトラフィックが一方の方向（送信方向または受信方向）に流れている場合に

のみ点灯します。ポートには CARLOSS アラームが発生している可能性があります。

• オレンジのポート LED：リンクが接続されていて、送受信トラフィックが物理ポートを流れて

いる場合に限り点灯します。

• グリーンのポート LED：リンクが動作中で、かつポートをトラフィックが流れていない場合に

点灯します。

ステップ 3 ポートの状態を判断できない場合は、弊社のテクニカル サポート担当者に問い合わせてください。
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1.7.2　Retrieve Diagnostics File ボタン

Maintenance ウィンドウで Retrieve Diagnostics File ボタンをクリックすると、CTC にシステム デー

タを取り込むことができます。メンテナンス担当のユーザ、またはより高い権限を持つユーザは、

そのシステム データをローカルのディレクトリに保存して負荷分散できます。また、それを弊社サ

ポート担当に送ることができます。診断ファイルは機械語レベルで、容易に読むことは出来ません

が、弊社テクニカル サポート担当者が問題解析に利用できます。診断ファイルをオフロードするた

めに、次の作業を行います。

（注） 機械語レベルの診断ファイルに加えて、ONS 15454 は、ユーザ ログイン、リモートのログイン、シ

ステムの設定や変更などのすべてのシステム イベントの監査証跡を保存します。この監査証跡は、

トラブルシューティング機能というよりも、記録機能と考えられます。機能についての詳細は、

『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の章を参照してください。

診断ファイルのオフロード

ステップ 1 ノード ビューで、 Maintenance > Diagnostic  タブをクリックします（図 1-42 参照）。

ステップ 2 Retrieve Tech Support Log をクリックします。

ステップ 3 Saving Diagnostic File ダイアログボックスで、ファイルを保存したいディレクトリ（ローカルまた

はネットワーク）に移動します。

ステップ 4 File Name フィールドに名前を入力します。

アーカイブ ファイルには特定の拡張子を付ける必要がありません。弊社テクニカル サポート担当

者が解凍して読むことができる圧縮ファイル（gzip）です。

ステップ 5 Save をクリックします。

Get Diagnostics status ウィンドウは、ファイルの格納の進行状況を進行バーで表示し、完了すると

「Get Diagnostics Complete」が表示されます。

ステップ 6 OK をクリックします。

1.7.3　双方向診断回線

CTC には、Pseudo-Random Bit Sequence（PRBS; 擬似ランダム ビット シーケンス）エラー検出を使

用して、スタンバイ UPSR、BLSR、1+1、または非保護回線パスの状態を監視する診断用の双方向

ループバック回線機能があります。

診断回線は双方向であり、STS で単一の VT 1.5 を使用します。回線は複数のノードに渡ることがで

きますが、パス全体を同じ STS で伝送されなければなりません。回線は同じノードから出て、同じ

ノードに帰ってきますが、他のノードを経由してループさせることもできます（ヘアピン回線に

よって）。回線が発信元ノードに戻ったあと、PRBS によって信号結果が検出されて、エラー分析さ

れます。
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このタイプの回線は、通常のスタンバイ保護チャネル アクセス（PCA）回線とほぼ同様に作成され

ますが、回線作成時に Diagnostic チェックボックスをチェックすることによって指定されます。通

常の回線は回線カードをエンドポイントとして使用しますが、回線が診断用として設定された場

合、エンドポイントはクロスコネクト カードになります。

カードのタイプによって、診断機能の利用方法が異なります。スタンバイ電気回路カードは、PRBS

テストを実行することによって、信号パスの整合性を確認します。光カードは PRBS テストを実行

せず、代わりに ASIC テストを実行して、カードの動作をテストします。クロスコネクト カードは、

スタンバイ パスを確認します。

診断回線は、エンド ツー エンドまたは複数ノード パス レイアウトで設定でき、送信および受信ス

タンバイ パスを経由します図 1-43 を参照）。

図 1-43 CTC ノード ビューの診断ウィンドウ

診断回線の 大サイズは VT1.5 であり、使用可能な診断回線の 大数は、1 ノードにつき 1 つです

（言い換えると、STS 内に診断 VT を作成した場合、残りの 27 の VT をプロビジョニングでき、他

のノードを発信元とする診断回線を含めることもできます）。

他の双方向回線と同じように、診断回線は、回線が経由する各スパンで同じ STS が使用可能な場合

だけ作成できます。1 つまたは複数の中間ノードを経由する双方向診断を使用するときには、各中

間ノードに双方向回線を作成するか、各中間ノードの既存の双方向回線を利用してください。終端

ノードでは、信号を返すために、PRBS 発信元スパンの 後にヘアピン ループバックを作成する必

要があります。

（注） 診断 VT 回線は、AIS-P または UNEQ-P が PRBS 検出器に返された場合も障害アラームを生成しま

せん。障害のある診断回線を示すアラームを表示するには、回線が生成元とは別のペイロードを

伴って、かつ AIS-P または UNEQ-P 状態を伴わずに、PRBS 検出器に戻されなければなりません。
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双方向診断回線の作成

ステップ 1 診断回線を作成するノードにログインします。ログインの手順については、『Cisco ONS 15454

Procedure Guide』の「Connect the PC and Log into the GUI」の章を参照してください。

ステップ 2 回線を作成する前に、回線の発信元ポートと宛先ポートに名前を付けたい場合は、『Cisco ONS 15454

Procedure Guide』の「Create Circuits and VT Tunnels」の章にある、ポートへの名前の割り当てタス

クを参照してください。そうでない場合は、ステップ 3 の作業を実行してください。

ステップ 3 View メニューから Go to Network View を選択します。

ステップ 4 Circuits タブをクリックして、Create をクリックします。

ステップ 5 Circuit Creation ダイアログボックスで、以下のフィールドに入力します。

• Circuit Type — VT を選択します。

• Number of Circuits — 1 を入力します（STS につき使用可能な診断回線の 大数）。

• Auto-ranged — ボックスのチェックを外します（このオプションは、診断回線には適用できま

せん。）

ステップ 6 Next をクリックします。

ステップ 7 Circuit Creation ダイアログボックス（図 1-44）で以下のパラメータを使用して、回線の属性を定義

します。

図 1-44 ネットワーク ビューの Circuit Creation ダイアログボックス

• Name — 回線に名前を付けます。名前には 48 文字までの英数字（スペースを含めて）を使用で

きます。モニタ回線を作成したい場合は、44 文字以下の回線名にしてください。このフィール

ドを空白のままにした場合は、CTC がデフォルトの名前を回線に割り当てます。

• Size — デフォルトは VT1.5 です。これを変更することはできません。

• Bidirectional — これはデフォルト値です。この回線については、チェックしたままにしておき

ます。
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• State — Diagnostic オプションをチェックした場合、このオプションは使用できません。

• Diagnostic — 診断回線を作成するには、このボックスをチェックします。

• Apply to drop ports — このボックスは、チェックを付けないままにしておきます。

• Create cross-connects only (TL1-like) — 診断回線では使用できません。

• Inter-domain (UCP) SLA — 診断回線では使用できません。

• Protected Drops — 診断回線では使用できません。

ステップ 8 Next をクリックします。

ステップ 9 Circuit Creation ペインの Source エリアで、以下の操作を行います。

a. Node ドロップダウン リストから、ノードを選択します。

b. Slot ドロップダウン リストから、PRBS Generator を選択します。

c. Next をクリックします。

ステップ 10 Circuit Creation ペインの Destination エリアで、以下の操作を行います。

a. Node ドロップダウン リストから、ノードを選択します。このリストで選択できるのは、発信

元ノードとして選択したノードだけです。

b. Slot ドロップダウン リストから、スパンの発信元スロットを選択します。

c. STS ドロップダウン リストから、STS を選択します。

d. VT ドロップダウン リストから、VT を選択します。

e. Next をクリックします。

ステップ 11 Finish をクリックします。

ステップ 12 Circuits ウィンドウで、回線リストに新しい回線が表示されていることを確認します。
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1.7.4　データ通信ネットワーク ツール

CTC には、Data Communications Network（DCN; データ通信ネットワーク）ツールがあり、Open

Shortest Path First（OSPF）ネットワークのネットワーク トラブルシューティングを支援します。こ

のツールはネットワーク ビューに表示されています（図 1-45 を参照）。このツールは internal dump

コマンドを実行して、エントリ ポイントからアクセス可能なノードすべてに関する情報を取得しま

す。

図 1-45 DCN ツールの OSPF ダンプ

ダンプは、特別なネットワーキング コマンドによって実行されたダンプと同じ情報が得られます。

Maintenance > Diagnostic タブのネットワーク ビューで使用できます。Select Node ドロップダウン

リストからアクセス ポイント ノードを選択します。ダンプを作成するには、Retrieve をクリックし

ます（ダンプをクリアするには、Clear をクリックします）。

ダンプ ファイルの内容は、保存または印刷され、シスコ テクニカル サポート担当者が OSPF ネッ

トワーク サポートで使用するために提供されます。
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1.8　データベースとデフォルト設定の復元
ここでは、ソフトウェア データまたはデフォルトのノード設定の復元を必要とするノードの動作エ

ラーに関するトラブルシューティングについて説明します。

1.8.1　ノード データベースの復元

現象   1 つ以上のノードが正しく機能していない、またはそのデータが不正です。

考えられる原因   ノード データベースが不正または破壊されている。

推奨処置   手順については、『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の章を

参照してください。

1.9　PC 接続のトラブルシューティング
ここでは、 小システム要件、サポートされるプラットフォーム、ブラウザ、および JRE について

説明します。また、ONS 15454 への PC とネットワーク接続に関するトラブルシューティングの手

順についても説明します。

1.9.1　PC システムの 小要件

Windows プラットフォームで CTC ソフトウェア リリース 7.2 を運用するワークステーションの

小要件は次のとおりです。

• Pentium III 以上のプロセッサ

• プロセッサ速度 700 MHz 以上

• 256 MB 以上の RAM

• 50 MB 以上のハードディスクの空きスペース

• 20 GB 以上のハードドライブ容量

1.9.2　Sun システムの 小要件

Sun ワークステーションでソフトウェア 7.2 を運用するワークステーションの 小要件は次のとお

りです。

• UltraSPARC 以上のプロセッサ

• 256 MB 以上の RAM

• 50 MB 以上のハードディスクの空きスペース

1.9.3　サポートされるプラットフォーム、ブラウザ、および JRE

ソフトウェア R7.2 は次のプラットフォームをサポートします。

• Windows NT

• Windows 98

• Windows XP

• Windows 2000
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• Solaris 8

• Solaris 9

ソフトウェア R7.2 は次のブラウザと JRE をサポートします。

• Netscape 7 ブラウザ（PC または Solaris 8 または 9、Java Plug-in 1.4.2 または 5.0 使用）

• Java Plug-in 1.4.2 または 5.0 の PC プラットフォーム

• Internet Explorer 6.0（Java Plug-in 1.4.2 または 5.0 使用の PC プラットフォーム）

• Mozilla 1.7（Solaris のみ）

（注） ブラウザは次の URL から入手できます。
Netscape:http://channels.netscape.com/ns/browsers/default.jsp
Internet Explorer:http://www.microsoft.com
Mozilla:http://mozilla.org

（注） JRE 1.4.2 または JRE 5.0 は、ソフトウェア R7.2 を実行するのに必要です。JRE 1.4.2 はソフトウェ

ア CD で提供されています。

1.9.4　サポートされていないプラットフォームとブラウザ

次のプラットフォームは、ソフトウェア R7.2 ではサポートされません。

• Windows 95

• Solaris 2.5

• Solaris 2.6

次のブラウザと JRE は、ソフトウェア R7.2 ではサポートされません。

• Netscape 4.73（Windows 版）

• Solaris 上の Netscape 4.76 はサポートされていません。

• Solaris 8 または 9 上の Netscape 7 は、JRE 1.4.2 以上と併用する場合のみサポートされます。

1.9.5　使用 PC の IP 設定を確認できない

現象   PC を ONS 15454 に接続するときに、IP 設定を確認するために PC の IP アドレスで発行した

ping コマンドが正常に実行されない。

考えられる原因   IP アドレスおよびサブネット マスクの入力が正しくありません。

推奨処置   PC の ping コマンドに指定した IP アドレスが、システムから取り込んだ Windows の

IP 設定情報に示された IP アドレスと一致するか確認します。「使用 PC の IP 設定の確認」

（p.1-128） を参照してください。

考えられる原因   PC の IP 設定が正しくありません。

推奨処置   PC の IP 設定を確認します。「使用 PC の IP 設定の確認」（p.1-128） の作業を行いま

す。この手順で解決しない場合には、ネットワーク管理者に PC の IP 設定を訂正する方法を尋

ねてください。

http://channels.netscape.com/ns/browsers/default.jsp
http://www.microsoft.com
http://www.microsoft.com
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使用 PC の IP 設定の確認

ステップ 1 Start メニューで、Start > Run を選択して、DOS コマンド ウィンドウを開きます。

ステップ 2 Open フィールドに、command と入力し、OK をクリックします。DOS コマンド ウィンドウが表示

されます。

ステップ 3 DOS ウィンドウのプロンプトに、次のコマンドの中で該当するものを入力します。

• Windows 98、NT、2000、および XP では、ipconfig と入力し、Enter キーを押します。

IP アドレス、サブネット マスク、デフォルト ゲートウェイなど Windows の IP 設定情報が表示され

ます。

（注） 現在ネットワークに接続されていなければ、winipcfg コマンドは情報を返しません。

ステップ 4 DOS ウィンドウのプロンプトに、ping に続けて、以前に表示された Windows IP 設定情報に示され

ていた IP アドレスを入力します。

ステップ 5 Enter キーを押すことにより、コマンドを実行します。

DOS ウィンドウに複数（通常は 4 つ）の応答が戻った場合は、IP 設定は正常に機能しています。

応答が戻らなかった場合は、IP 設定が正しくない可能性があります。この場合は、ネットワーク管

理者に PC の IP 設定を訂正する方法を尋ねてください。

1.9.6　ブラウザにログインしても Java が起動しない

現象   「Loading Java Applet を読み込み中」のメッセージの表示がなく、初期ログイン時に JRE が

起動しません。

考えられる原因   PC のオペレーティングシステムとブラウザが正しく設定されていません。

推奨処置   PC オペレーティングシステムの Java Plug-in コントロール パネル設定とブラウザ設

定をやり直します。「PC オペレーティングシステムの Java Plug-in コントロール パネルの再設

定」（p.1-128） および 「ブラウザの再設定」（p.1-129） の作業を行います。

PC オペレーティングシステムの Java Plug-in コントロール パネルの再設定

ステップ 1 Windows Start メニューで、Setting > Control Panal をクリックします。

ステップ 2 Java Plug-in が表示されない場合は、JRE が PC にインストールされていない可能性があります。

a. Cisco ONS 15454 ソフトウェア CD を実行します。

b. CD ドライブ :\Windows\JRE フォルダを開きます。
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c. j2re-1_4_2-win アイコンをダブルクリックすることにより、JRE インストール ウィザードを起

動します。

d. JRE インストール ウィザードの指示に従います。

ステップ 3 Windows Start メニューで、Setting > Control Panal をクリックします。

ステップ 4 Java Plug-in Control Panel ウィンドウで、Java Plug-in 1.4.2 アイコンをダブルクリックします。

ステップ 5 Java Plug-in Control Panel の Advanced タブをクリックします。

ステップ 6 C:\ProgramFiles\JavaSoft\JRE\1.4.2 に移動します。

ステップ 7 JRE 1.4 を選択します。

ステップ 8 Apply をクリックします。

ステップ 9 Java Plug-in Control Panel ウィンドウを閉じます。

ブラウザの再設定

ステップ 1 Start メニューから、ブラウザ アプリケーションを起動します。

ステップ 2 Netscape Navigator を使用している場合

a. Netscape Navigator のメニューバーで、Edit > Preferences メニューをクリックします。

b. Preferences ウィンドウで、Advanced > Proxies カテゴリをクリックします。

c. Proxies ウィンドウで、Direct connection to the Internet チェックボックスにチェックマークを付

け、OK をクリックします。

d. Netscape Navigator のメニューバーで、Edit > Preferences メニューをクリックします。

e. Preferences ウィンドウで、Advanced > Cache カテゴリをクリックします。

f. Disk Cache Folder フィールドに次のいずれかのパスが設定されていることを確認します。

• Windows 98/ME では、C:\ProgramFiles\Netscape\Communicator\cache

• Windows NT/2000/XP では、C:\ProgramFiles\Netscape\username\Communicator\cache

g. Disk Cache Folder フィールドの設定が正しくない場合は、Choose Folder をクリックします。

h. ステップ f に示したファイルまで移動し、OK をクリックします。

i. Preferences ウィンドウで OK をクリックし、ブラウザを終了します。

ステップ 3 Internet Explorer を使用している場合

a. Internet Explorer のメニューバーで、Tools > Internet Options メニューをクリックします。

b. Internet Options ウィンドウで Advanced タブをクリックします。

c. Settings メニューで、Java（Sun）までスクロールダウンし、Use Java 2 v1.4.2 for applet (requires
restart) チェックボックスをクリックします。

d. Internet Options ウィンドウで OK をクリックし、ブラウザを終了します。
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ステップ 4 コンピュータでウィルススキャン ソフトウェアが起動している場合は、一時的に無効にします。

「1.10.4　TCC2/TCC2P カードから CTC JAR ファイルをダウンロード中にブラウザが停止」（p.1-136）

を参照してください。

ステップ 5 コンピュータに Network Interface Card（NIC; ネットワーク インターフェイス カード）が 2 枚イン

ストールされていないことを確認します。NIC が 2 枚インストールされている場合は、1 つを削除

します。

ステップ 6 ブラウザを起動し、ONS 15454 にログインします。

1.9.7　使用 PC の NIC 接続を確認できない

現象   PC を ONS 15454 に接続しているとき、リンク LED が点灯も点滅もしていないため、NIC 接

続が正しく機能していることを確認できません。

考えられる原因   カテゴリ 5 ケーブルが正しく接続されていません。

推奨処置   ケーブルの両端が正しく挿入されているか確認します。ロック クリップが破損して

いるためケーブルが完全に挿入できない場合は、ケーブルを交換してください。

考えられる原因   Category-5 ケーブルが破損しています。

推奨処置   ケーブルが良好な状態か確認します。疑わしい場合には、良品に交換します。ケーブ

ルは引っ張ったり曲げたりすると破損する恐れがあります（カードの取り付けについての詳細

は、『Cisco ONS 15454 Procedure Guide』の「Install Cards and Fiber-Optic Cable」の章を参照して

ください）。

考えられる原因   Category-5 ケーブルとして誤った種類のケーブルが使用されています。

推奨処置   ONS 15454 をラップトップ、PC、またはルータに直接接続する場合は、Category-5 の

ストレート ケーブルを使用します。ONS 15454 をハブまたは LAN スイッチに接続する場合は、

Category-5 のクロス ケーブルを使用します。Category-5 ケーブルの種類についての詳細は、

「1.12.2.1　交換用 LAN ケーブルの圧着」（p.1-156） を参照してください。

考えられる原因   NIC の挿入または取り付けが正しくありません。

推奨処置   Personal Computer Memory Card International Association（PCMCIA; パーソナル コン

ピュータ メモリ カード国際協会）ベースの NIC を使用している場合は、NIC を抜き差しして、

きちんと挿入されていることを確認します（NIC がラップトップまたは PC に組み込まれている

場合は、NIC に故障がないか確認します）。

考えられる原因   NIC が故障しています。

推奨処置   NIC の機能が正常か確認します。ネットワーク（または他のノード）との接続に問題

がない場合は、NIC の機能は正常と考えられます。ネットワーク（または他のノード）との接

続が困難な場合は、NIC に故障の可能性があり、交換が必要です。
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1.9.8　PC から ONS 15454 への接続の確認（ping）

現象   TCP/IP 接続が確立後に失われました。

考えられる原因   PC と ONS 15454 の間の接続が切断されています。

推奨処置   標準の ping コマンドを使用して、PC と ONS 15454 の TCC2/TCC2P カードとの間の

TCP/IP 接続を確認します。ping コマンドは、PC が直接 TCC2/TCC2P カードと接続している場

合、または LAN を介して TCC2/TCC2P にアクセスしている場合に有効です。「ONS 15454 への

ping 送信」（p.1-131） の作業を行います。

ONS 15454 への ping 送信

ステップ 1 コマンド プロンプトを開きます。

a. Microsoft Windows オペレーティング システムを使用している場合は、Start メニューから Run
を選択し、Run ダイアログボックスの Open フィールドに command と入力し、OK をクリック

します。

b. Sun Solaris オペレーティング システムを使用している場合は、Common Desktop Environment
（CDE; 共通デスクトップ環境）から  Personal Application タブをクリックし、Terminal をク

リックします。

ステップ 2 オペレーティングシステムが Sun の場合も、Microsoft の場合も、プロンプトで次のように入力しま

す。

ping ONS-15454-IP-address

たとえば、次のように指定します。

ping 198.168.10.10

ステップ 3 ワークステーションが ONS 15454 と接続していれば、ping コマンドは正常に実行され、IP アドレ

スからの応答が表示されます。ワークステーションが正しく接続されていなければ、「Request timed

out」のメッセージが表示されます。

ステップ 4 ping コマンドが成功すれば、TCP/IP 接続が有効であることを示します。CTC を再起動します。

ステップ 5 ping コマンドが失敗し、ワークステーションが LAN 経由で ONS 15454 と接続している場合は、ワー

クステーションの IP アドレスが、ONS ノードと同じサブネットにあることを確認します。

ステップ 6 ping コマンドが失敗し、ワークステーションが ONS 15454 と直接接続している場合は、ワークス

テーションの NIC 上のリンク LED が点灯していることを確認します。
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1.9.9　ノードの IP アドレスが不明

現象   ノードの IP アドレスが不明なため、ログインできません。

考えられる原因   ノードにデフォルトの IP アドレスが設定されていません。

推奨処置   シェルに 1 枚の TCC2/TCC2P を残します。残した TCC2/TCC2P カードに PC を直接

接続し、カードのハードウェア リセットを実行します。リセット後、TCC2/TCC2P カードは IP

アドレスを送信するので、ログイン用の IP アドレスを取得できます。「不明ノード IP アドレス

の取得」（p.1-132） の作業を行います。

不明ノード IP アドレスの取得

ステップ 1 アクティブな TCC2/TCC2P カードの前面プレート上のイーサネット ポートに PC を直接接続しま

す。

ステップ 2 PC で Sniffer アプリケーションを起動します。

ステップ 3 アクティブな TCC2/TCC2P カードをいったん抜き、再度挿入することによりハードウェア リセッ

トを実行します。

ステップ 4 TCC2/TCC2P カードは、リセット後、その IP アドレスをブロードキャストにより送信します。PC

の Sniffer ソフトウェアは、ブロードキャストされた IP アドレスを取得します。
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1.10　CTC の動作のトラブルシューティング
ここでは、CTC のログインまたは動作に伴う問題を解決するためのトラブルシューティング手順に

ついて説明します。

1.10.1　CTC の色が UNIX ワークステーションに正しく表示されない

現象   UNIX ワークステーションで CTC を実行すると、色が正しく表示されません。たとえば、メ

ジャー アラームとマイナー アラームが同じ色で表示されます。

考えられる原因   UNIX ワークステーションを 256 色モードで実行しているとき、Netscape など

のカラー アプリケーションはすべての色を使用します。

推奨処置   CTC が正常に動作するためには、24 色パレットが必要です。UNIX ワークステーショ

ンで CTC にログインして、使用しているアダプタでサポートされる 大の色数を実行します。

また、-install または -ncols 32 コマンド ライン オプションを使用して、Netscape が使用する色数

を制限することもできます。「Netscape の色数の制限」（p.1-133） の作業を行います。Netscape の

色数を制限しても問題が続く場合は、使用中の他のカラー アプリケーションを終了します。

Netscape の色数の制限

ステップ 1 Netscape の現在のセッションを閉じます。

ステップ 2 コマンド ラインに次のように入力して、Netscape を起動します。

netscape -install（Netscape が使用する Netscape カラーをインストール）

または

netscape -ncols 32（Netscape を 32 色に制限して、要求された色が使用できない場合は、 も近

い色で代用する）

1.10.2　Netscape を削除したあと、CTC ヘルプを起動できない

現象   Netscape を削除したあと、Internet Explorer を使用して CTC を起動すると、CTC ヘルプを起

動できず、「MSIE is not the default browser」というエラー メッセージが表示されます。

考えられる原因   ブラウザファイルとヘルプファイルの関連付けがされていません。

推奨処置   CTC ソフトウェアと Netscape がインストールされると、ヘルプファイルはデフォル

トで Netscape と関連付けられます。Netscape を削除しても、ヘルプファイルは、デフォルトの

ブラウザとして Internet Explorer に自動的には関連付けられません。CTC がヘルプ ファイルを正

しいブラウザと関連付けるように、Internet Explorer をデフォルトのブラウザとして再設定しま

す。CTC ヘルプ ファイルを正しいブラウザに関連付ける方法については、「Internet Explorer を

CTC 用のデフォルトのブラウザとして再設定する」（p.1-134） を参照してください。
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Internet Explorer を CTC 用のデフォルトのブラウザとして再設定する

ステップ 1 Internet Explorer ブラウザを開きます。

ステップ 2 メニュー バーから、Tools > Internet Options をクリックします。Internet Options ウィンドウが表示

されます。

ステップ 3 Internet Options ウィンドウで、Programs タブをクリックします。

ステップ 4 Internet Explorer should check to see whether it is the default browser チェックボックスをクリックし

ます。

ステップ 5 OK をクリックします。

ステップ 6 起動しているすべての CTC アプリケーションおよび Internet Explorer アプリケーションを終了しま

す。

ステップ 7 Internet Explorer を起動し、新しい CTC セッションを開きます。これにより、CTC ヘルプにアクセ

スできます。

1.10.3　ノード ビューからネットワーク ビューに変更できない

現象   ソフトウェア R3.2 から ソフトウェア R3.3 で、大規模な複数ノード BLSR をアクティブにす

ると、いくつかのノードがグレーで表示されます。ユーザが新しい CTC にログインすると、いず

れのワークステーションからもいずれのノードでもノード ビューをネットワーク ビューに変更で

きません。また、java ウィンドウには、「Exception occurred during event dispatching:java.lang.

OutOfMemoryError」というメッセージが表示されます。

考えられる原因   大規模な複数ノード BLSR では、GUI 環境変数用にメモリの追加が必要です。

推奨処置   システムまたはユーザ CTC_HEAP 環境変数を再設定し、メモリの上限を大きくしま

す。CHC_HEAP 変数の変更を可能にする方法については、「Windows 用 CTC_HEAP 環境変数の

再設定」（p.1-135） または 「Solaris 用 CTC_HEAP 環境変数の再設定」（p.1-135） を参照してくだ

さい。

（注） この問題が通常影響を及ぼすのは、多数のノードおよび回線を管理するために追加メモリ

を必要とするような大規模ネットワークです。
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Windows 用 CTC_HEAP 環境変数の再設定

ステップ 1 起動しているすべての CTC アプリケーションおよび Netscape アプリケーションを終了します。

ステップ 2 Windows のデスクトップで、My Computer を右クリックし、ショートカット メニューから

Properties を選択します。

ステップ 3 System Properties ウィンドウで、Advanced タブをクリックします。

ステップ 4 Environmental Variables をクリックし、Environmental Variables ウィンドウを開きます。

ステップ 5 User Variables フィールドまたは System Variables フィールドの下にある New をクリックします。

ステップ 6 Variables Name フィールドに CTC_HEAP と入力します。

ステップ 7 Variables Value フィールドに 256 と入力し、OK をクリックすることにより、変数を作成します。

ステップ 8 Environment Variables ウィンドウで OK をクリックし、変更を確認します。

ステップ 9 System Properties ウィンドウで OK をクリックし、変更を確認します。

ブラウザと CTC ソフトウェアを再起動します。

Solaris 用 CTC_HEAP 環境変数の再設定

ステップ 1 ユーザ シェル ウィンドウから、すべての CTC アプリケーションをキルします。

ステップ 2 すべての Netscape アプリケーションを終了します。

ステップ 3 ユーザ シェル ウィンドウで、環境変数を設定することによりヒープ サイズを大きくします。

% setenv CTC_HEAP 256 

ステップ 4 同じユーザ シェル ウィンドウでブラウザと CTC ソフトウェアを再起動します。
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1.10.4　TCC2/TCC2P カードから CTC JAR ファイルをダウンロード中にブラウザが停
止

現象   TCC2/TCC2P カードから CTC Java アーカイブ（JAR）ファイルをダウンロード中にブラウザ

が停止またはハングアップしました。

考えられる原因   McAfee VirusScan ソフトウェアは、上記の処理に影響を及ぼすことがありま

す。この問題は、McAfee VirusScan 4.5 以上で VirusScan Download Scan を有効にしているときに

発生します。

推奨処置   VirusScan Download Scan 機能を無効にします。「VirusScan Download Scan の無効化」

（p.1-136） の作業を行います。

VirusScan Download Scan の無効化

ステップ 1 Windows の Start メニューから、Programs > Network Associates > VirusScan Console を選択します。

ステップ 2 VirusScan Console ダイアログボックスに表示された VShield アイコンをダブルクリックします。

ステップ 3 Task Properties ウィンドウの下部にある Configure をクリックします。

ステップ 4 System Scan Properties ダイアログボックスの左側にある Download Scan アイコンをダブルクリック

します。

ステップ 5 Enable Internet download scanning チェックボックスのチェックマークを外します。

ステップ 6 警告メッセージが表示されたら、Yes をクリックします。

ステップ 7 System Scan Properties ダイアログボックスで OK をクリックします。

ステップ 8 Task Properties ウィンドウで OK をクリックします。

ステップ 9 McAfee VirusScan ウィンドウを閉じます。

1.10.5　CTC が起動しない

現象   CTC が起動せず、ログイン ウィンドウが表示される前にエラー メッセージが表示されます。

考えられる原因   Netscape ブラウザのキャッシュが無効なディレクトリを指している可能性が

あります。

推奨処置   Netscape のキャッシュを有効なディレクトリにリダイレクトします。「有効なディレ

クトリへの Netscape キャッシュのリダイレクト」（p.1-137） の作業を行います。
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有効なディレクトリへの Netscape キャッシュのリダイレクト

ステップ 1 Netscape を起動します。

ステップ 2 Edit メニューを開きます。

ステップ 3 Preferences を選択します。

ステップ 4 左側の Category カラム上で、Advanced カテゴリを展開し、Cache タブを選択します。

ステップ 5 ディスク キャッシュ フォルダを、キャッシュ ファイルの場所を指すように変更します。

キャッシュ ファイルの場所は通常は、C:\ProgramFiles\Netscape\Users\yourname\cache です。ファイ

ル場所にある yourname の部分は、多くの場合、ユーザ名と同じです。

1.10.6　CTC 動作の遅延またはログイン障害

現象   CTC 動作の遅延または CTC へのログイン時に障害が発生しました。

考えられる原因   CTC キャッシュが破損している、または交換の必要があります。

推奨処置   キャッシュ ファイルを検索して、削除します。この操作により、ONS 15454 は新し

い Java アーカイブ（JAR）ファイル セットをコンピュータのハードドライブに強制的にダウン

ロードします。「CTC キャッシュ ファイルの自動削除」（p.1-137） または 「CTC キャッシュ ファ

イルの手動削除」（p.1-138） の作業を行います。

CTC キャッシュ ファイルの自動削除

注意 CTC キャッシュを削除する前に、実行中の CTC セッションをすべて停止する必要があります。CTC
キャッシュを削除すると、システムで実行中の CTC が予測できない動作をする場合があります。

ステップ 1 ブラウザの URL フィールドに ONS 15454 の IP アドレスを入力します。ブラウザの初期ウィンドウ

に、Delete CTC Cache ボタンが表示されます。

ステップ 2 開いているすべての CTC セッションとブラウザ ウィンドウを閉じます。PC のオペレーティングシ

ステムの機能により、使用中のファイルを削除することはできません。

ステップ 3 ブラウザの初期ウィンドウで Delete CTC Cache をクリックすることにより、CTC キャッシュをク

リアします。図 1-46 に Delete CTC Cache ウィンドウを示します。
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図 1-46 CTC キャッシュの削除

CTC キャッシュ ファイルの手動削除

注意 CTC キャッシュを削除する前に、実行中の CTC セッションをすべて停止する必要があります。CTC
キャッシュを削除すると、システムで実行中の CTC が予測できない動作をする場合があります。

ステップ 1 JAR ファイルを手動で削除するには、Windows Start メニューから Search > For Files or Folders を選

択します。

ステップ 2 Search Result ダイアログボックスの Search for files or folders named フィールドに ctc*.jar または

cms*.jar  と入力し、Search Now をクリックします。

ステップ 3 Search Result ダイアログボックスの Modified カラムをクリックすることにより、TCC2/TCC2P から

ファイルをダウンロードした日付と一致する JAR ファイルを探します。

ステップ 4 対象のファイルを強調表示させ、キーボードの Delete キーを押します。

ステップ 5 確認用ダイアログボックスで Yes をクリックします。
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1.10.7　CTC のネットワーク ビューでノード アイコンがグレー表示

現象   CTC のネットワーク ビューで、1 つまたは複数のノード アイコンがグレー表示となり、ノー

ド名の表示がありません。

考えられる原因   CTC のリリースが異なると、互いを認識できません。

推奨処置   「1.10.10　異なる CTC リリースが相互に認識できない」（p.1-142） で説明する方法に

より、コア バージョン ビルドを訂正します。

考えられる原因   ユーザ名またはパスワードが一致しません。

推奨処置   「1.10.11　ユーザ名またはパスワードが一致しない」（p.1-142） で説明する方法によ

りユーザ名とパスワードを訂正します。

考えられる原因   ノード間で IP 接続が未確立です。

推奨処置   通常は、イーサネット固有のアラームも発生します。「1.10.16　イーサネット接続」

（p.1-144） で説明する方法により、イーサネット接続を確認します。

考えられる原因   DCC 接続が切断されました。

推奨処置   通常は Embedded Operations Channel（EOC; 組み込みチャネル動作）アラームを伴い

ます。EOC（p.2-84） で説明する方法により、EOC アラームをクリアして DCC 接続を確認します。

1.10.8　アプレットのセキュリティ制限のため CTC を起動できない

現象   ブラウザ ウィンドウに IP アドレスを入力後、「Unable to launch CTC due to applet security

restrictions」というエラーメッセージが表示される。

考えられる原因   R4.0 以前の CTC ソフトウェアを実行しているノードにログインしようとして

います。R4.1 より前のリリースでは、CTC JAR ファイルをコンピュータにダウンロードできる

ように、java.policy ファイルを変更することが必要です。変更された java.policy ファイルがコ

ンピュータ上に存在していない可能性があります。

推奨処置   ログイン先のノードのリリースに対応するソフトウェア CD をインストールしてく

ださい。CTC セットアップ ウィザードを実行します（Setup.exe をダブルクリックします）。カ

スタム インストールを選択してから、Java Policy オプションを選択します。詳細については、

『Cisco ONS 15454 Procedure Guide』の「Connect to the PC and Log Into the GUI」の章にある CTC

のインストールの説明を参照してください。ソフトウェア CD を利用できない場合には、使用

コンピュータで java.policy ファイルを手動で編集することが必要です。「java.policy ファイルの

手動編集」（p.1-140） の作業を行います。



第 1 章      一般的なトラブルシューティング

1.10　CTC の動作のトラブルシューティング

1-140
Cisco ONS 15454 トラブルシューティング ガイド

78-17734-01-J

java.policy ファイルの手動編集

ステップ 1 コンピュータ上から java.policy ファイルを探し、テキスト エディタ（メモ帳またはワードパッド）

で開きます。

ステップ 2 ファイルの 後の行が次のとおりであることを確認します。

// Insert this into the system-wide or a per-user java.policy file.
// DO NOT OVERWRITE THE SYSTEM-WIDE POLICY FILE--ADD THESE LINES!

grant codeBase “http://*/fs/LAUNCHER.jar {
permission java.security.AllPermission;

};

ステップ 3 この 5 行がファイルにない場合には、手動で入力します。

ステップ 4 ファイルを保存し、Netscape を再起動します。

CTC が正常に起動するはずです。

ステップ 5 エラーメッセージが引き続き表示される場合は、java.policy ファイルを .java.policy として保存しま

す。Win98/2000/XP PC の場合は、ファイルの保存先を C:\Windows フォルダにします。Windows NT

4.0 以降の PC の場合は、C:\Winnt\profiles\joeuser など PC 上のすべてのユーザ フォルダにこのファ

イルを保存します。

1.10.9　Java ランタイム環境の非互換

現象   CTC アプリケーションが正しく実行されていません。

考えられる原因   互換性のある Java 2 JRE がインストールされていません。

推奨処置   JRE には、Java プログラミング言語で作成されたプログラムを実行するために必要な

Java 仮想マシン、ランタイム クラス ライブラリ と Java アプリケーション ランチャが格納され

ています。ONS 15454 の CTC は Java アプリケーションです。Java アプリケーションは、アプ

レットとは異なり、Web ブラウザのみでインストールとランタイム サービスを完全に実行でき

ません。Java プログラミング言語で作成されたアプリケーションを実行するときには、正しい

JRE をインストールすることが必要です。各 CTC ソフトウェア リリースの正しい JRE は、

Cisco ONS 15454 ソフトウェア CD に格納されています。「CTC の起動によるコア バージョン ビ

ルドの訂正」（p.1-141） の作業を行います。ネットワークで複数の CTC ソフトウェアを実行して

いる場合は、コンピュータにインストールされている JRE と各種ソフトウェア リリースとの間

に互換性がなければなりません。表 1-3 に、JRE と ONS 15454 ソフトウェア リリースの互換性

を示します。
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CTC の起動によるコア バージョン ビルドの訂正

ステップ 1 現在の CTC セッションを終了し、ブラウザを完全に閉じます。

ステップ 2 ブラウザを起動します。

ステップ 3 アラームを報告したノードの ONS 15454 の IP アドレスを入力します。このアドレスは、ログイン

したときに指定した当初の IP アドレスである場合と、当初の IP アドレスとは異なる場合がありま

す。

ステップ 4 CTC にログインします。ブラウザが、JAR ファイルを CTC からダウンロードします。

表 1-3 JRE の互換性

ソフトウェア リリース

JRE 1.2.2 
との互換性

JRE 1.3 
との互換性

JRE 1.4 
との互換性

JRE 1.4.2 
との互換性1

1. JRE 1.4.2 は推奨バージョンで、ソフトウェア CD で提供されています。

JRE 1.5 
との互換性

ONS 15454 R2.2.1 以前 あり なし なし なし なし

ONS 15454 R2.2.2 あり あり なし なし なし

ONS 15454 R3.0 あり あり なし なし なし

ONS 15454 R3.1 あり あり なし なし なし

ONS 15454 R3.2 あり あり なし なし なし

ONS 15454 R3.3 あり あり なし なし なし

ONS 15454 R3.4 なし あり なし なし なし

ONS 15454 R4.02

2. R4.0 は、旧バージョンの JRE が PC または UNIX ワークステーションで実行されている場合には、ユーザに通知
します。

なし あり なし なし なし

ONS 15454 R4.1 なし あり なし なし なし

ONS 15454 R4.5 なし あり なし なし なし

ONS 15454 R4.6 なし あり あり なし なし

ONS 15454 R4.7 なし あり あり なし なし

ONS 15454 R5.0 なし あり あり あり なし

ONS 15454 R6.0 なし なし あり あり なし

ONS 15454 R7.0 なし なし なし あり あり

ONS 15454 R7.2 なし なし なし あり あり
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1.10.10　異なる CTC リリースが相互に認識できない

現象   CTC のリリースが異なると、互いを認識できません。この状況では多くの場合、

INCOMPATIBLE-SW アラームが発生します。

考えられる原因   接続しているワークステーションにロードされたソフトウェアと 

TCC2/TCC2P カード上のソフトウェアに互換性がありません。

推奨処置   この状況は、TCC2/TCC2P ソフトウェアがアップグレードされたにもかかわらず、PC

側で互換性のある CTC JAR ファイルにアップグレードされていない場合に発生します。また、

互換性のあるソフトウェアが搭載されたログイン ノードが、ネットワーク内でさらに新しい

バージョンのソフトウェアが搭載された別のノードと接続したときにも発生します。「CTC の起

動によるコア バージョン ビルドの訂正」（p.1-142） の作業を行います。

（注） 初にログインするノードは、 新の CTC コア バージョンが搭載された ONS ノードであ

ることを確認してください。CTC コア バージョンが 2.2 以前の ONS ノードに 初にログイ

ンして、同じネットワーク内でそれより新しい CTC コア バージョンの別の ONS ノードに

ログインしようとすると、古い方のバージョンのノードは新しい方のバージョンのノード

を認識できません。

CTC の起動によるコア バージョン ビルドの訂正

ステップ 1 現在の CTC セッションを終了し、ブラウザを完全に閉じます。

ステップ 2 ブラウザを起動します。

ステップ 3 アラームを報告したノードの ONS 15454 の IP アドレスを入力します。このアドレスは、ログイン

したときに指定した当初の IP アドレスである場合と、当初の IP アドレスとは異なる場合がありま

す。

ステップ 4 CTC にログインします。ブラウザが、JAR ファイルを CTC からダウンロードします。

1.10.11　ユーザ名またはパスワードが一致しない

現象   ユーザ名とパスワードの不一致は、多くの場合、NOT-AUTHENTICATED アラームと同時に

発生します。

考えられる原因   入力されたユーザ名またはパスワードが TCC2/TCC2P に登録された情報と一

致しません。

推奨処置   ネットワーク内のすべての ONS ノードを表示するには、すべての ONS ノードに同じ

ユーザ名とパスワードが登録されていることが必要です。ネットワーク内で、ログインしよう

とするユーザのユーザ名とパスワードが登録されていない ONS ノードにはログインできませ

ん。ONS 15454 に 初にログインするときには、CISCO15 というユーザ名を大文字で入力して、

Login をクリックし、パスワードとして「otbu+1」と入力します（パスワードは大文字と小文字

が区別されます）。「正しいユーザ名とパスワードの確認」（p.1-143） の作業を行います。ノード
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が Radius 認証を使用するように設定されていた場合、ユーザ名とパスワードは、ローカル ノー

ド データベース内のセキュリティ情報ではなく、Radius サーバ データベースと照合されます。

Radius セキュリティの詳細については、『Cisco ONS 15454 Reference Manual』の「Security」の章

を参照してください。

正しいユーザ名とパスワードの確認

ステップ 1 キーボードの Caps Lock キーがオフで、ユーザ名とパスワードの大文字小文字の区別に影響を与え

ないことを確認します。

ステップ 2 システム管理者に正しいユーザ名とパスワードを尋ねます。

ステップ 3 弊社のテクニカル サポート担当者と連絡を取り、システムにログインして、新しいユーザ名とパス

ワードを作成するよう依頼します。

1.10.12　ノード間に IP 接続が存在しない

現象   ノード間に IP 接続が存在しません。ノードがグレーのアイコンで表示される。この問題は、

通常、アラームを伴います。

考えられる原因   イーサネット接続が切断されています。

推奨処置   通常は、イーサネット固有のアラームも発生します。「1.10.16　イーサネット接続」

（p.1-144） で説明する方法により、イーサネット接続を確認します。

1.10.13　DCC 接続が切断された

現象   DCC 接続が失われました。通常はノードにアラームが発生し、ネットワーク ビューにその

ノードがグレー表示されます。この症状は通常 EOC アラームを伴います。

考えられる原因   DCC 接続が切断されました。

推奨処置   通常は EOC アラームを伴います。EOC（p.2-84） で説明する方法により、EOC アラー

ムをクリアして DCC 接続を確認します。

1.10.14　回線作成中に「Path in Use」エラーが発生

現象   回線作成中に、「Path in Use」エラーが発生したため、回線作成を終了できません。

考えられる原因   他のユーザが別の回線を作成するために同じ発信元ポートをすでに選択され

ています。

推奨処置   回線のプロビジョニングが終了するまで、CTC は使用可能なカードとポートのリス

トから、カードやポートを削除しません。2 人のユーザが回線作成のために同じ発信元ポートを

同時に選択すると、 初に回線のプロビジョニングを終了したユーザがポートの使用権を得ま
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す。他方のユーザには「Path in Use」エラーが表示されます。回線作成を取り消してやり直す

か、回線作成の 初のウィンドウに戻るまで Back ボタンをクリックします。選択した発信元

ポートは、すでにプロビジョニングが終了した回線の一部となっているため、使用可能なポー

トのリストからは外されています。別の使用可能なポートを選択し、回線作成プロセスをもう

一度開始します。

1.10.15　IP サブネットの計算と設計

現象   ONS 15454 の IP サブネットの計算や設計ができません。

考えられる原因   ONS 15454 の IP 機能では、IP サブネットを正しく設計するために固有の計算

が必要となります。

推奨処置   シスコは、IP サブネットの計算と設計を行うための無料のオンライン ツールを提供

しています。http://www.cisco.com/techtools/ip_addr.html にアクセスしてください。ONS 15454 の

IP 機能の詳細については、『Cisco ONS 15454 Reference Manual』の「Management Network

Connectivity」の章を参照してください。

1.10.16　イーサネット接続

現象   イーサネット接続に問題がある可能性がある、または正しく機能していません。

考えられる原因   しっかり接続されていません。

考えられる原因   間違って接続されています。

推奨処置   イーサネット ネットワークでの接続問題のほとんどは、いくつかのガイドラインを

守ることにより解決できます。図 1-47 を参照して、「イーサネット接続の確認」（p.1-145） の作

業を行います。

図 1-47 イーサネット接続の参照

http://www.microsoft.com
http://www.microsoft.com
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イーサネット接続の確認

ステップ 1 アラーム フィルタが OFF であることを確認します。

ステップ 2 VLAN イーサネット回線を伝送している STS 上で、SONET および DWDM アラームを確認します。

第 2 章「アラームのトラブルシューティング」 を参照して、アラームをすべてクリアします。

ステップ 3 イーサネット固有のアラームの有無を確認します。第 2 章「アラームのトラブルシューティング」

を参照して、発生しているアラームをすべてクリアします。

ステップ 4 イーサネット カード上の ACT LED がグリーンであることを確認します。

ステップ 5 ONS 15454 ＃ 1 のポート 1 と 3 および ONS 15454 #2 のポート 1 と 2 のグリーンのリンク整合 LED

が点灯していることを確認します。

ステップ 6 いずれかのポートのグリーンのリンク整合 LED が点灯していない場合、次の項目を実行します。

a. ONS 15454 と接続デバイスの間の物理的接続を確認します。

b. イーサネット カード上でポートが有効に設定されていることを確認します。

c. 正しいイーサネット ケーブルが使用され、その結線が正しいことを確認します。または、ケー

ブルを良品のイーサネット ケーブルと交換します。

d. イーサネット カードの前面プレート上のステータス LED で、カードが正しくブートされてい

ることを確認します。この LED がグリーンの連続点灯であれば正常です。必要に応じて、カー

ドをいったん外して再度挿入することにより、リブートさせます。

e. イーサネット ポートが正しく機能していても、リンク LED 自体が故障している可能性もあり

ます。「一般的なカード LED の動作確認」（p.1-118） の作業を行います。

ステップ 7 ローカル接続のデバイス A とデバイス C の間で ping をやり取りすることにより、これらデバイス

間の接続を確認します。「1.9.8　PC から ONS 15454 への接続の確認（ping）」（p.1-131） の作業を行

います。ping が失敗した場合、次の項目を実行します。

a. デバイス A と C が同じ IP サブネットにあることを確認します。

b. CTC カード ビューでイーサネット カードを開き、Provisioning > VLAN タブをクリックするこ

とにより、カード上のポート 1 とポート 3 がどちらも同じ VLAN に割り当てられていることを

確認します。

c. いずれかのポートが正しい VLAN に割り当てられていない場合は、該当する VLAN 行のポー

ト列をクリックし、そのポートを Tagged または Untag に設定します。Apply をクリックします。

ステップ 8 デバイス B と D について ステップ 7 を繰り返します。

ステップ 9 VLAN #1 を伝送しているイーサネット回線がプロビジョニング済みであり、ONS 15454 #1 と

ONS 15454 #2 のポートも VLAN #1 を使用していることを確認します。
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1.10.17　VLAN が Untag ポートからネットワーク デバイスに接続できない

現象   1 つの ONS 15454 イーサネット カード ポートが Tagged に設定され、別の ONS 15454 イーサ

ネット カードが Untag に設定された VLAN があるネットワークでは、Untag ポートに接続された

ネットワーク デバイスに対して Address Resolution Protocol（ARP; アドレス解決プロトコル）を実

装することが困難な場合があります（図 1-48 を参照）。このようなネットワークでは、Untag ポー

トに接続されたネットワーク デバイスでのラント パケット カウントが通常よりも大きくなりま

す。この症状または制限は、同じカード内のポートまたは同じシャーシ内のポートが、Tagged と

Untagged が混在した状態で同じ VLAN 上に配置された場合にも発生します。

考えられる原因   Tagged ONS 15454 では IEEE 802.1Q タグが追加され、Untag ONS 15454 ではバ

イトの置換なしに Q タグが削除されます。ネットワーク デバイスの NIC は、パケットをラン

ト（大きい）として分類し、このパケットを削除します。

考えられる原因   パケットの破棄は、ARP が、Untag ポートに接続されたネットワーク デバイ

スの IP アドレスと、ネットワーク アクセス層が必要とする物理 MAC アドレスの照合を試みた

ときにも発生します。

推奨処置   VLAN のどちらのポートも Tagged に設定することにより、データパケットから 4 バ

イトが削除されることを防止するとともに、ネットワーク アクセス デバイス内の NIC カードが

パケットをラント（大きい）と認識して破棄することを防止することで解決します。IEEE 802.1Q

に準拠している NIC カードを持つネットワーク デバイスは、タグ付きパケットを受け付けます。

IEEE 802.1Q に準拠していない NIC カードを持つネットワーク デバイスは、この場合でもタグ

付きパケットを破棄します。この問題を解決するには、ネットワーク デバイスの IEEE 802.1Q

に準拠しない NIC カードを、IEEE 802.1Q に準拠した NIC カードにアップグレードします。

VLAN 上の両方のポートを Untag に設定することも可能ですが、この場合、IEEE 802.1Q に準拠

しなくなります。

図 1-48 Tagged と Untag が混在したイーサネット ポートがある VLAN
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VLAN ポートの Tagged と Untag 設定の変更

ステップ 1 問題の VLAN にあるイーサネット カードの CTC カード ビューを開きます。

ステップ 2 Provisioning > Ether VLAN タブをクリックします（図 1-49 を参照）。

図 1-49 各イーサネット ポートの VLAN メンバーシップの設定

ステップ 3 ポートが Tagged に設定されている場合には、引き続き VLAN 内の他のカードとそのポートから、

Untag に設定されたポートを探します。

ステップ 4 Untag に設定された VLAN ポートが見つかったら、そのポートをクリックし、Tagged を選択します。

（注） 接続された外部デバイスは、IEEE 802.1Q VLAN を認識できることが必要です。

ステップ 5 各ポートが適切な VLAN に配置されたら、Apply をクリックします。
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1.11　回線とタイミング
ここでは、回線作成や回線報告に関するエラー、および一般的なタイミング基準エラーやアラーム

が発生した場合の解決方法を説明します。

1.11.1　OC-N 回線の不完全状態への遷移

現象   ある状態から別の状態への自動または手動による回線の遷移の結果、OOS-PARTIAL 状態が

発生します。これは、回線内のすべての OC-N 接続が IS-NR サービス状態ではないことを示します。

考えられる原因   手動移行時、CTC が該当ノードのいずれかと通信できないか、または該当

ノードのいずれかで使われているソフトウェアが新しい状態モデルをサポートしていないバー

ジョンです。

推奨処置   手動の移行操作を繰り返します。不完全状態が解消されない場合は、回線内のノード

のうち、目的の状態に遷移しないノードを特定します。「OC-N 回線ノードの状態の表示」

（p.1-148） の作業を行います。目的の状態に遷移しない回線ノードにログインし、ソフトウェア

のバージョンを確認します。ノードのソフトウェアが Software R3.3 以前の場合は、ソフトウェ

アをアップグレードします。アップグレード手順については、リリースに対応したソフトウェ

ア アップデート マニュアルを参照してください。

（注） ノードのソフトウェアを R4.0 にアップグレードできない場合は、旧ソフトウェア バー

ジョンでサポートされていた回線状態のみを使用することにより、不完全状態を避ける

ことができます。

考えられる原因   自動遷移時、回線で何らかのパスレベルの障害またはアラームが検出されま

した。

考えられる原因   回線の一方の端が正しく終端されていません。

推奨処置   回線内のノードのうち、目的の状態に遷移しないノードがどれであるかを特定しま

す。「OC-N 回線ノードの状態の表示」（p.1-148） の作業を行います。目的の状態に遷移しない回

線ノードにログインし、この回線でパスレベルの障害、回線終端不良、またはアラームの有無

を調べます。アラームをクリアする手順については、第 2 章「アラームのトラブルシューティ

ング」 を参照してください。回線の設定を変更する手順については、『Cisco ONS 15454 Procedure

Guide』の「Manage Circuits」の章を参照してください。回線ノードの障害またはアラーム（ま

たはその両方）を解決してクリアし、回線全体が目的の状態に遷移することを確認します。

OC-N 回線ノードの状態の表示

ステップ 1 Circuits タブをクリックします。

ステップ 2 Circuits タブのリストから、*_PARTIAL 状態の回線を選択します。

ステップ 3 Edit をクリックします。Edit Circuit ウィンドウが表示されます。

ステップ 4 Edit Circuit ウィンドウの State タブをクリックします（SONET 回線を表示している場合）。
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State タブ ウィンドウに、回線内の各ノードの Node（ノード名）、End A（終端 A）、End B（終端

B）、CRS Admin State、および CRS Service State（CRS サービス状態）が表示されます。

1.11.2　VT 回線を使用していない DS3XM-6 または DS3XM-12 の AIS-V

現象   不完全な回線パスが AIS の原因です。

考えられる原因   アラームを報告しているノードのポートはイン サービスですが、回線のアッ

プストリームのノードの OC-N ポートがイン サービスになっていません。

推奨処置   AIS-V は、Virtual Tributary（VT; 仮想トリビュタリ）レイヤでアップストリーム障害

が発生したことを示します。AIS-V アラームは、トラフィックを伝送していず、孤立した帯域

幅の DS3XM-6 および DS3XM-12 VT 回線でも発生します。「VT 回線を使用していない DS3XM-6

または DS3XM-12 の AIS-V のクリア」（p.1-149） の作業を行います。

VT 回線を使用していない DS3XM-6 または DS3XM-12 の AIS-V のクリア

ステップ 1 影響を受けているポートを調べます。

ステップ 2 ノード ID、スロット番号、ポート番号、または VT 番号を記録します。

ステップ 3 Source node/Slot 2/Port 2/VT 13 にクロスコネクトされた Source node/Slot 2/Port 2/VT 13 など、影響を

受けたポートからそれ自身への単方向 VT 回線を作成します。

ステップ 4 回線作成ウィンドウで、Bidirectional チェックボックスをオフにします。

ステップ 5 単方向 VT 回線に、「delete me」などわかりやすい名前を付けます。

ステップ 6 CTC カード ビューで、DS3XM-6 カードを開きます。Maintenance > DS1 タブをクリックします。

ステップ 7 アラームを報告している VT を特定します（DS3 #2、DS1 #13 など）。

ステップ 8 Loopback Type リストから、 Facility を選択して、 Apply をクリックします。

ステップ 9 Circuits をクリックします。

ステップ 10 ステップ 3 で作成した単方向回線を見つけます。回線を選択して、 Delete をクリックします。他の

チェックボックスはチェックしないでください。

ステップ 11 Delete Confirmation ダイアログボックスで Yes をクリックします。

ステップ 12 CTC カード ビューで、DS3XM-6 または DS3XM-12 カードを開きます。Maintenance > DS1 タブを

クリックします。

ステップ 13 Facility Loopback の VT を特定します。

ステップ 14 Loopback Type リストから、None を選択して、 Apply をクリックします。
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ステップ 15 Alarms タブをクリックして、AIS-V アラームがクリアされたことを確認します。

ステップ 16 DS3XM-6 または DS3XM-12 カード上のすべての AIS-V アラームについて、この手順を繰り返しま

す。

1.11.3　VT1.5 回線での回線作成エラー

現象   CTC で VT1.5 回線を作成しようとすると、「Error while finishing circuit creation.Unable to

provision circuit.Unable to create connection object at node_name」というメッセージが表示されます。

考えられる原因   エラー メッセージに示されている ONS 15454 の VT クロスコネクト マトリッ

クスが帯域幅不足になった可能性があります。

推奨処置   マトリックスの 大容量は、336 の双方向 VT1.5 クロスコネクトです。BLSR では、

336 未満の双方向 VT1.5 で、または、Unidirectional Path Switched Ring（UPSR; 単方向パス切り替

えリング）あるいは 1+1 保護グループでは、224 以下の双方向 VT1.5 で、VT 容量がいっぱいに

なることがあります。詳細については、『Cisco ONS 15454 Reference Manual』の「Circuits and

Tunnels」の章を参照してください。

1.11.4　DS-3 カードから DS3XM-6 または DS3XM-12 カードへの回線を作成できない

現象   DS-3 カードから DS3XM-6 または DS3XM-12 カードへの回線は作成できません。

考えられる原因   DS-3 カードと DS3XM-6 または DS3XM-12 カードでは、機能が異なります。

推奨処置   DS3XM-6 カードは、ネットワーク全体のクロス コネクションのために、6 つの DS-3

インターフェイスのそれぞれを 28 の DS-1 に変換します。DS3XM-12 は、12 のインターフェイ

スのそれぞれを 48 の DS-1 に変換します。したがって、DS3XM-6 または DS3XM-12 カードから

DS-1 カードへの回線を作成することはできますが、DS3XM カードから DS-3 カードへの回線は

作成できません。このような違いは、STS パス オーバーヘッドに示されています。DS-3 カード

は DS-3 の非同期マッピングを使用します。これは、STS パス オーバーヘッドの C2 バイトが 16

進数の 04 であることによって示されます。DS3XM-6 または DS3XM-12 の VT ペイロードの C2

は、16 進数の 02 です。

（注） 回線の作成手順についての説明は、『Cisco ONS 15454 Procedure Guide』の「Create Circuits
and VT Tunnels」の章にあります。
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1.11.5　DS-3 カードで外部機器からの AIS-P が報告されない

現象   DS3-12、DS3N-12、DS3-12E、または DS3N-12E カードは、外部機器 / 回線側からの STS AIS-P

を報告しません。

考えられる原因   カードは設計どおりに機能しています。

推奨処置   このカードはバックプレーンでポート信号を終端するため、外部機器や回線側からの

STS AIS-P は報告されません。DS3-12、DS3N-12、DS3-12E、および DS3N-12E カードには、DS3

ヘッダー モニタリング機能があり、DS3 パス上で PM を行うことができます。しかし、STS パ

スの AIS-P を表示することはできません。DS3-12、DS3N-12、DS3-12E、または DS3N-12E カー

ドの PM 機能の詳細については、『Cisco ONS 15454 Reference Manual』の「Performance Monitoring」

を参照してください。

1.11.6　OC-3 と DCC の制限事項

現象   OC-3 および DCC の使用に制限があります。

考えられる原因   ONS 15454 では、OC-3 および DCC の使用に制限があります。

推奨処置   OC-3 および DCC の制限事項については、『Cisco ONS 15454 Reference Manual』の

「Circuits and Tunnels」の章を参照してください。

1.11.7　ONS 15454 でタイミング基準が切り替わります。

現象   問題発生時にタイミング基準が切り替わる。

考えられる原因   光入力または BITS 入力がタイミング ソースから Loss Of Signal（LOS; 信号消

失）、Loss Of Frame（LOF; フレーム同期損失）、または AIS アラームを受信しました。

考えられる原因   光入力または Building Integrated Timing Supply（BITS; ビル内統合タイミング

供給源）入力が機能しません。

考えられる原因   Synchronization Status Messaging（SSM; 同期ステータス メッセージング）メッ

セージが Do Not Use for Synchronization（DUS）に設定されています。

考えられる原因   SSM は、Stratum 3 以下のクロック品質を示します。

考えられる原因   入力周波数に 15 ppm を超えるずれがあります。

考えられる原因   入力クロックが安定せず、30 秒間に 3 回を超えるスリップがあります。

考えられる原因   2 分以上の間、正しくないタイミング基準がありました。

推奨処置   ONS 15454 の内部クロックは、Stratum 3E レベルの精度で動作します。これにより、

ONS 15454 は、±4.6 ppm のフリーラン同期精度を実現し、24 時間以内のスリップ数が 255 未満

または 1 日あたりスリップ数が 3.7 × 10-7 未満というホールドオーバー（長時間）安定性を実現

しています（温度による変動を含む）。ONS 15454 のフリーラン同期は、Stratum 3 の内部クロッ

クを基準としています。長期間にわたる場合、高い品質の（Stratum 1 または Stratum 2 の）タイ

ミング ソースを使用すると、低い品質の（Stratum 3 の）タイミング ソースを使用した場合に比

べて、タイミング スリップ数が少なくなります。
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1.11.8　ホールドオーバー同期アラーム

現象   クロックが通常と異なる周波数で動作している状態で、HLDOVRSYNC（p.2-131） が発生し

ます。

考えられる原因   新の基準入力が失敗しました。

推奨処置   クロックは、良好であることが明らかな 新の基準入力の周波数で動作しています。

このアラームは 新の基準入力が失敗したときに発生します。詳細は、「HLDOVRSYNC」

（p.2-131） を参照してください。

（注） ONS 15454 は、外部（BITS）タイミングを使用するようにプロビジョニングされている場

合、Telcordia GR-436 準拠のホールドオーバー タイミングをサポートします。

1.11.9　フリーラン同期モード

現象   クロックが通常と異なる周波数で動作している状態で、FRNGSYNC（p.2-119） が発生します。

考えられる原因   信頼できる基準入力が使用できません。

推奨処置   クロックは、内部オシレータを唯一の周波数基準として使用しています。この状態

は、信頼できる以前のタイミング基準が使用できない場合に発生します。詳細は、「FRNGSYNC」

（p.2-119） を参照してください。

1.11.10　デイジーチェーン接続した BITS が機能しない

現象   BITS ソースをデイジーチェーン接続できません。

考えられる原因   デイジーチェーン接続した BITS ソースは ONS 15454 でサポートされていませ

ん。

推奨処置   デイジーチェーン接続した BITS を使うとネットワーク内に余計な構造が増えるた

め、デイジーチェーン接続した BITS はサポートしていません。代わりに、タイミング信号発生

器を使って BITS クロックを複数作成し、それらを各 ONS 15454 に個別にリンクしてください。

1.11.11　カード取り付け後の STAT LED の点滅

現象   カードを取り付けたあと、STAT LED が 60 秒以上点滅します。

考えられる原因   Power-on Shelf Test（POST）診断に不合格だったため、カードをブートできま

せん。

推奨処置   STAT LED の点滅は、POST 診断が実行中であることを示します。この LED が 60 秒

以上点滅する場合、カードが POST 診断テストに不合格だったため、ブートに失敗したことを

示します。カードに実際に障害がある場合は、該当のスロット番号に対して、EQPT（p.2-88） が

「Equipment Failure（装置障害）」の説明とともに発生します。Alarm タブを見て、カードを取り

付けたスロットに対してこのアラームが表示されていないか調べます。この状態から回復する
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には、カードをいったん取り外してから再取り付けし、カードのブート プロセスを確認します。

カードのブートが失敗する場合は、カードを交換してください。「トラフィック カードの物理的

な交換」（p.2-293） の作業を行います。

1.12　ファイバとケーブル接続
ここでは、主にケーブル接続エラーが原因で発生する問題について説明します。そのほか、

Category-5 ケーブルを圧着する手順について説明し、光ファイバ接続レベルの一覧も示します。

1.12.1　トラフィック カードでビット エラーが発生

現象   トラフィック カードで複数のビット エラーが発生しています。

考えられる原因   ケーブル接続に誤りがあるか、光回線レベルが低い状態です。

推奨処置   一般に、回線（トラフィック）カードのビット エラーは、ケーブル接続の問題か、ま

たは光回線レベルが低すぎることが原因で発生します。このエラーは、同期の問題が原因で発

生します。特に、Pointer Justification（PJ; ポインタ位置調整）エラーが報告される場合に発生し

ます。エラーの発生していない別のスロットにカードを移すことにより、原因を特定できます。

これらエラーの原因としては ONS 15454 に接続されている外部ケーブル、光ファイバ、外部機

器が考えられるため、可能であれば必ずテスト セットを使用します。光レベルが低い場合のト

ラブルシューティングについては、「1.12.2　光ファイバ接続障害」（p.1-153） を参照してくださ

い。

1.12.2　光ファイバ接続障害

現象   回線カードで SONET/DWDM アラームや信号エラーが複数発生しました。

考えられる原因   光ファイバ接続障害が発生しました。

推奨処置   光ファイバ接続に障害があると、SONET/DWDM アラームや信号エラーの原因にな

ります。「光ファイバ接続の確認」（p.1-154） の作業を行います。

考えられる原因   Category-5 ケーブルの不良です。

推奨処置   Category-5 ケーブルに不良があると、SONET/DWDM アラームや信号エラーの原因に

なります。「1.12.2.1　交換用 LAN ケーブルの圧着」（p.1-156） の作業を行います。

考えられる原因   GBIC に障害があります。

推奨処置   GBIC に障害があると、SONET/DWDM アラームや信号エラーの原因になります。

「1.12.2.2　障害の発生した GBIC、SFP、または XFP コネクタの交換」（p.1-158） を参照してくだ

さい。

警告 接続されていない光ファイバ ケーブルやコネクタからは目に見えないレーザー光が放射されてい

る可能性があります。レーザー光を直視したり、光学機器を使用して直接見たりしないでください。
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警告 レーザー放射は目に見えない障害を引き起こしますので、レーザー光線の被曝を避けてください。

レーザーの安全な取り扱いに習熟していて、この装置を扱う前に、適切な目の保護を行わなければ

なりません。

光ファイバ接続の確認

ステップ 1 シングルモードのファイバが ONS 15454 OC-N カードに接続されていることを確認します。

（注） 光ファイバ スパン ケーブルに、「SM」または「SM Fiber」と印字されているはずです。

ONS 15454 OC-N カードでは、マルチモード ファイバは使用しません。

ステップ 2 SC ファイバ コネクタのコネクタ キーの位置が正しいこと、正しくロックされていることを確認し

ます。

ステップ 3 シングルモード光ファイバのパワー レベルが指定の範囲内であることを確認します。

a. 障害発生の疑いのある光ファイバの受信終端を取り外します。

b. 障害発生の疑いのあるファイバの Rx 終端をファイバ用光パワー メーター（GN Nettest LP-5000
など）に接続します。

c. ファイバ用光パワー メーターを使ってファイバのパワー レベルを調べます。

d. パワー メーターがテスト対象の OC-N カードに適した波長（カードにより、1310 nm または

1550 nm）に設定されていることを確認します。

e. パワー レベルがテスト対象カード（OC-N カードの場合）に指定された範囲内であることを確

認します。詳細は、「1.12.3　OC-N カードの送受信レベル」（p.1-162） を参照してください。

ステップ 4 パワー レベルが OC-N カードの指定範囲未満の場合は、次の手順を実行します。

a. ファイバ パッチ コードの汚れを取り除くか、交換します。現場の方法に従って、または、現

場の方法がない場合は、『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の章の手順

に従って、ファイバを清掃します。可能な場合は、作業対象の OC-N カードと遠端のカードに

ついて、これを行います。

b. カードの光コネクタの汚れを取り除きます。現場の方法に従って、または、現場の方法がない

場合は、『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の章の手順に従って、コネ

クタを清掃します。可能な場合は、作業対象の OC-N カードと遠端のカードについて、これを

行います。

c. 遠端の送信カードが ONS IR カードでないことを確認します（ONS LR カードが適切な場合）。

IR カードは、LR カードよりも小さな出力パワーで送信します。

d. 遠端の送信側 OC-N カードのトランスミッタの劣化が障害原因かどうかを確認するため、この

OC-N カードを交換します。
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注意 ポートで現在トラフィックを伝送しているカードを取り外すと、トラフィックが中断される可能性

があります。これを回避するために、切り替えがまだ行われていない場合は外部切り替えを行いま

す。「2.9.2　保護切り替え、ロック開始、クリア」（p.2-278） の手順を参照してください。詳細につ

いては、『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の章を参照してください。

e. 光ファイバとカードを交換してもパワー レベルが指定範囲に満たない場合は、パワー レベル

が減衰して Link Loss（LL; リンク損失）の原因になる次の 3 つの要因を調べます。

• ファイバ距離の超過。シングルモードのファイバの場合、約 0.5 dB/km で減衰します。

• ファイバ コネクタ数の超過。コネクタごとに約 0.5 dB の減衰が発生します。

• ファイバ接合部位数の超過。接合部位ごとに約 0.5 dB の減衰が発生します。

（注） 上記の値は標準的な減衰値です。製品のマニュアルを見て実際の値を確かめるか、

Optical Time Domain Reflectometer（OTDR）を使用して正確なリンク損失およびバジェッ

ト要件を確定してください。

ステップ 5 ファイバのパワー レベルが表示されない場合は、ファイバが不良であるか、OC-N カードのトラン

スミッタに障害があります。

a. Tx ファイバと Rx ファイバが逆になっていないことを確認します。一般に、LOS および EOC
アラームは、Tx ファイバと Rx ファイバが逆になっているときに発生します。逆になっている

Tx ファイバと Rx ファイバを正しい状態にすることにより、アラームはクリアされ、信号は回

復します。

b. ファイバ パッチ コードの汚れを取り除くか、交換します。現場の方法に従って、または、現

場の方法がない場合は、『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の章の手順

に従って、ファイバを清掃します。可能な場合は、作業対象の OC-N カードと遠端のカードに

ついて、これを行います。

c. 光ファイバのパワー レベルの再テストを行います。

d. ファイバを交換してもパワー レベルが表示されない場合は、OC-N カードを交換します。

注意 ポートで現在トラフィックを伝送しているカードを取り外すと、トラフィックが中断される可能性

があります。これを回避するために、切り替えがまだ行われていない場合は外部切り替えを行いま

す。「2.9.2　保護切り替え、ロック開始、クリア」（p.2-278） の手順を参照してください。詳細につ

いては、『Cisco ONS 15454 Procedure Guide』の「Maintain the Node」の章を参照してください。

ステップ 6 ファイバのパワー レベルがカードに指定された範囲より高い場合は、ONS IR カードが適切である

にもかかわらず、ONS LR カードが使用されていないか確認します。

LR カードは、IR カードよりも大きな出力パワーで送信します。ファイバの距離が短い場合、LR ト

ラッスミッタでは、受信側 OC-N カードのレシーバーに対して光量が大きすぎます。

レシーバーの 大光量を超えると、レシーバーに過負荷が発生します。
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ヒント レシーバーの過負荷を防ぐには、ONS OC-N カードのトランスミッタとレシーバーを接続するファ

イバに減衰器を取り付けます。ONS OC-N カードの受信トランスミッタに減衰器を取り付けてくだ

さい。具体的な手順については、減衰器のマニュアルを参照してください。

ヒント ほとんどの場合、2 本のより線ファイバのうちの 1 本だけに文字が印刷されています。この文字を

見て、Tx に接続するファイバと Rx に接続するファイバを区別します。

1.12.2.1　交換用 LAN ケーブルの圧着

用意した LAN ケーブルを圧着して、ONS 15454 で使用できます。ONS 15454 をハブ、LAN モデム、

またはスイッチに接続するときはクロス ケーブルを使用し、ONS 15454 をルータやワークステー

ションに接続するときは LAN ケーブルを使用します。Category-5 ケーブル RJ-45 T-568B、カラー

コード（100 MBps）と圧着工具を使用します。図 1-50 に、RJ-45 コネクタの配線を示します。図

1-51 に LAN ケーブルのレイアウトを、表 1-4 にケーブルのピン割り当てを示します。図 1-52 にク

ロス ケーブルのレイアウトを、表 1-5 にクロス ケーブルのピン割り当てを示します。

図 1-50 RJ-45 のピン番号

図 1-51 LAN ケーブルのレイアウト



第 1 章      一般的なトラブルシューティング

1.12　ファイバとケーブル接続

1-157
Cisco ONS 15454 トラブルシューティング ガイド

78-17734-01-J

図 1-52 クロス ケーブルのレイアウト

（注） 奇数番号のピンは、必ず白地に色つきの縞が入った線と接続します。

表 1-4 LAN ケーブルのピン割り当て

ピン 色 ペア 名前 ピン

1 ホワイト / オレンジ 2 送信データ + 1

2 オレンジ 2 送信データ – 2

3 ホワイト / グリーン 3 受信データ + 3

4 ブルー 1 — 4

5 ホワイト / ブルー 1 — 5

6 グリーン 3 受信データ – 6

7 ホワイト / ブラウン 4 — 7

8 ブラウン 4 — 8

表 1-5 クロス ケーブルのピン割り当て

ピン 色 ペア 名前 ピン

1 ホワイト / オレンジ 2 送信データ + 3

2 オレンジ 2 送信データ – 6

3 ホワイト / グリーン 3 受信データ + 1

4 ブルー 1 — 4

5 ホワイト / ブルー 1 — 5

6 グリーン 3 受信データ – 2

7 ホワイト / ブラウン 4 — 7

8 ブラウン 4 — 8
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1.12.2.2　障害の発生した GBIC、SFP、または XFP コネクタの交換

GBIC および Small Form-factor Pluggables（SFP または XFP）はホットスワップ対応であるため、カー

ドやシェルフ アセンブリが通電されて動作中の状態での取り付けや、取り外しが可能です。

警告 クラス 1 レーザー製品です。

警告 接続されていない光ファイバ ケーブルやコネクタからは目に見えないレーザー光が放射されてい

る可能性があります。レーザー光を直視したり、光学機器を使用して直接見たりしないでください。

GBIC および SFP/XFP は、ギガビット イーサネット カードにプラグインされる入出力装置であり、

ポートを光ファイバ ネットワークにリンクするために使用します。GBIC または SFP のタイプによ

り、カードから次のネットワーク装置までのイーサネット トラフィックの 大伝送距離が決まりま

す。GBIC および SFP とそれらの機能については、『Cisco ONS 15454 Reference Manual』を参照して

ください。

（注） GBIC および SFP は両端でタイプが一致している必要があります。一方が SX の場合はもう一方も

SX であることが必要です（同様に LX には LX、ZX には ZX が対応）。

（注） すべてのバージョンの G1K-4 カードが、CWDM GBIC をサポートしています。

GBIC には 2 種類のモデルがあります。一方の GBIC モデルには、E1000-2-G、G シリーズ、または

G1K-4 カードのスロットに GBIC を固定するためのクリップが 2 つ（GBIC の各側面に 1 つずつ）あ

ります。もう一方のモデルにはロック ハンドルがあります。図 1-53 に両モデルを示します。

図 1-53 GBIC

（注） GBIC の外観はよく似ています。取り付ける前に、GBIC のラベルを慎重に確認してください。
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GBIC、SFP、または XFP コネクタの取り外し

警告 接続されていない光ファイバ ケーブルやコネクタからは目に見えないレーザー光が放射されてい

る可能性があります。レーザー光を直視したり、光学機器を使用して直接見たりしないでください。

ステップ 1 GBIC SC コネクタまたは XFP/SFP LC デュプレックス コネクタからネットワーク ファイバ ケーブ

ルを取り外します。

ステップ 2 両側にある 2 つのプラスチック タブを同時に引っ張ることにより、GBIC または SFP/XFP をスロッ

トから外します。

ステップ 3 GBIC または SFP/XFP をスライドさせて、ギガビット イーサネット モジュール スロットから抜き

取ります。ギガビット イーサネット カードのコネクタを保護するため、GBIC または SFP スロット

のフラップが閉じます。

GBIC または SFP/XFP デバイスの取り付け

警告 クラス 1 レーザー製品です。

警告 終端していない光ファイバ ケーブルの先端やコネクタからは、目に見えないレーザー光線が放射

されていることがあります。レーザー光線を光学機器を通して直接見ないでください。特定の光学

機器（ルーペ、拡大鏡、顕微鏡など）を使用して 100 mm 以内の距離からレーザー光線を見ると、

目を痛める危険性があります。

（注） 2003 年 8 月以前に製造された G シリーズ カードは、DWDM GBIC をサポートしていません。DWDM
GBIC に対応している G1K-4 カードの Common Language Equipment Identification（CLEI）コードは

WM5IRWPCAA です。

（注） すべてのバージョンの G1K-4 カードが、CWDM GBIC をサポートしています。

（注） GBIC、SFP、および XFP はホットスワップ対応であるため、カードやシェルフ アセンブリが通電

されて動作中の状態での取り付けや、取り外しが可能です。
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ステップ 1 GBIC、SFP、または XFP を保護パッケージから取り出します。

ステップ 2 ラベルを調べて、GBIC、SFP、または XFP がネットワークに適したタイプであることを確認します。

表 1-6 に、使用可能な GBIC を示します。

（注） GBIC の外観はよく似ています。取り付ける前に、GBIC のラベルを慎重に確認してくださ

い。

表 1-7 に、使用可能な SFP および XFP を示します。

表 1-6 使用可能な GBIC

GBIC 対応するカード 用途 ファイバ 製品番号

1000BaseSX E1000-2-G

G1K-4

CE-1000-4

SR 大長 550 m のマルチモード ファ

イバ

15454E-GBIC-SX=

15454-GBIC-SX

ONS-GC-GE-SX

1000BaseLX E1000-2-G

G1K-4

CE-1000-4

LR 大長 5 km のシングル モード ファ

イバ

15454E-GBIC-LX=

15454-GBIC-LX

ONS-GC-GE-LX

1000BaseZX G1K-4

CE-1000-4

Extra Long Reach

（ELR; 拡張長距

離）

大長 70 km のシングル モード

ファイバ

15454E-GBIC-ZX=

15454-GBIC-ZX

ONS-GC-GE-ZX

FC_MR-4 LR シングル モード ファイバ、1310 nm ONS-GX-2FC-SML=

FC_MR-4 IR マルチモード ファイバ、850 nm ONS-GX-2FC-MMI=

表 1-7 使用可能な SFP および XFP

SFP/XFP 対応するカード 用途 ファイバ 製品番号

1000BaseSX ML1000-2 SR 大長 550 m のマルチモード ファ

イバ

15454E-SFP-LC-SX=

1000BaseLX LR 大長 5 km のシングル モード ファ

イバ

15454E-SFP-LC-LX=

1000BaseFX ML100X-8 SR 大長 2 km の 1310 nm マルチモー

ド ファイバ

ONS-SE-100-FX

1000BaseLX-10 IR 大長 15 km の 1310 nm シングル

モード ファイバ

ONS-SE-100-LX10

OC-48 SR MRC-12 SR 大長 2 km の 1310 nm シングル

モード ファイバ

ONS-SI-2G-S1

OC-48 IR1 IR 大長 15 km の 1310 nm シングル

モード ファイバ

ONS-SI-2G-I1

OC-48 LR1 LR 大長 40 km の 1310 nm シングル

モード ファイバ

ONS-SI-2G-L1

OC-48 LR2 LR 大長 80 km の 1550 nm シングル

モード ファイバ

ONS-SI-2G-L2
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（注） MRC-12 カードに SFP を取り付ける前に、SFP を取り付けるポートと、使用しているクロ

スコネクト カードに基づく帯域幅の制限について、『Cisco ONS 15454 Reference Manual』の

MRC-12 カードの説明を参照してください。

ステップ 3 使用する GBIC、SFP、または XFP のタイプを確認してください。

• クリップ付き GBIC を使用する場合は、ステップ 4 へ進みます。

• ハンドル付き GBIC を使用する場合は、ステップ 5 へ進みます。

• SFP または XFP を使用する場合は、ステップ 6 へ進みます。

ステップ 4 クリップ付き GBIC の場合は、以下の手順で行います。

a. 親指と人差し指で GBIC の両側を持ち、カードのスロットに GBIC を挿入します。

OC-48 LR2 
DWDM 

MRC-12（続き） LR 大長 120 km の 1530.33 ～ 1560.61

nm シングル モード ファイバ

ONS-SC-2G-30.3 ～ 
ONS-SC-2G-60.6  

OC-3/OC-12 IR1 
デュアル レート

IR 大長 15 km の 1310 nm シングル

モード ファイバ

ONS-SI-622-I1

OC-12 LR1 LR 大長 40 km の 1310 nm シングル

モード ファイバ

ONS-SI-622-L1

OC-12 LR2 LR 大長 80 km の 1550 nm シングル

モード ファイバ

ONS-SI-622-L2

OC-12 CWDM LR 大長 80 km の 1470 ～ 1610 nm シ

ングル モード ファイバ

ONS-SE-622-1470 ～ 
ONS-SE-622-1610

OC-3 IR1 IR 大長 15 km の 1310 nm シングル

モード ファイバ

ONS-SI-155-I1

OC-3 LR1 LR 大長 40 km の 1310 nm シングル

モード ファイバ

ONS-SI-155-L1

OC-3 LR2 LR 大長 80 km の 1550 nm シングル

モード ファイバ

ONS-SI-155-L2

OC-3 CWDM LR 大長 80 km の 1470 ～ 1610 nm シ

ングル モード ファイバ

ONS_SE-155-1470 ～ 
ONS-SE-155-1610

OC-192 SR1 OC192SR1/

STM64IO Short 

Reach1

SR 大長 10 km の 1310 nm シングル

モード ファイバ

ONS-XC-10G-S1

OC-192 SR1、

IR1、LR2

OC192/

STM64 Any 

Reach1

SR 大長 10 km の 1310 nm シングル

モード ファイバ

ONS-XC-10G-S1

IR 大長 15 km の 1550 nm シングル

モード ファイバ

ONS-XC-10G-I2

LR 大長 80 km の 1550 nm シングル

モード ファイバ

ONS-XC-10G-L2

1. CTC では、このカードは OC192-XFP として表示されます。

表 1-7 使用可能な SFP および XFP（続き）

SFP/XFP 対応するカード 用途 ファイバ 製品番号
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（注） GBIC は誤った取り付けを防ぐ形状になっています。

b. 開口部を保護するフラップを通り抜けて、カチッと音がするまで、GBIC をスライドさせます。

カチッという音は、GBIC がスロットにロックされたことを示します。

c. ネットワーク光ファイバ ケーブルを接続する準備が整ったら、GBIC から保護プラグを取り外

します。プラグはあとで使用できるよう保管しておきます。次に、ファイバのコネクタを GBIC
に接続します。

ステップ 5 ハンドル付き GBIC の場合は、以下の手順で行います。

a. SC タイプのコネクタから保護プラグを取り外します。

b. 親指と人差し指で GBIC の両側を持ち、カードのスロットに GBIC を挿入します。

c. ハンドルを押し下げて閉じることにより、GBIC を所定の位置にロックします。SC タイプのコ

ネクタが隠れない状態になっていれば、ハンドルは正しく閉じられた位置になっています。

d. カバー フラップを通り抜けて、カチッと音がするまで、GBIC をスライドさせます。

カチッという音は、GBIC がスロットにロックされたことを示します。

e. ネットワーク光ファイバ ケーブルを接続する準備が整ったら、GBIC から保護プラグを取り外

します。プラグはあとで使用できるよう保管しておきます。次に、ファイバのコネクタを GBIC
に接続します。

ステップ 6 SFP および XFP の場合は、以下の手順で行います。

a. ファイバの LC デュプレックス コネクタを、弊社がサポートしている SFP または XFP に接続

します。

b. 新しい SFP または XFP にラッチが付いている場合は、ラッチを閉じてケーブルを固定します。

c. ケーブルを接続した SFP または XFP をカード ポートにカチッというまで押し込みます。

1.12.3　OC-N カードの送受信レベル

各 OC-N カードの前面プレートに送受信コネクタがあります。表1-8 に、これらのレベルを示します。
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表 1-8 光カードの送受信レベル

カード

送信 受信

小 大 小 大

OC3 IR 4/STM1 SH 1310 –15 dBm –8 dBm –28 dBm –8 dBm

OC3IR/STM1SH 1310-8 –15 dBm –8 dBm –28 dBm –8 dBm

OC12 IR/STM4 SH 1310 –15 dBm –8 dBm –28 dBm –8 dBm

OC12 LR/STM4 LH 1310 –3 dBm +2 dBm –28 dBm –8 dBm

OC12 LR/STM4 LH 1550 –3 dBm +2 dBm –28 dBm –8 dBm

OC12 IR/STM4 SH 1310-4 –15 dBm –8 dBm –30 dBm –8 dBm

OC48 IR 1310 –5 dBm 0 dBm –18 dBm 0 dBm

OC48 LR 1550 –2 dBm +3 dBm –28 dBm –8 dBm

OC48 IR/STM16 SH AS 1310 –5 dBm 0 dBm –18 dBm 0 dBm

OC48 LR/STM16 LH AS 1550 –2 dBm +3 dBm –28 dBm –8 dBm

OC48 ELR/STM16 EH 100 GHz –2 dBm 0 dBm 1E-12 BER で
–27 dBm

–9 dBm

OC48 ELR/STM16 EH 200 GHz –2 dBm 0 dBm –28 dBm –8 dBm

OC192 SR/STM64 IO 1310 –6 dBm –1 dBm –11 dBm –1 dBm

OC192 IR/STM64 SH 1550 –1 dBm +2 dBm –14 dBm –1 dBm

OC192 LR/STM64 LH 1550 +7 dBm +10 dBm –19 dBm –10 dBm

OC192 LR/STM64 LH ITU 15xx.xx +3 dBm +6 dBm –22 dBm –9 dBm

15454_MRC-12（ONS-SI-2G-S1） –10 dBm –3 dBm –18 dBm –3 dBm

15454_MRC-12（ONS-SI-2G-I1） –5 dBm 0 dBm –18 dBm 0 dBm

15454_MRC-12（ONS-SI-2G-L1） –2 dBm 3 dBm –27 dBm –9 dBm

15454_MRC-12（ONS-SI-2G-L2） –2 dBm 3 dBm –28 dBm –9 dBm

15454_MRC-12（ONS-SC-2G-30.3 ～ 

ONS-SC-2G-60.6）

0 dBm 4 dBm –28 dBm –9 dBm

15454_MRC-12（ONS-SI-622-I1） –15 dBm –8 dBm –28 dBm –8 dBm

15454_MRC-12（ONS-SI-622-L1） –3 dBm 2 dBm –28 dBm –8 dBm

15454_MRC-12（ONS-SI-622-L2） –3 dBm 2 dBm –28 dBm –8 dBm

15454_MRC-12（ONS-SE-622-1470 ～ 

ONS-SE-622-1610）

0 dBm 5 dBm –28 dBm –3 dBm

15454_MRC-12（ONS-SI-155-I1） –15 dBm –8 dBm –30 dBm –8 dBm

15454_MRC-12（ONS-SI-155-L1） –5 dBm 0 dBm –34 dBm –10 dBm

15454_MRC-12（ONS-SI-155-L2） –5 dBm 0 dBm –34 dBm –10 dBm

15454_MRC-12（ONS_SE-155-1470 ～ 

ONS-SE-155-1610）

0 dBm 5 dBm –34 dBm –3 dBm

OC192SR1/STM64IO Short Reach

（ONS-XC-10G-S1）

–6 dBm –1 dBm –11 dBm –1 dBm

OC192/STM64 Any Reach

（ONS-XC-10G-S1）

–6 dBm –1 dBm –11 dBm –1 dBm

OC192/STM64 Any Reach

（ONS-XC-10G-I2）

–1 dBm 2 dBm –14 dBm 2 dBm

OC192/STM64 Any Reach

（ONS-XC-10G-L2）

0 dBm 4 dBm –24 dBm –7 dBm
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1.13　電源の問題

現象   電源断または低電圧により、トラフィック損失が発生し、LCD クロックがデフォルトの日時

にリセットされました。

考えられる原因   電源断または低電圧です。

考えられる原因   電源の接続が正しくありません。

推奨処置   ONS 15454 が正しく動作するには、一定電圧の DC 電源が必要です。入力電力は DC

–48 V です。必要な電力範囲は DC –42 ～ –57 V です。新しく設置した ONS 15454 は、電源に正

しく接続されていなければ動作しません。電源の問題は、特定の ONS 15454 に限定される場合

も、設置場所の複数の装置に影響が及ぶ場合もあります。電源断または低電圧の状態になると、

トラフィック損失が発生し、ONS 15454 の LCD クロックがデフォルトの日時（1970 年 1 月 1 日

00 時 04 分 15 秒）にリセットされることがあります。クロックを再設定するには、ノード ビュー

で Provisioning >  General > General タブをクリックし、Date フィールドと Time フィールドを

変更してください。「電源問題の原因の特定」（p.1-164） の作業を行います。

警告 この装置の設置、交換、または保守は、訓練を受けた相応の資格のある人が行ってください。

警告 作業中は、カードの ESD 破壊を防ぐため、必ず静電気防止用リスト ストラップを着用してくださ

い。感電する危険があるので、手や金属工具がバックプレーンに直接触れないようにしてください。

注意 電源に割り込む操作や ONS 15454 と電源との接続を短絡させる操作を行うと、動作状態に悪影響

があります。

電源問題の原因の特定

ステップ 1 1 台の ONS 15454 に電源変動や電源断の兆候がみられる場合は、次の作業を行います。

a. DC –48 V の #8 電源端子がヒューズ パネルに正しく接続されていることを確認します。これら

の電源端子は、バックプレーンの EIA 下部の透明プラスチック カバーの下にあります。

b. 電源ケーブルが #12 または #14 AWG であり、状態が良好であることを確認します。

c. 電源ケーブルが正しく圧着されていることを確認します。より線 #12 または #14 AWG の場合、

Staycon タイプのコネクタに正しく圧着されないことがあります。

d. ヒューズ パネルで 20 A のヒューズが使用されていることを確認します。

e. ヒューズが切れていないことを確認します。

f. ラックアース ケーブルが ONS 15454 EIA の右側の Frame-Ground Terminal（FGND; フレーム

アース端子）に接続されていることを確認します。このケーブルを現地の規約に従ってアース

端子に接続します。

g. DC 電源容量が電源負荷に対して十分であることを確認します。
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h. DC 電源が電池ベースの場合は、次の作業を行います。

• 出力電力が十分な大きさであることを確認します。必要な電力範囲は DC –42 ～ –57 V で
す。

• 電池の寿命を確認します。電池のパフォーマンスは、時間が経つにつれて低下します。

• 電池にオープンや短絡がないか確認します。オープンや短絡があると、電力の出力に悪影

響があります。

• 電圧低下が発生している場合は、電力負荷およびヒューズが供給電源に対して高すぎるこ

とが考えられます。

ステップ 2 設置場所の複数の装置に電源変動や電源断の兆候がみられる場合は、次の作業を行います。

a. 装置に電源を供給している Uninterruptible Power Supply（UPS; 無停電電源装置）または整流器

を調べます。具体的な手順については、UPS 製造者提供のマニュアルを参照してください。

b. 他の装置（発電機など）による過剰な電力消費がないか確認します。

c. 代替電源が使用されている場合は、バックアップ用の電源システムまたは電池で過剰な電源需

要が発生していないか確認します。

1.13.1　ノードとカードの消費電力

現象   ノードまたはノード内のカードに電力を供給できません。

考えられる原因   電源が正しくありません。

推奨処置   電源については、『Cisco ONS 15454 Reference Manual』の付録「Hardware Specifications」

を参照してください。
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